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Lectia ].

Recapitulare

v’ Operatii cu principalele obiecte Excel: registre, foi de

calcul, celule

v’ Formatarea datelor si a foilor de calcul, afisarea la

imprimanta

v’ Operatii elementare cu celule, adresarea relativa si

absoluta, formule grafice

Sarcina Revedeti

1 | Creati un nou registru cu numele ,test_initial.xls” New file

2 | Creati trei foi de calcul cu numele ,,sem_1", ,,sem_2" si Rename sheet
,an_scolar”

3 | Grupati cele 3 foi de calcul si scrieti Tn prima linie denumirile | Grupare foi
coloanelor ,,numar_curent’ si ,,nume_si_prenume”,
,,data_nasterii”, ,bursa”

4 | Realizati o serie personalizata cu denumirile obiectelor de Crearea serii
studiu: matematica, informatica, fizica, Ib. romana, etc. personalizate

5 | Copiati seria cu denumirile obiectelor pe linia 1 a tuturor foilor |Introducere serie
de calcul

6 | Pastrati gruparea foilor si introduceti pe coloana Serii numerice
,humar_curent” o serie numerica cu pasul 1 pana la valoarea
30 (presupunem ca in clasa nu sunt mai mult de 30 elevi)
Fixati pentru coloana , data_nasterii” formatul ,,zi numeluna an” |Format data

8 | Formatati coloana ,,bursa” la tipul monetar Lei intreg cu 2 Format currency
zecimale

9 | Formatati coloanele pentru mediile la obiecte la Tntreg fara Format number
zecimale.

10 | Pe ultima coloana puneti ca titlu ,,medie” si formatati la intreg | Format number
cu 2 zecimale

11 | Puneti formula de calcul a mediei fiecarui elev pe coloana Copiere Formula
»,medie”. Copiati-o pe coloana Average

12 | Puneti formula pentru ,,bursa” astfel: daca media este intre 9- |Functiile IF, AND
10 valoarea va fi 100 Lei, daca este intre 7-8.99 valoarea va fi
50 Lei, altfel va fi O Lei

13 | La sfarsitul tabelului addugati o linie si puneti textul ,medii pe |Formatare celule
obiecte” Tn celulele corespunzatoare numarului curent, nume, |de text
data_nasterii pe care le concatenati (lipiti). Centrati textul.
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14 | Scrieti formulele pentru calcularea mediilor la fiecare obiect. | Average
Formatati celulele respective la intreg cu 2 zecimale Format cells

15 |Pe o nouad linie scrieti textul ,total burse” in celulele Sum
corespunzatoare numarului curent, nume, data_nasterii pe care
le concatenati. Centrati textul. Puneti formula pentru suma
totala a burselor. Formatul este bun? Schimbati-I daca e
necesar!

16 |Pregatiti foaia de calcul ,,an_scolar” punand pentru coloana Lucru cu celule
bursa suma bursei din semestrull+semestrul 2 din 2 foi de

calcul; sum

17 |Foaia de calcul ,,an_scolar” va avea n celulele Lucru cu celule
corespunzatoare mediilor pe obiecte media aritmetica cu 2 din 2 foi de
zecimale a mediilor din cele doua semestre. Scrieti formulele. | calcul;
Formatul pentru zona mediilor este corect? Faceti corectia. average

18 |Numiti ,,abs_1" coloana cu absente din foaia ,,sem_1" si Insert>name
»abs_2" coloana cu absentele elevilor din foaia de calcul
,sem_2"

19 |Plasati Tn foaia de calcul ,,an_scolar” o celula cu totalul sum
absentelor pe clasa calculat prin Tnsumarea coloanelor ,,abs_1"
si ,abs_2"

20 |Puneti cate un comentariu la coloanele cu absente din foile de | Insert>comment
calcul ,,sem_1" si ,,sem_2" aratand numele lor si la celula cu
totalul acestora

21 |Salvati cele 3 foi de calcul ca template! Save as template

22 |Introduceti numele a 10 colegi si data_nasterii. Observati Introducere date
prezenta acestor date simultan in cele 3 foi de calcul. n foi grupate
Observati functionarea formulelor.

23 |Separati foile de calcul Degrupare foi

24 |Introduceti valori pentru mediile pe obiecte in semestrul 1 si Introducere date
separat Tn semestrul 2. Verificati functionarea formulelor. Ce se
Tntampla daca nu sunt 30 elevi? Ar trebui schimbate formulele?
De ce?

25 |Pe foaia de calcul ,,an_scolar” inserati o coloana Percentage
»pondere_absente” Tn care veti calcula ponderea numarului de
absente ale fiecarui elev in totalul absentelor clasei.

26 |Pe foaia de calcul ,,an_scolar” inserati o prima linie vida. Insert row
Puneti in celula A1 valoarea unui dolar in lei.

27 |Pe foaia de calcul ,,an_scolar” inserati o noua coloana dupa Adresare
coloana bursa cu valoarea bursei Tn dolari folosind Tn formula | absoluta

adresarea absoluta a ratei de schimb.
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28

Faceti cate o copie pentru fiecare foaie de date

Copiere foaie

29

Mutati toate copiile dupa cele trei foi de date si colorati
numele foilor de calcul (copii) cu rosu

Mutare foi
Format
sheet—>tab color

30

Pregatiti foaia de calcul ,an_scolar(2)” pentru a fi listata la
imprimanta.

Formatare foaie
-delete column

a. stergeti coloana data_nasterii -word art

b. scrieti cu WordArt titlul raportului -format cells

a. ncadrati tabelul intr-un chenar -tools—>gridlines

b. folositi pentru liniile de total fonturi, dimensiuni, culori -insert picture
diferite fata de continutul raportului -background

c. anulati caroiajul -print setup

d. puneti o imagine Tn colful stanga sus -header and

e. puneti ca antet de pagina anul scolar si clasa footer

f. repetati numarul curent al elevului si pe foaia continuare a
mediilor (pentru ca numarul de coloane este mare foaia se
fragmenteaza vertical)

g. Dimensionati paginile astfel incat datele sa fie echilibrat
plasate in pagina. Previzionati.

31 | Pregatiti o foaie — numita ,,centralizator” — pentru tiparirea la | -Copy
imprimanta a unui raport centralizator cu numele, data-nasterii,| -paste special
bursa, absentele si mediile fiecarui elev — fara detalierea pe -autoformat
obiecte.

a. Copiati continuturile tabelelor din fiecare foaie de calcul Print setup
(“sem_1", ,sem_2', ,,an_scolar”) pe verticala unul in Header and footer
continuarea celuilalt, separate doar de o linie pe care scrietil -insert picture
perioada (semestrul 1, semestrul 2 si anual) fara capul de | View Print break
tabel.

b. Puneti ca titlu ,situatia centralizatoare la clasa...”

c. Formatati noul tabel.

d. Pentru ca raportul este mai lung decat dimensiunea paginii,
fixati marginile astfel incat fiecare pagina sa aiba tabelul
dintr-o perioada.

e. Puneti ca antet fotografia clasei.

32 | Pe foaia de calcul ,,an_scolar(2)” realizati graficul mediilor Chart-column
generale pe elev. Atentie! La selectarea seriilor de date din Serie pe coloane
zone neadiacente veti folosi coloana cu numele elevilor si neadiacente
coloana cu mediile generale.

33 | Tipariti la imprimanta graficul mediilor generale pe obiecte — | Chart bar
veti folosi linia cu denumirile obiectelor si linia mediilor Seria pe linii
generale pe obiecte.

34 | Afisati sub forma grafica ponderea absentelor fiecarui elev in Chart pie

total absente pe clasa
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35

Desenati un grafic care sa ilustreze variatia burselor si a Grafice cu 2 serii
numarului de absente pe elev de date

36

Colorati cu rosu situatiile in care un elev are mai mult de 40 de Formatare
absente anual conditionata

37

Tnregistrati temperaturile de dimineata, pranz si seara din mai multe zile. Pe o coloan
vor fi afisate sub forma de imagini fenomenele atmosferice din ziua respectiva: ceata,
senin, vant, zapada, etc. folositi Clip art.

Aflati numarul de zile cand temperaturile de dimineata au fost sub O grade; temperatura
minima seara; temperaturile medii zilnice; temperatura medie a Tntregii perioade si
numarul de zile Tn care temperatura medie a zilei a fost sub cea medie a perioadei.
Afisati sub forma de grafic variatia temperaturilor medii pe zile. Afisati sub forma de
grafic variatia temperaturilor pentru dimineatd, pranz si seara in perioada studiata.

38*

Aflati al 50-lea termen din sirul Fibonacci. Sirul Fibonacci este o serie infinita de numere
intregi O, 1, 1, 2, 3, 5, 8, 13. Primele doua numere sunt O si 1, apoi fiecare numar se
calculeaza ca fiind suma celor doua numere precedente. Aflati de la al catelea termen
se stabilizeaza raportul a doi termeni succesivi. Cat este valoarea raportului de aur?

39*

Mama Tmi spune sa o ajut! Are o retetd pentru 4 persoane. Doreste sa afle cat sa
cumpere din fiecare produs daca la masa vin 10 persoane. Dar daca vin 20?7 Dar daca
reteta ar fi pentru 6 persoane?

latd reteta: ,Se taie rondele 400 g sunculitd frageda de porc, 2 cepe (cca 200 g),
700 g. cartofi fierti, 5 rosii mari (cca “kg); varza alba cam 400 g; 4 ardei grasi (la un
kg intra cam 6 !). Se amesteca bine cu sosul din 3 linguri otet, 2 linguri ulei, sare,
piper. Se presara deasupra branza telemea (cam 200 g). Realizati o foaie de calcul
care sa permita afisarea exacta a cantitatilor necesare unui numar oarecare de invitati.

40*

O firma de comercializare a masinilor de lux a Tnregistrat cantitatile vandute in ultimele
doua luni in regiunile Moldova, Muntenia si Oltenia, Maramures etc. Doreste sa obtina
diferenta cantitativa intre cele doua luni si procentul de modificare a vanzarilor de la
prima luna la urmatoarea. Daca vanzarile au scazut, se va afisa diferenta cu rosu. De
asemenea, doreste sa afle ce procent din totalul vanzarilor au fost vanzarile lunii curente
n fiecare regiune. Realizati foaia de calcul.

41%

Creati o foaie de calcul pentru salariile minime din diferite sectoare de activitate
pentru o tara oarecare. Completati cu date fictive pentru salariile medii din Tnvatamant,
cercetare, armata, politie, sanatate, justitie.

a. Calculati salariul mediu.

b. Aflati procentual ponderea salariului pentru fiecare ramura fata de salariul mediu
general.

c. Adaugati o noua coloana unde veti scrie valoarea salariului Tn dolari. Folositi celula
A1 pentru rata de schimb. Folositi adresarea absoluta. Dati nume celulei si refaceti
formulele pentru calcularea salariului in dolari.

d. Dati domeniului de celule unde sunt trecute salariile numele SAL1.

42*

La firma noastra orice angajat poate iesi la pensie daca a lucrat cel putin 40 de ani
sau are peste 65 ani sau a lucrat cel putin 30 de ani si are peste 60! Afisati pensionarii
posibili.
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Verificarea notiunilor de baza Excel din clasa a X-a

1. S& se creeze un registru de calcul cu numele Facturi.xls care sa contina
doua foi de calcul: Facturi si Situatii. Pe foaia de calcul Facturi creati un tabel
Tncepand din linia 3 cu urmatoarele coloane: data-facturii, numarul-facturii, nume-
furnizor, nume-produs, cantitate, unitate-de-masura, pret de achizitie. Formatati
coloanele la tipul datelor stiind ca preful este in lei cu doud zecimale iar data
este Tn formatul ,nume-luna, ziua, anul”, cantitatea este Tntreaga iar numarul-
facturii este de fapt text! Introduceti 10 linii astfel incat sa fie diferite produse

2. Inserati o prima coloana unde puneti numarul curent ca serie cu pasul 1.

3. Adaugati coloana TVA, unde puneti formula de calcul a valorii TVA pentru
fiecare produs ca fiind cota-tva*pretul de achizitie a fiecarui produs. Cota tva va
fi trecutd ca o valoare in celula Al. Folositi aceasta valoare Tn formula.

4. Puneti in celula A2 cota de adaos practicata de societate ca fiind 30%.
Numiti celula ,cota_adaos”.

5. Adaugati coloana adaos la tabelul initial si puneti formula de calcul a
adaosului ca fiind cota_adaos * preful de achizitie.

6. Adaugati coloana Pret_de_vanzare ca fiind pretul de achizitie + TVA +
adaosul la fiecare produs.

7. Adaugati pe ultimele linii ale raportului o situatie centralizatd unde veti
calcula:
a. Totalul valoric al intrarilor la pretul de achizitie
b. Totalul valoric al intrarilor la pretul de vanzare
c. Totalul valorii tva
d. Totalul valorii adaos

Observatie. Adaugati coloane suplimentare unde sa calculati valoarea la fiecare
linie si sa insumati apoi pe coloana. Coloanele de calcul le veti ascunde.

8. Copiati doar valorile din tabelul facturilor in foaia de calcul Situatie si
pregatiti foaia pentru un raport la imprimanta: puneti titlu, chenare, culori.

9. Realizati graficul variatiei pretului de achizitie si de vanzare la fiecare produs.

1 pct

0,5 pct

0,5 pct

0,5 pct

0,5 pct

0,5 pct

1 pct
1 pct
1 pct
1 pct

0,5 pct

1 pct
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Introducerea si validarea

lectia 2 |istelor Excel

v’ Ce este o lista de date?
v’ Validarea datelor
v" Vizualizarea si editarea datelor prin formulare Excel

O lista de date Excel sau o baza de date! este o colectie de date structurate care se
refera la un obiect distinct dintr-un domeniu dat. Fiecare lista va contine acele atribute
care pot sa caracterizeze obiectul respectiv in vederea memorarii si prelucrarilor specifice
unor utilizatori. De exemplu, Tntr-o listéa necesara examenului de bacalaureat vom retine
pe fiecare linie un elev cu CNP, numele, coala de provenienta, anul cand a absolvit clasa
a 12-a, mediile la fiecare proba. O lista de date pentru dirigintele unei clase poate sa
contina pentru fiecare elev numele parintilor, adresa, hobby, data nasterii, evolutia mediilor
pe obiecte si ani de studiu, etc.

Lista de date Excel apare tot sub forma unui tabel cu linii si coloane. Numai ca fiecare
linie are o anumita semnificatie si, Tn general, fiecare linie are macar o valoare care o
face unica.

De obicei se pune o singura lista pe o foaie de calcul, dar daca sunt mai multe se
separa cu linii si coloane vide. Lista nu trebuie sa contina linii sau coloane vide!

Exemplu:

La balcaniada de informatica de la lasi participa elevi din mai multe tari. Pentru buna
desfasurare fixam ca Tnsotitori ai musafirilor ghizi de-ai nostri. Fiecare elev gazda
numit ghid raspunde de un musafir. Am Tntocmit doua tabele. Observati diferenta!

1 A 8 c A B @ D E
2 LISTA GHIZILOR SI A GHIDUSE LOR
% 1 NUME  VARSTA LOCATIE SEX
5 IONUT 12 ani sala 1 lg—]g)ENEUg :g S:':g: =
6 BEBE 10 ani parter P
7 |ANDREI 10 ani hol 4 |ANDREI 10 hol
8 5 MARIA 10 sala 3 f
9 6 I0ANA 10 parter f
10 MARIA 10 ani SALA2 7 VICA 10 salal f
11 I0ANA 10 ANI PARTER 8
12 VICA 10ani salal o
13
Fig. 2.1. Exemplu de tabel care nu e Fig. 2.2. O lista Excel ocupa o zona
considerat lista n Excel compacta de celule

! Despre baze de date Access ati Tnvdtat Tn clasa a X-a. Revedeti lectiile!

TEHNOLOGIA INFORMATIEI §1 A COMUNICATIILOR ® CLASA A XI-A




Coloanele intr-o lista sunt numite campuri. Identificatorul coloanei trebuie sa fie dis-
tinct. Numele coloanelor se mai numesc etichete si se plaseaza pe prima linie a bazei de
date. Spunem ca formeaza structura bazei de date. Liniile se numesc articole sau inregistrari
si formeaza continutul bazei de date.

Daca dorim sa vizualizam etichetele sau numele campurilor, atunci putem folosi chenare
sau culori, dar nu separam structura de continutul listei.

Listele Excel beneficiaza de anumite facilitati, cum ar fi: extensia automata a formatelor
si a formulelor, validarea datelor la introducerea lor sau la o editare, sortarea dupa unul
sau mai multe atribute, filtrarea dupa unul sau mai multe criterii, gruparea si totalizarea
la nivelul fiecarui grup de date etc.

2.1. Extensia automata a formatelor in liste

O facilitate importanta a listelor este extinderea automata a formatului unei coloane
preluand formatul comun a 3 celule (din ultimele 5) anterioare.

Exemplu:

Avem de introdus Tntr-un camp pretul si formatdam doar primele 3 A |

celule ale coloanei la Currency cu doua zecimale si simbolul ,lei”. 1

Introducand n continuare valori pe coloana, chiar daca depasim ) 122 lei

cele 3 celule, observam ca se pastreaza formatul. 3 9 44 ei

Acest lucru este foarte util mai ales cand nu stim de la Tnceput cat 4 SIDD lei

de lungi vor fi coloanele, pentru a le formata de la bun Tnceput. 5 BIDIIII -
. LT N L - 00 lei

Tehnica obisnuitd de a formata intreaga coloana este acceptata G

numai daca pe coloand nu sunt alte categorii de informatii. Excel
aduce ca facilitate preluarea formatului gasit in cel putin 3 din ultimele 5 celule Tn
continuare, pe masura ce introducem datele!

Sarcina 1.

Introduceti valorile urmatoare intr-un camp numit Pret. Formatati celulele [pret
unde se gasesc valorile 2,4,55 la intreg fard zecimale. Addugati pe coloana in 2 89
continuare valorile 5.7A8, 3.7457, 1,9. Ce se Intampla? Ce format vor avea 2
valorile noi introduse? Intreg sau cu 2 zecimale? 4

R. intreg 55
Sarcina 2. 2.6

Observati imaginea. Celulele A2, A4 si A6 sunt formatate la valori A
monetare cu doua zecimale, iar celulele A3 si Ab la intreg. Ce format | 1
va avea valoarea din celula A7? Dar A8? 2 1.22 lei

Cum procedam sa schimbam formatul la numeric (intreg) pentru | 3 2
celulele care urmeaza lui A7? Dar la text? 4 5.00 lei

5 B
B 9.00 lei
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2.2. Extensia automata a formulelor in liste

O altad facilitate a bazelor de date este extensia formulelor, daca toate celulele
precedente (cel putin 4!) au aceeasi formula.

Exemplu:
Avem de introdus si de calculat mediile anuale TN TTE 5 = 3
ale mai multor elevi. Desigur, pentru primul vom | !

. . . o 2 cod medial  media2  media_general
scrie formula si o vom copia pe coloana. Ce ne |3 1000 500 750
facem Tnsd daca nu avem date? Mesajul de eroare | T 2
afisat datorat lipsei de date poate sda ne |& 700 800 7.50
incomodeze. Unii proiectanti ai foilor de calcul |] ey
folosesc formatarea conditionata pentru ca eroarea | @ 7N

. o s e - o 10 #ONVOI
de acest tip sa fie invizibila. O facilitate oferita de |, " oAl
Excel este ca, odatd formula repetatd pe 4 celule U2 _#ovm

anterioare ale coloanei, se copiaza automat in
noua linie atunci cand introducem valorile de calcul, fara ca operatorul sa aiba grija
de acest lucru. Si fara ca foaia de calcul sa fie invadata de mesaje!

Sarcini de laborator

1. Refaceti exemplul nostru. Puneti formula pe prima celula si copiati-o doar pe 4
celule. Introduceti valori in continuare pe cel putin 6 randuri. Observati refacerea automata
a formulei.

2. Construiti un nou registru cu numele Balcaniada, in care pe foaia de calcul ,,ghizi”
proiectati structura unei baze de date cu urmatoarele campuri: numele ghidului, varsta,
scoala, sex, sala de care raspunde, numele musafirului, varsta acestuia, tara, sex, disciplina
de concurs, data_sosirii

2.3. Validarea datelor

Introducerea datelor trebuie sa se faca corect inca de la introducerea datelor. Nu avem
de ce sa pierdem timp pentru a verifica corectitudinea datelor dupa ce actiunea de
introducere sau editare a fost terminata la toata lista! De aceea se poate specifica o
anumita conditie pe care trebuie sa o indeplineasca valorile la intrare.

La introducerea unei valori eronate operatorul poate fi doar avertizat ca s-a produs o
abatere fatd de valoarea consideratd buna dar i se permite sa continue procesul de intrare.

Sunt situatii, Tnsa, Tn care operatorul trebuie oprit la aceeasi celula pana la introducerea
valorii corecte.

Fixarea sau anularea regulilor de validare, mesajele catre operator la introducere si/
sau mesajele de eroare se stabilesc prin fereastra de dialog deschisda de comanda
Data->Validation.

Anularea validarii se face prin aceeasi fereastra de dialog prin butonul Clear.
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Cateva observatii

E necesar ca Tnainte de deschiderea ferestrei de dialog sa ne pozitionam pe campul
unde dorim introducerea restrictiilor de editare.

Daca nu stim cat de lunga va fi coloana, o vom selecta in intregime si, dupa fixarea
conditiilor de validare si verificarea lor, vom anula validarea pentru eticheta campului
prin butonul Clear din fereastra Data—>Validation.

Vom exemplifica cateva tipuri de validare pe o baza de date despre ghizi construita in
foaia numita ,,Ghizi” din registrul ,,Balcaniada” cu structura: nume_ghid, varsta, sex,
locatia, scoala, nume_musafir, tara, varsta_musafir, sex, disciplina de concurs etc.

2.3.1. Validarea numerelor prin limitarea valorii

Exemplul 1

Pentru lista elevilor care sunt
ghizi la Balcaniada varsta poate A g L o E F &
fi —de regulda —intre 7 si 15 ani,

dar se admit si exceptii. Deci [l MWHE WARSTA

3ot [ 6 Micresoll bxcel

daca un elev are varstade 16 ani, |3 geee i
o o~ abentie varsta ghizlor ar trebul sa fie intre 7210 ani
operatorul este cel care va hotarl | 4 ANDREI 10 ﬂ
% 1% g e
dacd acceptd sau nu persoana |2 MARE 10 S
e oA . B 108N 10 o ] = ol
respectiva. Observati Tn imagine |7 yica 10 z |l

mesajul afisat atunci cand am |8
introdus o valoare eronata. 19u
Cum procedam?

Fig. 2.3. Validare cu avertizare

Pasul 1. Selectam coloana B.
Pasul 2. Deschidem fereastra de validare cu Data->Validation.

Pasul 3. La pagina Settings fixam tipul de data Decimal si operatorul Be-

Settings ] Input

Walidation critetia

allow: tween

Dec‘f“a' Pasul 4. Introducem limita inferioara 7 si limita superioara 15.

Q:::,@T Pasul 5. La pagina Error Alert alegem stilul alertei Warning si scriem textul
Winimur mesajului afisat in caz de eroare.

7 Pasul 6. Pentru c& prima celuld B1

Mazximurn:

IE— contine n.umele coloar}ei VOM  |ssttings | InputMessags  Error Alert |
anU|a Valldarea acestei Ce|U|e I¥ Show errar alert after invalid data is entered

Flg 2.4. pOZ”_;lOné n d cursoru | pe aceasta §| hen user enters invalid data, show this error alert:
Fixarea actionand butonul Clear din ?ﬁiimﬂ“&
conditiei fereastra Data->Validation -
Efrar message:
3 atentie varsta ghizior ar trebui sa fie intre 7-
L] 10 ani

Fig. 2.5. Fixarea stilului si @ mesajului
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2.3.2. Validarea textelor prin selectarea unei valori (lista derulanta)

Exemplul 2

Tn lista ghizilor pe care am construit-o in aceasta lectie considerdm c& locatia trebuie
s& fie doar una din valorile ,,sala 1, sala 2, sala 3, parter, hol”. Tn acest caz nu se va
permite introducerea altei valori decat cea din lista! Operatorul va fi oprit din editare si
fortat sa reintroduca valoare pana cand valoarea corecta (butonul Retry).

Observati imaginea capturata

Cum am procedat?
Pasul 1. Am selectat coloana C

Pasul 2. Am deschis fereastra
Data—>Validation A B € D E F G

Pasul 3. Am fixat pentru valoa-
1 |MUME WARSTA LOCATIE SEX

rea coloanei tipul List gi am |5 onur Bleael o
construit lista direct Tn zona de |3 BEEE 10 parter  m -
H 4 ANDREI 10 hal m Microsoft Excel
editare Source. AR o
Pasu' 4- Pentru S|tuat|a Tn care EJ‘\E:QEA :]]gr%fvl @ alegeti sala dintre valotile datel
valoarea este eronata am intro- & i

. A w . 9
dus oprirea pana la introduce- |

rea valorii corecte prin stilul

Fig. 2.6. Validare cu oprire

alertei: stop!

Data Validation Data Validation

| Input Message | Errar &lert l Settings ] Inpuk Message  Error Alert l
Walidation criteria Iv Show error alert after invalid data is entered
Allow: ‘When user enters invalid data, show this error slert:
List - v Ignaore blank Style: Title:
Data: v In-cell dropdowin Stop |
Etror message:

Source: @ alegeti sala dintre valorile date! |
|sala 1; sala 2; sala 3; parter 1[

Fig. 2.7. Construirea unei liste de valori Fig. 2.8. Fixarea mesajului si a stilului pentru

situatia de eroare

Exemplul 3

Sa presupunem ca in baza de date a elevilor ghizi introducem un nou | scoala
camp Scoala. In aceastad coloana validarea se va face prin preluarea || v
; H o3 ; 3 5C. Genn S iasi
vanr|IorAd|ntrv—o lista, darvse va accepta si o noud yalqarve —deexemplu | |0 connr. 4 s
un elev invata la o scoala care nu a fost trecuta in lista! lic. Informatica i
% % ; ; ; : : Colegiul Negruz]
Sa presupunem cd avem deja scrise numele scolilor din lagi pe care | |\ iona jasi

le-am putea folosi. Sunt doua situatii:
a. valorile sunt 7n aceeasi foaie de calcul cu baza de date pe care
dorim sa o validam, caz n care folosim referintele la zona
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Data ¥alidation

} Input Message ] Error Alert

| Validation criteria

Allans:

|List Ea
Daka:

| [
Source:

|=scoli

Fig. 2.9. Lista derulanta se afla in
domeniul cu numele ,,scoli”

Exemplul 4

Tn registrul de lucru ,Balcaniada” avem o
baza de date cu ghizii si elevii participanti.
Dorim sa introducem numele disciplinei la
care concureaza fiecare participant printr-o
lista (dropdown list). Stim ca n registrul
»inspectorat” exista o baza de date cu disci-
pline de concurs, pe care am putea sa o
folosim.

Cum facem?

Metoda nu difera prea mult de folosirea pentru
lista derulantda a unui domeniu cu nume,

prin Windows—>Arrange.

Tntr-o listd Excel.

Data Validation

Walidation criteria

Inpuk Message ] Error flerk

Bllone;

[List |
Daka:

| El
Source:

[=fag102:524107

Fig. 2.10. Lista derulanta este un

domeniu Tn aceeasi foa
calcul

ie de

b. numele distincte ale scolilor din oras se gasesc pe alta foaie de calcul si atunci
vom da nume coloanei — atentie fara eticheta de camp — si vom pune Tn campul
Source numele zonei, precedat de semnul =.

El balcaniada

E

—_

discipline_de_
CONCurs
algoritrmi

haze de date
weh

TIC

maternatica
cercetari operational

OO0 g O P DD

disciEIina
w

algoritmi

baze de date
weh

TIC

makematica
cercekari operat]

OO~ | O | (T e L || —

Fig. 2.11. Lista derulanta cu valori

din alt registru

numai ca de asta data va trebui sa fie o referinta externa.

Pasul 1. Deschidem registrul ,,balcaniada” prin File=>0pen.

Pasul 2. Configuram fereastra Excel astel incat ambele registre sa fie deschise simultan

Pasul 3. Ne pozitionam in foaia de calcul unde avem campul ,,Discipline_de_concurs”.
Verificam ca valorile pe care le vom folosi pentru lista de validare sa fie constituite
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Pasul 4. Prin Insert>Name—>Define vom da numele ,,disciplina”, iar in zona de editare
Refers to... stergem referinta existenta si prin conturare cu mouse-ul introducem
referintele coloanei discipline_de_concurs din registrul ,inspectorat” care este activ!

Pasul 5. In fereastra Define Name ad&ugam noul nume.

Pasul 6. Selectam registrul ,,balcaniada” si ne
pozitionam pe celula unde dorim introducerea
validarii prin lista (derulantd).

Pasul 7. Deschidem fereastra de validare prin
Data->Validation introducem numele dome-
niului (creat ca referintd externa!) precedat de
semnul =. Vezi captura alaturata.

Atentie! Nu uitam ca la operatiile de editare a
bazei ,participanti” registrul ,,inspectorat” sa
fie deschis!

Sarcini

Data Validation

Settings l Input Message ] Errar Alert I

Walidation criteria

Allow:

|List j I+ Ignore
Data: v In-cell
Source:

|=disciplina E

Fig. 2.12. Validare prin apartenenta la o
lista din alt registru

1. Addugati in baza de date ,participanti” o noud coloana pentru tara de origine a

fiecarui musafir si fixati ca validare apartenenta
validare prin:

a. introducerea directa a constantelor;

b. preluarea valorilor din domeniul AA1:AA20

la o lista de valori. Construiti lista de

a aceleiasi foi;

c. preluarea valorilor in domeniul A1:A20 a altei foi de calcul;
d. preluarea valorilor din alt registru constituit de voi.

2.3.3. Validarea prin

compararea continuturilor celulelor vecine

Exemplul 5
In baza de date ,ghizi” A B © H J
introducem o noua coloana
pentru campul varsta_musa- | 1 NUME  WARSTA LOCATIVARSTA_MUSAFIR
fir alaturi de numele musa- | 2 AMDREI 10 hel J
firului | 3 |BEEE 10 parter | 27]
N . . 4 |IDANA, 10 parta
Vom fixa ca validare condi- | 5 jonuT TIPS BALCANIADA
tia ca varsta ghidului sa fie | & wiCA 10 sal
mai mare decéat cea a musa- ; MARIA 10 sal y FIT ATEMT LA DIFERENTA DE VARSTA!
firului! g

L] 4

Fig. 2.13. Validare cu informarea operatorului asupra valorii

eronate
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Cum procedam?

Pasul 1. Pe prima valoare care trebuie validata se introduce conditia de validare,
precedatd de semnul egal. Pentru ca varsta primului musafir se afla in celula H2, o
vom compara cu varsta ghidului din celula B2. Observati datele din baza de date si
construirea conditiei.

Pasul 2. Fixam mesajul si stilul avertizarii in caz de eroare
Pasul 3. Verificam functionarea validarii Tn celula H2
Pasul 4. Copiem validarea pe coloana folosind comenzile Copy si Paste Special.

Observatie: Odata cu operatia de copiere a validarii in celula H3, expresia devine
B3>H3, in celula H4 devine B4>H4 s.a.m.d. (datorita folosirii adreselor relative!).

Sarcini de laborator

1. Creati o alta foaie de calcul in registrul

Balcaniada in care proiectati baza de date concurs s aae
. . . Nl Data Validation
cu structura cod-participant si punctele obtinute n

fiecare zi de concurs. l Inpuk Message l Error Alert l
2. Validati punctajul obtinut in ziua 1 astfel incat B
sa fie mai mare ca 1 si mai mic ca 100. Yalidation criteria
3. Validati punctajul obtinut in ziua 2 astfel incat Allav:
sa fie cel putin egal cu cel din ziua 1, altfel celula |_Custc:m j
ramanand fara continut.
4. Tn baza ,ghizi” puneti coloana Data-sosirii Data:
pe care sa o validati astfel Tncat valoarea introdusa | J
sa fie mai mica decat data curenta primita de la Farmula:
sistem. ezt

Fig. 2.14. Validare prin referire relativa

Data Yalidation la o celuld vecini

I Input Message ] Error Alert ]
Walidation criberia . . . . .
! Fig. 2.15. Validarea unei date calendaristice si
=l folosirea functiilor
|Date ﬂ v
| Data: Exemplu. Tn coloana Data_sosiri dorim validare astfel
incat valoarea introdusa sa fie mai mica decat data
|Iess than j <
curenta.
End date: Observati fereastra de validare. Operatorul este ,,less
|=TCDaT ]| than” iar functia care intoarce data sistem este To-
day().
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2.3.4. Marcarea celulelor invalide

Am Tnvatat ca mecanismul de validare este declansat la terminarea introducerii unei
valori Tntr-o celuld. Operatorul este solicitat sa introduca valoarea corecta. Sa luam in
discutie cazul in care validarea unei valori depinde de valoarea dintr-o celula anterioara.
Ce se intampla, insd, daca dupa ce s-a terminat actiunea de introducere a valorii validate
se modifica valoarea Tn celula de referinta? Atunci mecanismul de validare nu mai este
declansat si ramane valoarea introdusa eronat.

Cum aflam daca sunt astfel de situatii?
Prin Tncercuirea cu rosu a celulelor care au valori eronate. Aceasta operatie se realizeaza
prin Tools>Formula Auditing—>Show Formula Auditing Toolbar si butonul Circle invalid Data.

Exemplul 6
Avem de introdus valori numerice Tn coloanele K, L, M,
cu urmatoarele restrictii:
a. Valorile din coloana K trebuie sa fie mai mici ca 20;
b. Valorile din coloana L trebuie sa fie mai mari decéat
cele n coloana K; ; f
c. Valorile din coloana M trebuie sa fie mai mari decat | 3 6
4
5

suma celorlalte doua.

Pasul 1. Am pus conditiile de validare astfel:

a. pentru celula K2 tipul este Decimal, operatorul este Less than, iar la maximum am
pus valoarea 20;

b. pentru celula L2 tipul este Custom si formula este =(L2>K2);

c. pentru celula M2 tipul este Custom si conditia este = (M2>(L2+K2).

Tools | Data  Window  Help

Track Changes oo | T HE s - B4

Probection 3

Formula Auditing » || 3= Trace Frecedents

[Macra b |=F  Trace Dependents

Pasul 2. Am copiat celulele K2, L2 si
M2 pe coloanele lor.

Pasul 3. Am introdus valori si am verificat
validarea. In acest moment, datele sunt
corecte.

Customize. .. Trace Error

b &

Remave All Arrows

Dpkions...

¥

Show Formula Auditing Toolbar

Pasul 4. Modificam valoarea K3=12 si
K4=16. Dorim sa stim daca validarile
mai sunt corecte!

Pasul 5. Deschidem Tools—=>Formula Audi-
ting—>Show Formula Auditing Toolbar si
activam butonul Circle invalid Data

i —  __ Observam ca datele incorecte sunt incer-
Fig. 2.16. Marcarea celulelor invalide prin Circle . ite cu rosu!

Invalid Data de pe Formula Auditing Toolbar
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Sarcini

1. Adaugati la lista participantilor din registrul Balcaniada coloana ,,bursd”, in format
Currency fara zecimale, cu valoarea monetara $, care sa primeasca doar valori pozitive.

2. Addugati o coloana , taxe_si_cheltuieli” cu acelasi format, dar care sa primeasca —
de reguld — o valoare mai mica decat 1/2 din valoarea bursei.

3. Introduceti 5 valori si verificati functionarea validarilor.

4. Modificati acum pe coloana ,,burse” valoarea astfel Tncat, uneori, s@ nu se mai
respecte conditia din coloana , Taxe_si_cheltuieli”

5. Marcati cu rosu celulele cu valori eronate!

2.3.5 Atentionarea operatorului prin mesaje de intampinare

De multe ori operatorul nu stie ce valori sunt considerate corecte sau ce trebuie sa
introduca ntr-o celula. De aceea sunt utile mesajele care se afiseaza Tnaintea selectarii
unei celule.

De exemplu, dorim ca numele elevului sa fie scris cu majuscule si informam despre
acest lucru pe operator.

£l balcaniada

HUME WARSTA

1
scricti 1 Fig. 2.17. Mesajul de intampinare se compune tot prin fereastra de
numele cu 1 validare deschisa prin Data->Validation in pagina Input Message.
majuscule ! 1 Aveti grija ca sa fie activ comutatorul Show input.

2.4. Vizualizarea si editarea datelor din liste prin
formulare Excel

Atunci cand listele pe care le construim in Excel sunt foarte mari, cu multe coloane si
multe linii, operatorul care doreste sa adauge un nou articol nu mai vede nici denumirea
campurilor (antetul este pe prima linie!) nici toate coloanele. O modalitate de a aduce in
zona vizibild datele Tndepartate este tehnica Split. O alta modalitate este folosirea
formularului Excel.

Formularul asociat listei se deschide prin meniul Data->Form.

Un formular(form) prezinta doar un singur articol, avand pentru fiecare camp denumirea
si valoarea sa care poate fi vizualizatd? si/sau editatd. Dacd numarul de campuri este

2 Depinde de protectia aplicata la nivel de celuld, foaie, registru. vezi , Protectia datelor”.
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prea mare pentru a putea fi incluse in 7 U
ferestra formularului, putem sa ne P ghizi (3) @E
deplasam cu bara de deplasare verticala. ||
Putem s& vedem datele prin deplasare NUIME: - Lofé
catre inceputul listei (butonul Find Prev) LOCATIE: et New
sau catre sfarsit (butonul Find Next).
Putem ad&uga noi linii (butonul New) aEx: m _ Dekte |
sau putem sa stergem linia curenta MUSAFIR MUME:  |Beatrice
(butonul Delete). MusaFIR vaRsTa: [0
Firnd Prew
MUSAFIR SEx: f
Find Mext
TARA: Bulgaria [ Fneess
. Criteria
.. 1Problema 1: |10 o =R
Sarcini de laborator = e
1. Deschideti un formular pentru baza dlproplemaz: |z Close
de.date »ghizi” si adaugati inca 4 noi Fig, 2.18. Formularul asociat listei penrtu
articole. vizualizarea si editarea datelor

2. Verificati daca validarile functio-
neaza si la nivelul formularului

3. Pozitionati-va pe articolul 2 si stergeti-I.

4. Restaurati datele. Se poate anula operatia de stergere prin formular a unui articol?

5. Pozitionati-va pe primul articol si modificati numele ghidului.

6. Deplasati-va la articolul cu numarul 3.

7. Apasati butonul Restore si revedeti articolul 1. S-a pastrat corectia voastra? Sau
s-a anulat?

8. Problema

La firma Imobexpert, care se ocupa cu tranzactii imobiliare, se inregistreaza ofertele
de vanzare si cererile de cumparare a apartamentelor, caselor, terenurilor. Pentru fiecare
client se inregistreaza si datele personale (nume, telefon, e-mail) pentru a putea fi contactat
n cazul in care au fost gasite solutii pentru cererea sa. Proiectati bazele de date imaginand
cererile de informatii. Ce informatii ar solicita un client? Dar un sef? Poate o lista cu
ofertele/cererile dintr-o zona, ordonate dupa pret, poate o listd a apartamentelor cu x
numar de camere si cu pretul cel mai mic. Poate o lista a apartamentelor pe zone sau
dupa preturi, separat vanzarile si separat cererile de cumparare? O situatie statistica a
numarului de apartamente deja vandute si comisionul aferent pe luni/ani. O situatie a
cererilor comparativ cu ofertele de terenuri etc.

[y, ¢

(Test 1 %

Se va verifica nivelul cunostintelor si al deprinderilor de operare cu tipuri de date
diferite, introducerea si validarea lor.
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1. Creati un nou registru pe care sa-I numiti , inspectorat”.

In foaia de calcul cu numele ,scoli” proiectati o listd cu informatii despre scoli:
numele, adresa, data infiintarii, tipul scolii, filiera, profil, specializare, numarul de clase,
de elevi, de profesori, daca are cantina, daca are camin, valoarea de inventar a bunurilor
din scoala n lei.

Atentie: proiectarea nu inseamna si introducerea articolelor, ci doar fixarea numelor
de camp, a tipurilor si a validarilor necesare. Nu cunoasteti de la inceput céate articole
veti avea. De aceea veti folosi facilitatea listelor Excel de a extinde formatele si formulele!

Formatati campurile la tipurile de date corespunzatoare.

2. Addugati o coloana cu numele ,,fond_investitii” care va avea ca valoare numarul de
elevi Tnmultit cu suma_pe_un_elev, acordatd de minister. Suma va fi depusa n celula Al si
numita ,,Suma_pe_un_elev”. Coloana va fi de tip Currency cu doud zecimale exprimata in $.

3. Proiectati restrictii de validare asociind si mesaje la intalnirea situatiei de eroare
stiind ca:

3.a numarul de clase la o scoala poate fi intre 2 si 20;

3.b. numarul de elevi la o scoala este peste 40 (obligatoriu);

3.c numarul de profesori sa fie mai mic decat numarul de elevi.

4. Proiectati o validare a campului ,tip scoald’” prin apartenenta la lista de valori
introdusa direct: , scoald generald”, ,liceu”, ,,colegiu”. Anuntati operatorul ce trebuie sa
faca la pozitionarea n celula.

5. Proiectati o validare pentru ,data_infiinarii” scolii. Astfel ea poate fi mai mica
decat data curenta si mai mare decat ,,1 ian. 1700”. In caz de eroare se va cere acordul
pentru acceptare sau nu.

6. Creati In Zona AA1:AA4 a foii de calcul o listd a filierelor cu urmatoarele valori:
»reoretic”, ,,Tehnologic”, ,Vocational”. Folositi lista construita aici ca lista derulanta
pentru introducerea valorilor in campul , filiera”

7. Creati Tn alta foaie de calcul (noud) a aceluiasi registru — numita ,,constante”, o
lista cu profile posibile pentru licee: ,teoretic”, ,tehnic”, ,servicii”, ,arte plastice”,
»sportiv”, ,militar”, ,,pedagogic”. Folositi aceasta listd derulanta pentru campul ,, Profil”.

8. Creati un nou registru cu numele , Specializéri” unde puneti in foaia de calcul
»,Constante” o listd cu specializarile posibile: ,filologie”, ,stiinte sociale”, ,,matematica-
informatica”, ,electronica”, ,turism”, ,teatru”, ,mecanicd” etc. Folositi aceasta lista
ca lista de derulare pentru campul , specializare” din baza de date a scolilor.

9. Introduceti 10 articole folosind formularul. Schimbati datele astfel incat sa vizualizati
situatiile eronate prin incercuire cu rosu!

Se va puncta fiecare sarcind cu 1 pct + 1 pct din oficiu.

LEC]’IA 2 ® INTRODUCEREA $!1 VALIDAREA LISTELOR ExceL




Sortarea si filtrarea listelor de

lectia 3 ate Excel

v’ Operatia de sortare
v’ Filtrarea simpla
v’ Filtrarea prin conditii complexe

3.1. Sortarea datelor

Operatia de sortare se face prin schimbarea articolelor (liniilor) unei liste de date
astfel incat sa fie respectata ordinea valorilor din campurile indicate drept chei.

Operatia de sortare se poate face prin selectarea tabelului si comanda Data->Sert sau
prin butoanele de sortare

Fereastra de dialog deschisa de comanda Data—> Sort permite introducerea a maxim 3
nume de camp, fiecare punand valorile crescator sau descrescator. Daca se folosesc mai
multe chei, atunci se aranjeaza liniile dupa valorile primei chei. La aceeasi valoare a
primei chei se aranjeaza dupa valorile din a doua cheie. Daca se gasesc valori egale si la
a doua cheie atunci se aranjeaza liniile dupa valorile celei de-a treia chei, s.a.m.d. Dar
daca avem nevoie de mai multe chei? Vom executa sortarea Tn mai multe etape pornind
de la cheia cea mai putin prioritara.

Exemplul 1

Tn baza de date a elevilor ghizi la balcaniad dorim s& aranjam ghizii pe sali.
Pasul 1. Vom selecta tabelul.
Pasul 2. Vom deschide fereastra de sortare prin Data—>Sort.

Pasul 3. Vom fixa cheia de sortare alegand din lista de atribute (nume de coloane)
asociata primei casete de editare. Vom fixa sensul ordonarii.

File Edit Wiew Insert  Formatb  Tools Qatam

O = é @‘ Close < L initial_valute Sart by
£ IONUT focere

* Ascending

" Descending
Then by

- (+ fscending

" Descending

WARSTA LOCATIE SEX

Then by

12 sala 1 m . .

10 parter m ’—Ll : Rscend!n.g

10 hal m . Descending

10 sala 3 f =tz ni=s )

10 parter  f @ Headerrow " Mo header row Fig. 3.1. Fereastra Sort

Dsalal  f permite fixarea cheilor si a
e | o | _cncd || sensului ordonarii
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Exemplul 2

Dorim o aranjare a elevilor ghizi pe locatiile unde sunt repartizati, dar nu ne avantajeaza
aranjarea acestor valori nici crescator nici descrescator, pentru ca dorim sa incepem
cu parterul, apoi cu sélile 1,2,3 si 4 si apoi holul! Este Tn acest caz o sortare dupa o
serie personalizata de valori.

Cum facem?

Pasul 1. Adaugam seria personalizata prin

fereastra Tools>Options=>Custom list. Sort Options

Pasul 2. Ne pozitionam pe baza de date si | Eirst key sort arder

deschidem fereastra Data—>Sort. [parter, sala 1, sala 2, sala 3, sala v | oK |

Pasul 3. Introducem in zona de editare a | i
cheii identificatorul “locatie”.

=

Cancel

Orientation
Pasul 4. Prin butonul Option deschidem % Sort top to botkom
fereastra de dialog care permite selectarea I sort left to right

seriei personalizate pe care dorim sd o B eI T FEEETaT —
folosim. Fig. 3.2. Sortarea dupa o serie personalizata

Sarcini de laborator

1. Sortati ghizii dupa varsta, pentru fiecare varsta, alfabetic.

2. Sortati ghizii dupa varsta, incepand cu fetele.

3. Schimbati lista, incepand cu baietii.

4. Afisati lista participantilor ordonata pe tari, varstele musafirilor, locatii, si alfabetic
dupa numele musafirilor!

5. Afisati lista ghizilor ordonata dupa locatii, dar punand mai intai holul, apoi parterul,
salile 1 si 3 si la urma salile 2, 4

6. Puteti schimba rapid ordonarea elevilor astfel incat sa se inceapa cu salile care au numar
par, apoi cele cu numar impar, apoi parterul si la urma holul? Trebuie facuta o alta lista?

3.2. Filtrarea datelor

Filtrarea datelor din liste este operatia prin care putem ntr-un mod usor sa gasim si sa
lucram cu un subset de date. O lista filtratd afiseaza doar articolele care indeplinesc o
anumita conditie.

Microsoft Excel dispune de doua metode de realizare a filtrarii listelor:

1. Autofilter — care presupune filtrarea prin selectarea valoriilor la nivelul unui sau mai
multor campuri

2. Advanced Filter — care foloseste criterii mai complexe

Subsetul de date consta de fapt in ascunderea articolelor care nu indeplinesc conditia.
Ele nu dispar din baza de date, nu se aranjeaza altfel. Subsetul de date poate fi editat,
formatat, folosit ca sursa pentru grafice sau tiparit fara a fi nevoie sa-I mutam sau copiem
in alta zona.
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3.2.1. Filtrarea prin Autofilter

Se foloseste meniul Data—>Filter>Autofilter care asociaza fiecarui camp cate o lista
ce se deschide la apasarea butonulul sageata. Optiuni ale filtrului:

e (All) = afiseaza toate valorile campului

e (Top 10) = afiseaza primele cele mai mici sau mai mari numere

e Optiunea Custom permite fixarea unei conditii compuse pentru valorile unui camp
e Valorile unice din coloana permit filtrarea liniilor care contin una din aceste valori
Anularea filtrului dintr-o coloana se face prin optiunea (all).

Anularea filtrarii automate se face prin acelasi meniu Data->Filter dezactivand optiunea
Autofilter.

A B C D
Exemplul 1
Dorim sa obtinem doar elevii ghizidinsala 1. § 1 [MUME ~|vARST~[LOCATIwISEX |
Cum facem? 2_ANDRE|
L 3 |BEBE
Pasul 1. Ne pozitionam in lista. 4 [I0ANA,
Pasul 2. Selectam Data->Filter>Autofilter. g '\E,:I'SKT
Pasul 3. Alegem valoarea “sala 1” pentru f§ 7 [MARIA
coloana “locatie”. :

Fig. 3.3. Alegerea valorii pentru filtrarea
tabelului.

Exemplul 2
Dorim ca lista sa contina doar baietii care stau la parter si au 10 ani. Cum procedam?
Pasul 1. Selectam Data->Filter>Autofilter.

Pasul 2. Vom deschide pe rand listele de filtru de la coloanele vérsta (pe valoarea
“10"), locatie (pe valoarea “parter”) si sex (pe valoarea “m”).

Exemplul 3 (—
. o o .. ~ A B a
Dorim sa selectdm doar copii cu varste C it U F
i 1 i i fr here:
cuprinse intre 10 si 14 ani. JNUME < [vaRST o] S rons where
Cum procedam? g QEEEE' 13 o il Ty
Pasul 1. Ne pozitionam pe tabel si | 4 10auA 10
activam Data->Filter>Autofilter. e =1 M
. . i ker th It
Pasul 2. Alegem optiunea Custom din | 7 MARiA 10f feissthan
. L e . a < is | h. |
lista asociatd coloanei vérsta. : U St =
- . n does nok begin with b
Pasul 3. Fixam conditia alegand opera- |7 endswih
. . oes nok end wil i
torul si valoarea pentru fiecare termen . L
al cor%di i comp Use Fig. 3.4. Fereastra Custom Autofilter permite fixarea
! puse. unei conditii compuse.
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Exemplul 4
Dorim sa facem un nou tabel pe care sa-| afisam la imprimanta cu informatiile despre
elevii ghizi cei mai mici ca varsta!
Pasul 1. Deschidem Data->Filter->Autofilter.
Pasul 2. La coloana Varsta fixam optiunea Top10. care deschide o fereastra de dialog.
Pasul 3. Alegem din lista Show optiunea Bottom si numarul de valori=1

Prin optiunea (Top10.) putem selecta primele valori (Top) sau ultimele (Bottom) din
lista Show.

Pasul 4. Selectam tabelul filtrat si-l copiem in alta locatie. 1| formatam si il afisam la
imprimanta.

nume  w|varsv|locatie w|sex  w|nume_muw|tara  w|varsta_r wfafi
ANDREI 10/ hol =

GABI ST "op 10 AutoFilter
LEOQ 10 salq shg

foton =]t =] feess <] | Fig 3.5, Prin optiunea (Topl0) putem
selecta primele valori (Top) sau ultimele
[ ] s | (Bottom) din lista Show.

Observatii
* Revenirea la toate datele din lista se face [3

prin Data% FIlter%ShOW a” 7 nume w|vaisw Incmia_vlsex v[nume_mu_
o ) ) . ) 8 |ANDREI hal None
¢ Calcule statistice pe lista filtrata se fac prin %'GICA hOI P

meniul contextual asociat barei de stare :g GABI hol_ I
* Odaté cu filtrarea pe bara de stare se afiseaza |2/ Counk Nums
a i 1 i Macx
automat numarul de articole afisate din totalul | 22 =
i 3 i % ; ; px] s -
artu;plelor. Daca dorim sa thmem al_te mfolr— W W et @ (oo sun L
matii centralizate despre articolele obtinute prin  [fte___Aversge- i1 6666667 N

filtrare, cum ar fi suma, media, maximul etc.  Fig. 3.6. Calcule statistice pe lista filtrat
deschidem meniul contextual atasat barei de se fac prin meniul contextual asociat barei
stare prin butonul drept al mouse-ului. de stare.

Sarcini de laborator

a. Filtrati si afisati numai baietii ghizi cu varsta de 10 ani.

b. Afisati numai fetele musafire care au ghizi baieti.

c. Afisati numai articolele care se referad la prima tara din lista.

d. Ghizii cu varste cuprinse intre 11 si 15 ani.

e. Musafirii baieti cu varste de peste 15 ani.

f. Aflati cate eleve au peste 10 ani.

g. Aflati varsta media a baietilor musafiri.

h. Aflati cati ghizi au cea mai mare varsta.

i. Filtrati tabelul si aflati care sunt elevii care provin de la licee (numele scolii incepe
cu “lic”.).
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j. Afisati elevii ghizi care nu provin de la licee si sunt baieti si au varsta = 10 ani si
sunt pe hol!

k. Filtrati astfel Tncat sa obtinem elevii cu cea mai mica varsta si care sunt pe hol!

[. Obtineti cele mai in varsta 3 fete.

m. Afisati elevii care au Tn campul scoala siru
valoarea.

|u

nr.” care nu ncepe sau nu termina

3.3. Filtrarea avansata prin Data—>Filter->Advanced Filter

Uneori este necesara obtinerea unei filtrari a datelor dintr-o listd Excel in alta zona a
foii de calcul active. Noul tabel poate sa nu aiba toate coloanele, poate avea o alta ordine
a coloanelor si liniile vor fi cele care verifica o conditie pusa de operator. Pentru aceasta
se foloseste Data—>Advanced Filter. Filtrarea avansata foloseste 3 zone:

a. zona bazei de date — identificatad prin adresare absoluta sau prin nume;
b. zona conditiei — are cel putin doua linii; prima contine identificatorul de camp, pe
celelalte valori pentru a se forma conditia de filtru;

c. zona rezultatului — poate fi Tn alta locatie a aceleiasi foi de calcul sau peste baza de
date, ca Tn Autofilter.

Exemplul 5

Pentru baza de date cu ghizii si ghidusele Balcaniadei dorim sa obtinem un tabel
separat numai cu numele, sexul si varsta elevilor care raspund de sala 1.

Cum procedam?

Pasul 1. Organizam foaia de calcul pentru a putea folosi filtrarea avansata. Astfel,
conditia o punem Tn A10 (identificatorul de camp) si A11 valoarea “sala 1”; Pentru
rezultat copiem numele campurilor nume, sex, varsta pe linie incepand cu A13.

Pasul 2. Deschidem fereastra Data—>Filter->Advanced Filter. indicam domeniul de
celule folosite ca sursa de intrare (list range) ca fiind domeniul $A$1:$D$7 prin tehnica
punctarii domeniului. indicam domeniul de celule unde am scris criteriul de filtrare
(Criteria range) ca fiind domeniul $A$10:$A$11. Indicam domeniul pentru rezultat
(copy to) ca fiind $A$13:$C$19

1 NUME VARSTA LOCATIE SEX Tﬂnhu. "
2 |ANDREI 10 hol m T .
3 BEBE T0jparier[m | s
4 I0ANA 10 part f st range: |—
5 |IONUT 12 :;:1[ m | . e
B VICA 10salat | Seenarnge:  [ragiogasn 3
; MARLA 10 sala 3 f Copy to: Imna;gc;w Y
1] & Teonditia de fitra I~ Unique pecords only Fig. 3.7. Fereastra de dialog Advanced Filter
locatie contine numele . I .
11 sala 1 Joanci s valoarea I solicita introducerea referintelor la zonele
]i nume [vanta oo Yl de construire, daca se va face o selectie
14 1ONUT 12 3 A i 3
A 12 E"t::‘::“ unica ascunzarld dupllca)tele sau daca
in
e Sk coecadien] rezultatul este in aceeasi locatie cu baza de
18 popte fschimbata date sau nu.
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Exemplul 6

Am dori — tot Tn alta parte a foii de calcul — un tabel cu numele locurilor unde sunt
ghizii de 10 ani!

Cum procedam?

Pasul 1. Tn foaia de calcul pregétim conditia compus& scriind numele de coloan& pe
un rand si valoarea pe alt rand.

Pasul 2. Pregatim locul unde vom obtine rezultatul scriind numele coloanei
Pasul 3. Deschidem Data->Advanced Filter.

Advanced Filter E|E|
SR o m |
=0 ' [’
3 BEBE Opater m | o ool R
4 |IDANA 10 parter  f
5 IONUT 12 sala 1 m § : ﬁ
B VICA 10 sala 1 f l'a“_m Ao
7 MARLA 10 sala 1 M Crteniarange:  [sagi0:38§11 E7|
8 Copy to: [sas13:8a819 | . o o
9 [— S Fig. 3.8. Observam cum se formeaza
! e s oomss o] conditia compusa:

2 et cavalon [ o ] e || varsta = 10 ani si sex = “m” — pe
afi . . .
Whol domeniul $A$10:$B$11 si activarea
}g ::;9; butonului Unique din fereastra de dia-

17 log!
Exemplul 7

Dorim sa aflam unde sunt fetele, la ce sali sunt repartizate. Pentru aceasta sarcina va
trebui ca fiecare sala sa fie afisatad o singura data!

Pasul 1. Vom da nume celor 3 zone de filtrare. Astfel zona $A$1:$g$5 cu numele
conditie, zona $A$7:$3G$60 cu numele baza_de_date si zona A$70:3A$90 cu numele
rezultat.

Fig. 3.10. Organizarea foii de
calcul pentru Advanced Filter:

& balcaniada
A

[~3]

Advanced Filter

B

Action

1 nume  vaista locatie , | pe primele linii se pune
o . " Eer the list, in-place

2 | conditia care are acelasi -
3 - t R v 1+ Copy to another location

- nume de camp cu baza de
"5 date. Pentru selectare unica List range: baza_de_date 3]
B folosim comutatorul Unique Crearange:  [orem M
7 nume  varsta locatie  sex 1 | record Only. Zona pentru

8 ANDREI 10 hol f rezultat contine doar

ZHOICA 15{hal f domeniul $A$70:$A$90 7 s ecoeds o]
10 GABI 10 hol m

11 BEBE 12 parer Lo ] coned |

12 I0ANA 14 pater  m
13 VICA 12salal  f Fig. 3.9. Proiectarea filtrului
14 10NUT Usalal  m
15 MARIA 15 sala 1 m

70 locatie
71 hol

72 parter

73 salai

b7

Ie [la

LECTIA 3 ® SORTAREA Si FILTRAREA LISTELOR DE DATE EXCEL 27




Exemplul 7. Construirea conditiei complexe in filtrarea avansata

a. O conditie compusa cu valori alternative ale aceluiasi camp se construieste prin
depunerea valorilor pe linii diferite Tn coloana.

A B C D
nume varsta locatie sex
EEEF Fig. 3.11. Conditia poate s& aibd mai multe valori pe o

MARIA coloana. Se citeste astfel: nume="BEBE"” sau
nume="ViCA” sau nume="MARIiA”

Mo Lk =

b. Putem formula conditii in care operatorul este <, <=,>,>=, <>, =.

A B C D |
nume varsta locatie  sex |1
=12

Fig. 3.12. Conditia poate s& aiba operator diferit de egal.
Ex. Copii cu varsta mai mare ca 12

=R =

c. Daca dorim sa concatenam conditiile relationale prin operatorul “sau”, valorile se
pun pe linii diferite.

]
A B c D
1 nume varsta locatie  sex nume_n
o . - “ Ghamy |1
2 12 Fig. 3.13. Conditie compusa cu operatorul “sau
3 hol P P
4 m Ex. copii cu varsta peste 12 ani sau baietii sau pe cei
5 care raspund de “hol”.

d. Daca dorim sa concatenam expresiile relationale prin operatorul “si” se foloseste
aceeasi linie pentru valori.

A B C D
nume  varsta locaie sex nume_| Fig. 3.14. Conditie compusa cu operatorul “si”
>=12_hel 0 Afiseaza baietii cu varsta peste 12 ani care raspund de
“ ”
hol”.

b LA R

e. In conditie pot fi folosite caracterele de substituire ? care inlocuieste un singur
caracter pe pozitia respectiva si * care inlocuieste un grup de caractere.

c2 v X & zala?
A E © 8] E
1 nume varsta locatie  sex nume_musafir . . . .
2] [sala? ] Fig. 3.15. Conditia poate s& contina caractere de
i substituire ? sau *. Ex. Elevii din Sali!

f. Tn conditie pot fi folosite valori (referinte, functii) din baza de date sau din afara ei
daca pe prima linie punem un alt identificator decat numele de camp din lista si pe a
doua linie aceeasi coloana punem formula precedatd de semnul egal.
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Exemplul 8

Presupunem ca in tabela ghizi exista si informatii despre musafiri. Astfel, fiecare ghid
este gazda unui musafir pentru care vom inregistra numele, tara de unde vine, varsta.
Dorim sa aflam care ghizi au aceeasi varsta cu a musafirului. Daca primul copil are
linia 2 si varsta este pe coloana B, iar varsta musafirului este pe coloana G putem
scrie conditia = B2 = G2.

Pe prima linie nu se scrie un nume de camp, ci un mesaj.

A =BB=0GE
H
eqal Fig. 3.16. Folosirea in conditia de filtrare (domeniul $H$1:$H$2) a unei
TRUE | expresii in care intervin celule vecine.
Exemplul 9
Dorim s& aflam care sunt musafirii care au varsta mai mare [, o crascses: sesom
decat media generald a varstelor tuturor musafirilor. Varsta | & [ | d

mal mari ca madia

musafirilor se gaseste pe coloana G, incepand din linia 2. Vom
folosi ca formuld = B2>Average($G$2:$G$100).

Exemplul 10

Din lista ghizilor de la balcaniada dorim sa extragem musafirii in alta parte a foii de
calcul. Pentru fiecare avem nevoie de nume si tara de unde vine. Observati modul Tn
care am pus conditia. Pentru ca nu se face nici o filtrare — dorim toate articolele! —am
pus o conditie totdeauna adevarata.

AA2 =e2=e2.
ASD - A =E2=E2
A CD E F G H Y| Z AR AB
MUSAFIR_ MUSAFIR_ MUSAFIR
1 [NUWL S NUME WARSTA | SEX TARA, musafir
| 2 |AND h m Beatrice 10f Bulgaria I TRUE !
3 BEBp mLeon 12 M Bulgaria
4 10ANp f Jack 10'm Grecia
5 1ONLs mSara 121 Serbia musafir_nume tara
B WICLs T alex 151 Bulyaria Beatrice Bulgaria
7 MAR s MAnatol 15 m Rormania Leon Bulgaria
g Jack Grecia
9 Sara Serhia
10 alex Bulgaria
11 Anatal Romania
12

Fig. 3.17. Obtinem o listd nefiltratd daca valoarea conditiei este TRUE.
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Sfaturi practice

1. Pregatiti zona unde plasati conditia la cel putin 3 linii departare de baza de date,
copiind pur si simplu linia de structura a bazei (linia cu numele campurilor).

2. Pe liniile urmatoare puneti valorile pentru filtru.
3. Este bine sad aduceti atat conditia, cat si tabelul raspuns in zona vizibila a ecranului.

4. Pentru comoditatea compunerii informatiilor din fereastra Advanced Filter dati nume
(prin Insert->Name->Define) pentru conditie, lista de date si rezultat selecténd fiecare
domeniu cu tot cu structura (adica identificatorii de camp).

5. Daca dorim sa selectam articolele unice va trebui sa activam comutatorul Unique
records only.

Sarcini de laborator

A. Obtineti Tn alta parte a foii de calcul — de exemplu incepand de la A100 — urmatoarele
situatii:

1. Numele tuturor musafirilor si varsta.

2. Numele ghizilor, ale musafirilor si locul unde merg (locatia) numai daca sunt din
Bulgaria sau Grecia.

3. Ghizii baieti care au aceeasi varsta cu a musafirilor lor.

4. Afisati, Tn alta parte a foii de calcul Ghizi, musafirii romani cu véarsta de 10 ani, intr-o
lista cuprinzand numele fiecarui musafir si numele ghidului lui.

B. Proiectati o lista pentru evidenta mijloacelor fixe dintr-o unitate scolara retinand
numarul de unitati, nume, data intrarii in inventar, valoare la intrare, durata normata de
viata, amortizare, locatia, anul producerii, firma producatoare.

Obtineti:

a) lista mijloacelor fixe care ar trebui scoase din inventar pentru ca durata normata de
functionare a fost depasita;

b) cele mai mari (ca valoare) mijloace fixe din locatia X;

c) lista mijloacelor fixe pe locatie, pentru fiecare locatie, dupa valoare si data producerii;

d) mijloacele fixe cu durata de functionare mai mare de d10 ani;

e) mijloacele fixe produse n fara X si achizitionate dupa data y;

f) mijloacele care au valoare de inventar mai mare decat media aritmetica a valorilor.

— durata de viata mai mare decét 5 ani;

— valoarea de inventar mai mare decat 1000.
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(s, ¢
(Test 2

Testul vizeaza verificarea cunostintelor si a deprinderilor de a prelucra liste Excel prin
sortare si filtrare.

.. Nume_scoala
Sarcini G. Ibraileanu
1. Aranjati lista scolilor descrescator, dupa fondul | sc. Gennr.2 IASI
de investitii. M. Eminescu
lasi, lic. National
lic. De informatica, lasi, "Gr.
Moisil"

2. Aranjati lista scolilor pe profile, numar de clase,
alfabetic.

3. Obtineti prin filtrare doar scolile din Pascani!
Copiati datele Tn alta foaie de calcul.

Obs. Numele localitatii se gaseste in adresa, nu neaparat la inceput sau sférsit!

4. Sa presupunem ca am completat gresit numele scolii, incluzand si localitatea ,,lasi”
(la unele in fatd, la altele Tn spate, iar la altele chiar in interiorul sirului).

Dorim sa facem corectii manual, filtrand lista scolilor astfel Tncat sa obtinem prima
data scolile care au in fata numelui localitatea ,,lasi”. Apoi scolile care au Tn spatele
numelui localitatea , lasi” si apoi pe cele care au Tn interior acest nume de localitate. Ce
manevre faceti?

5. Folosind filtrarea avansata obtineti Tn afara listei pe coloanele AA:AC numele scolii,
profilul si nr_clase pentru acele scoli care:

a) sunt din profilul ,liceu” si au mai mult de 5 clase
b) au cdmin sau cantina

¢) au camin si cantina si sunt din lagi

d) au 3 sau 5 sau 6 sau 9 clase

e) au ca suma de investitii o valoare mai mare decat media pe inspectorat a acestor
valori.

f) au prima litera a numelui ,,S".
6. Folosind filtrarea avansata obtineti numai profilele scolilor din baza de date.

7. Afisati Tn alta parte a foii de calcul numele tuturor scolilor si valoarea de investitii.
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Lectia 4

Functii

v’ Functii cu texte sau siruri de caractere
v’ Functii numerice si de aproximare
v’ Functii cu date calendaristice

v’ Functii statistice pentru baze de date

4.1. Functii pentru texte

Uneori suntem nevoiti sa prelucram informatiile de tip text aflate Tn celulele foii de
calcul. Un operator folosit pentru texte este &(ampersand) care realizeaza concatenarea
sirurilor.

Exemplu ,,alb” & ,astru” produce sirul ,albastru”

Cateva functii utile

1. Concatenate(sir1;sir2..) pentru concatenarea sirurilor date ca parametri. Exemplu:
concatenate(”alb”,”astru”) " ,,albastru”

2. Find(sir1;sir2;poz) sau Search(sir1;sir2; poz)
Cauta sirl n sir2 si Tntoarce pozitia

primei aparitii. Dacd aceasta nu se gaseste, A B C

se afiseaza mesajul de eroare. Cautarea [ 1 D-l. Lungeanu Liviu 6 =FIND("L";A1)

poate sa Tnceapa de la pozitia poz (implicit, g 12 E:ng :- :11):?)

poz este 1) 4 " #/ALUEI =FIND("LI",A1)
Functia Search nu este sensibila la | 5 15 =SEARCH("LI" A1

tipul caracterelor din cele doud siruri. Sirul ? SESEARCHC L,

cautat poate sa contina caracterele de
substitutie ? si *

3. Len (sir) Tntoarce lungimea sirului. Exemplu Len("alba”) >>> 4

4. Right(sir,nr) / Left (sir, nr) Tntoarce primele / ultimele nr caractere din sir.
Exemplu: Right("albatros”;3)—=>>> ,alb”; Left("albatros”;2)——=>>> ,0s"

5. Mid(sir;poz;nr) extrage un subsir de nr caractere incepand cu poz Exemplu
Mid("albatros”;3;2)>>>>"ba”
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6. Lower(sir) /Upper(sir)/ Proper(sir) realizeazd conversia la minuscule / majuscule /
Prima litera a fiecarui cuvant devine majuscula

Exemple: Lower("MaMa MiA”)>>>>"mama mia”; Proper("maMa mia”)>>>>"Mama
Mia”

7. Text(numar, sablon) / Fixed(numar, zecimale) realizeaza conversia unui numar la sir.
Sablonul contine simbolul diez si O pentru cifre (revedeti Format Cells=>Custom)

A B
1234 salar

o
salar=1234.00
"salar>=1234.00
dobanda=00.40

D
=B1&"=" & TEXT({A1,"00.00")
=B18& TEXT(A1;">=00.00")
=B3&"=" & TEXT(A3,"00.00")

dobanda=40.00% =B3&"=" & TEXT(A3;"00.00%")

1
2
3  40% dobanda
4
L

8. Value(sir) realizeaza conversia unui sir la o valoare numerica.
Exemplu:Value(”123.44")>>>>numarul 123.44

Exemplul 1
Fie un text pentru adresa care cuprinde numele localitatii, virgula, numele strazii si
numarul. Aflati si separati informatiile.

Ad M f lasi, Str M. Eminescu, Nr.5
A C D E F G H
5 lasi Str M. Eminescu, Nr.5 17 StrM. Eminescu  Nr5

10 =FIND(" ",A9) =LEFT(A3,C9-1) =RIGHT(A3,LEN(A3)-C9) =FIND('"E9) =LEFT(ES,F3-1)
1
12

=RIGHT(ES,LEN(ES)FY)

Exemplul 2

Pentru fiecare meci de fotbal din Cupa Romaniei au fost Tnregistrate numele echipelor,
locul, data de desfasurare si scorul. Scorul este dat sub forma unui sir. De exemplu ,,7-
4" unde 7 este numarul de goluri marcate de prima echipa, iar 4 este numarul de
goluri marcate de cea de-a doua echipa. Separati cele doua informatii in alte celule
(numerice!).

— — — —
e '7-4

[ E | F G H | J

liscor _ poz sep caracter_g1 ni_g1 caracter_g2 ni_g2

37 7% 4

i =FIND("-" E4,1) =LEFT(E4 F4-1) =VALUE(G4) =RIGHT(E4 LEN(E4)-F4) =VALUE(4)

Sarcini de laborator
1. Ce realizeaza formulele din exemplul urmator?
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A B C D E

12 4 =FIXED(A1,0) =FIXED(B10) =CONCATENATE(C1," D1)
2 12 5 =TEXT(A2,"##0")  =TEXT(B2,'##0") =C2&"-"&D2
3] ——1

2. In foaia de calcul cu mecuri — de exemplu — numele echipelor au fost scrise neglijent:
unele cu litere mari altele cu litere mici. Realizati corectia astfel incat sa fie scrise pe
fiecare coloand numele cu aceleasi tipuri de caractere.

4.2. Functii pentru date calendaristice si timp

Excel are inclus un calendar care incepe de la 1 ianuarie 1900 si se termina la 31
decembrie 2078. Fiecare zi are atribuit un numar intreg. De exemplu numarul 1 este
pentru 1.01.1900 iar numarul 366 este asociat datei de 31 decembrie 1900. Timpul
dintr-o zi este reprezentat prin fractii ale numarului asociat zilei. O ora reprezinta 1/24 =
0.041666; un minut =1/(24*60) iar o secunda =1/(24*60*60) dintr-o zi. De exemplu
miezul noptii (ora 24) este O iar miezul zilei este 0.5. Daca avem un numar cu zecimale,
Excel 7l considera ca reprezentand data si momentul din zi. De exemplu numarul 356785.5
reprezinta 06.09.2001, ora 12:00 PM

Cateva functii utile

1. Today() - intoarce data sistem. Exemplu: Today() = 22.06.2006

2. Now() — Tntoarce data si ora sistem. Exemplu: Now()=>22.06.2006 12:06:05

3. Date(an,luna,zi) / Time(ora,minut,secunda) intoarce o datd calendaristica / moment
de timp folosind numerele date ca parametri.

Exemplu: Date(1998,12,3)>3.12.1998; time(12,3,6)>12:03:06

4. Hour(n) / Minute(n / Second(n) Tntoarce ora/minutul/secunda din numar.

Exemplu: hour(12.34)>8; minute(12.34)>9; Second(12.4)>36

Sarcini de laborator

1*. Lainscrierea pentru cules de capsuni in Spania am numarat peste 100 de persoane.
Daca durata predarii unei cereri este de 2 minute, calculati cat voi astepta daca ma
hotdrasc sa ma asez la coada! Dar daca ar fi doar 76 persoane si durata servirii de 5
minute?

2*, La o parcare se cere introducerea momentului sosirii, respectiv plecarii masinii, si
se calculeaza automat costul. Realizati o foaie de calcul pentru aceasta parcare. Preful
unei ore de stationare este 0,6 RON (6000 lei vechi).

3*. Cu totii asteptam vacanta de vara. Calculati cate zile ne mai despart de ea! Atentie:
analizati problema gandindu-va la toate posibilitdtile: daca data curenta este 10 mai
atunci asteptati vacanta anul acesta. Dar daca este 10 octombrie? La ce vacanta va
ganditi? La cea de la anul viitor, nu? Cum veti calcula?

4*, Calculati cati ani, luni, zile, ore, minute, secunde sunt intre doud momente de
timp. De exemplu intre 31 dec. 2009 ora 12:45 si 01 aug. 2006 ora 17:20.
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4.3. Functii numerice

Cateva functii utile de aproximare sunt:

1. int(n) — Tntoarce partea intreaga prin trunchiere.

Exemplu: int(3.14)>3

2. Round(n,z) / Roundup(n,z), rounddown(n,z) — rotunjeste numarul n la a z-a zecimala
matematic/in plus/ Tn minus.

Exemplu: Round(123.56,0)=124; Round(123.34;0)= 123Roundup(4.235;1)=
4.3Rounddown(4.235;1=4.2

3. Mod(n1,n2) - restul impartirii intregi a lui n1 la n2. Exemplu: Mod(5,2)>1

Sarcini de laborator

5*. Pe drumul de Tntoarcere dintr-o excursie un grup de copii (n) au vazut un camp cu
flori si I-au rugat pe soferul autocarului cu care calatoreau sa opreasca pentru a culege
cateva flori, ca sa faca fiecare cate un buchet pentru mama lui.

Apoi s-au gandit sa puna la un loc toate florile si sa faca inca un buchet pentru doamna
educatoare. Au Tnceput sa puna fiecare cate o floare in mod egal la toate buchetele. La un
moment dat, au constatat ca toate buchetele contin acelasi numar de flori si ca a mai
ramas un numar de flori mai mic decat numarul de buchete. S-au hotarat sa puna aceste
flori in buchetul pentru doamna educatoare.

Rezolvati problema folosind foaia de calcul Excel. Aflati in orice moment numarul
total de flori, numarul de buchete care vor trebui formate. Cate flori va contine fiecare
buchet destinat unei mame? Dar al doamnei educatoare?

4.4 Functii statistice

Amintim cateva functii statistice studiate deja in clasa a X-a:

. Sum(n1:n2) — realizeaza suma parametrilor

. Average (n1,n2) — calculeaza media aritmetica a valorilor
.count(nl:n2) — numarul de calcule Tn domeniul precizat ca parametru
. min(nl,n2..) — valoarea minima

a b WN =

. max(nl,n2..) — valoarea minima

6. countif(domeniu, valoare) — numara celulele din domeniu care contin valori egale
cu valoarea data

7. sumif(domeniu-de-cautare, valoare-cautata, domeniu-de-insumare) — realizeaza
Tnsumarea valorilor din domeniul dat ca al treilea parametru pentru acele valori din domeniul
de cautare care sunt egale cu valoarea cautata
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Exemplul 1
Sa presupunem ca se Tnregistreaza meciurile de fotbal cu rezultatele lor in foaia de
calcul cu structura urmatoare:

A [ B [ C N O N = | O < O I [
1 jnaca "acasa” Ij,,m “in deplasare” I gokuri date de goluri date de
2 echipal echipa2
3|
4 |nr-meci echipal echipa? loc data i 2 '(d/
5| 1/ steaua dinama iagi 1.06.2006 1 1
B 2 rapid steaua bacau | 2.06.2006 2 3
7 3 rapid dinamo cly  [3.06.2006 5 2
g 4 steaua pol-iasi buc 4 06,2006 2 4
a. Vrem sa aflam:
1. cate meciuri au fost jucate de =countif(b5:b100, "steaua")
echipa ,steaua" acasa
2. cate goluri au fost date? =sum(f5:f100)+sum(g5:900)
3. la cate meciuri echipa aflata in =countif(G5:g100,4)
deplasare a inscris 4 goluri?
4. care este numarul minim de goluri =min(g5:9100)
inscrise de o echipa in deplasare?
5. care este numarul maxim de goluri | =max(f5:f100)
inscrise de o echipa ,acasa"?

b. Vrem sa afisam un clasament al echipelor. Stim ca pentru fiecare meci castigat se
acorda 3 puncte, la egalitate se acorda 1 punct. Situatia punctajelor si golaverajelor
o vom face pentru fiecare meci Tn parte.

Fl G H K , L M
golaveraj pt. echipa de | ¥Iavera] pentry echipa punctaj pentru
" p eplasare echipal si pentru

echipal echipa2 gl g2 g1_g2 g2_gl pct_pt_el pct_pt_e2

steaua dinamo 1 1 =F5-G5 =G5-F5 =IF{F5=G5,1IF(F5>G5,30)) =IF(F5=G5,1,IF(G5>F5,30))
rapid steaua 2 3 =FB-G6 =G6-Fb =IF(FE=G6,1 IF(FE>GE 3 0)) =IF(F6=GB,1 IF(GE>F6,30))
rapid dinamo 5 2 =F7-G7 =G7-F7 =IF(F7=G7 1 IF(F7>G7 3.0)) =IF(F7=G7 1 |F(G7>F7 3,0))
steaua  poli-iasi 2 4 =FB-G8 =G8-F8 =IF(F8=G8,1,IF(F8>G8 3 0)) =IF(F8=G8,1 |F(G8>F830))

e e M o4 g e, e om ey -y PR

Pentru clasament va trebui sa Tnsumam punctajele si golaverajele pe echipe si sa
sortam descrescator in functie de punctaje si apoi de golaveraje.

A ] D [ E T~
4 dinamo =SUMIF(ech1 Ad pct_pt_e1)+SUMIF(ech2 Ad pct_pt_e2) =SUMIF{echl A4 g1_g2)+SUMIF(ech2 Ad g2_g1) =
5 poliiasi =SUMIF{ech1 A5 pct_pt_e1)+SUMIF(ech2 A5 pct_pt_e2) =SUMIF(ech1 A5 g1_g2)+SUMIF(ech2 A5 g2_g1)
B rapid =SUMIF{echl AB pct_pt_e1)+SUMIF(ech2 A6 pct_pt_e2) =SUMIF(ech1 AB,g1_g2)+SUMIF(ech2 AB,g2_gl)
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Sarcini de laborator

6*. O firma de consultanta juridica desfasoara diverse activitati. Managerul firmei doreste
o evidenta clara a numarului de ore pe fiecare categorie in parte (consultante, documentare,
analize, alte activitati) in fiecare zi a unei luni. De asemenea, acesta doreste sa stie:

a. Cate ore au fost in total pentru fiecare categorie in cursul unei luni.

b. Cate ore s-a lucrat in fiecare zi.

c. Care este ziua cand s-a lucrat cel mai mult?

d. Care este categoria la care s-a lucrat cel mai putin?

e. Cate ore se lucreaza in medie pentru fiecare categorie in parte pe luna?
£

. Care este raportul intre numarul de ore ocupate pe fiecare categorie si numarul total de
ore.

g. In cate zile nu s-a lucrat deloc pentru documentare? Dar pentru analize, consultatii etc.?

4.4.1. Functii statistice pentru baze de date Excel

Toate functiile pentru baze de dateAau numele precedat de litera ,,D” si folosesc
tabelul Excel organizat ca baza de date. In acest caz putem folosi numele de camp intre
parametri, dar Tncadrat Tntre ghilimele.

Lista Excel este definita printr-un domeniu in care trebuie luat in considerare si prima
linie a numelor de camp.

Baza de date poate fi filtrata prin introducerea unei conditii precizata prin domeniu in
formatul functiei. Formatul general al functiilor statistice pentru bazele de date Excel
este

Functie (baza-de-date, camp-de-actiune, conditie-de-filtrare)

Sunt doua modalitati de a referi baza de date: prin domeniul de celule sau fie prin
numele ei acordat prin Insert>Name—> Define. Este bine sa dam un domeniu mai mare ca
numar de linii pentru a nu fi necesar sa-l redenumim odata cu adaugarea de noi articole.

Campul folosit Tn functie se poate referi prin numele sdu din structura bazei de date
Tncadrat Tntre ghilimele sau prin numarul de ordine n structura.

Conditia se poate referi prin domeniul de celule sau prin numele dat.

copiind structura bazei de date si, daca mai este nevoie de alte campuri, acestea

@ Este comod pentru proiectant ca pe zona de inceput a foii sa puna conditia
sa fie adaugate dupa structura.

Vom explica functiile statistice prin exemple folosind urmatoarea foaie de calcul,
special proiectatd pentru a facilita infelegerea variantelor de construire a functiilor.
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A B c D E F G
1 |cod categorie nume_produs unit_de_pret_produs cant_stoe
2 electrice ==200 —_— Foaia de calcul pentru
3 ™~ operatiile de calcule
g statistice
B cod categorie nume_produs unit_de_pret_produs cant_stoc
7 1 mobila  birou C©_345  buc 134 100 L
3] 2 maobila masatip A buc 45 0 Convenim sa
g Jmobila  scaun BMNTRD buc 2210 100 numim
0 4 mobila raft carti buc 50 0 Stocuri=
11 5 mobila raft carti_tipb buc e 100 A6:F17
12 B mobila  |masa calculatc buc Z30 100 o
13 7 electnice  lampa_de_cart buc 200 63 Conditie=
14 3 electnce  lampadar buc 200 20 Al:F2
15 9 papetarie foi-albe pac 10 100
16 10 papetarie foi-color pac 20 1
17 11 papetarie |clarne punga 12 1

Fie o baza de date cu stocurile anumitor produse. Pentru fiecare produs am indicat
numele, categoria sa, stocul existent si preful. Am pus stoc zero acolo unde produsul
lipseste.

Criteriul de filtrare este comun tuturor functiilor din exemplele care urmeaza:

Produsele de ,categorie=Electrice” si ,,Pret>=200"

1. Functia DCOUNT — numara celulele care contin numere,fara spatii.

Exemplu: Vrem sa aflam cate produse din categoria electrice cu pref >=200Lei sunt in
stoc.

Putem folosi:

a.=DCOUNT(A6:F17,"cant_stoc”,Al:F2) -2 numara produsele fara spatii in campul
cant_stoc.

b. =DCOUNT(stocuri,6,conditie)>2 realizeaza acelasi lucru dar foloseste numele
stocuri pentru baza de date (A6:F17), numarul coloanei cant_stoc este 6 iar pentru conditia
plasata pe domeniul A1:F2 am folosit un nume ="conditie”. Daca in celula F13 am
avea spatiu rezultatul s-ar schimba la 1 pentru ca functia nu numara si celulele blank.

c. =DCOUNT(stocuri,conditie)>2 numara articolele care indeplinesc conditia fara a
cerceta valorile blank sau non blank de pe o anumita coloana.

2. Functia DSUM calculeaza suma pe o coloana datd prin numarul ei sau numele ei
pentru acele articole care verifica conditia.

Exemplu: numarul total de bucati din categoria electrice cu pretul >-200
=DSUM(stocuri,6,conditie)>83 insumeaza cantitatile existente in stoc

3. Functia DAVERAGE calculeazd media aritmeticd pe o coloana data prin numarul ei
sau numele ei pentru acele articole care verifica conditia.

Exemplu: care este pretul mediu al electricelor?
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=DAVERAGE(A6:G17,"pret_produs”,conditie)> 250 calculeaza pretul mediu al
produselor filtrate.

4. Functia DMAX /DMiN-extrage maximul sau minimul valorilor filtrate
Exemplu: Care este pretul maxim al produselor electrice peste 200 lei?
=DMAX(A6:G17,"pret_produs”,A1:F2)->300 calculeaza pretul maxim.
Exemplu. Care este stocul minim din produsele electrice cu pret >2007
=DMiN(A6:G17,"cant_stoc”,A1:F2)>20 calculeaza stocul minim.

Sarcini de laborator

1. Refaceti foaia de calcul din lectie.

2. Pregatiti foaia pentru a se putea calcula, fard mari modificari, aceleasi informatii,
dar pentru alte categorii de date. Veti calcula numarul de produse, suma cantitatilor din
stoc, valoarea medie a preturilor, pretul minim si maxim pentru:

a. produsele de mobila cu stoc=100 ; b. produsele care au codul >5
c. produsele care au stocul zero; d. produsele care se vand la bucata! e. produsele
de papetarie sau de mobild; f. produsele de papetarie sau cu prefuri <100; g.

produsele de mobild cu prefuri<100 si (stocuri =0 sau stocuri =100); h. toate
produsele.

3. O societate comerciala Tnregistreaza contractele si facturile in doua foi de calcul
ale aceluiasi registru. Pentru contract se retin urmatoarele informatii: data si numarul
contractului, numele furnizorului si valoarea contractului.

Aflati:
a) diferenta dintre valoarea totald contractata si valoarea totala facturata;
b) cate contracte au valoare mai mica de 500 unitati banesti;
¢) cate contracte nu au facturi;
d) cate contracte au fost Tndeplinite (valoare contract = suma valorilor facturilor
primite);
e) realizati o situatie a tuturor contractelor in care sa apara alaturi de valoarea in

lei a contractului in format numeric cu doua zecimale si valoarea scrisa in
euro si dolari la un curs de schimb variabil.

0 I,
Test 3 S

Testarea urmareste verificarea modului in care s-a inteles functionarea conditiei si a
principalelor functii statistice
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1. Introduceti foaia de calcul din imaginea urmatoare intr-un registru nou. Refaceti
formulele. Indicati Tntr-o noua coloana asociata fiecarei functii ce se calculeaza in functie.

2. Copiati baza de date in altad foaie de calcul si aflati:
a. numarul scolilor care au plan de investitii

b. valoarea totald a planului de investitii pentru scolile cu profil ,fizica chimie”
c. numarul de elevi de la scolile ,,V.Lupu” si ,V.Alecsandri”
d. numarul maxim de profesori dintr-o scoala
e. numarul de produse cu stoc zero
f.  pretul minim si cel maxim
g. calculati pentru fiecare profil o situatie statistica cu numarul total de clase
h.  calculatti pentru fiecare profil o situatie statistica cu numarul total de scoli
A B C D E i | J n
1 lscoala profil |ni_clase | ni_prof | plan | ni_clase Formula rezultat
5 informatica |>10 <1b =DCOUNT(AS:E, "plan",A1.F2) 1
3 matematica =DCOUNT(scoala;"plan",A1:F2) 1
=DCOUNT(scoala;"plan"; scoala) 5
4
5 Jscoala profil  ni_clase ni_prof plan =DMAX(scoala;"Plan’ A1B2) 105
informatica 15 1 =DMIN(scoala;"Plan",B1:83) 0
[ 6 [Gr. Moisil"
| . Matematica 12 19 % =DSUM(scoala;"nr_clase"Al:B2) ¥
[ 7 ['Negruzzi
8 |'M. Viteazu' infarmatica ] 9 105 =DSUM(scoala;"nr_prof*info_10_16) A
9 [ L’ informatica 14 0 7 =D3UM(scoals;"nr_prof';info_sau_mate) 60
10 [*Anghel Salig Matematica ] 8 B =DAVERAGE(scoala;3;info_sau_mate) 1.2
o firicachime 25 B4 =DAVERAGE(scoala 3.01:02) 35
11]"V. Alecsandi

Fiecare functie de la sarcina 1 se va puncta cu 1 punct.
Fiecare cerinta a sarcinii 2 se va puncta cu 0,5 puncte.
1 punct din oficiu.
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Lectia 5

Operatii de cautare

v’ Cautarea in liste prin formulare Excel

v’ Cautarea si editarea datelor prin Edit-> Find/Replace
v’ Functia de cautare VLOOKUP

v’ Functiile ISNA, ISERROR, ISBLANK

5.1. Cautarea si editarea informatiilor prin formularul
asociat listei

Operatia de cautare si pozitionare pe articolele care indeplinesc o anumita conditie se
poate face si prin formularul asociat listei, prin butonul Criteria. Formularul afiseaza un
articol cu valori vide. Vom completa valorile pentru acele campuri folosite in conditie.
Dupa introducerea criteriului formularul va permite vizualizarea numai a liniilor care
Tndeplinesc conditia. Anularea filtrarii se face prin butonul Ferm. Putem folosi si caracterele
de substituire.

e 7_ 3 De exemplu, dorim sa vedem si eventual sa
IS P modificam datele privind béietii in varsta de 10 ani.
MUME: | Criteria Vom apasa butonul Criteria si vom introduce valoarea

L] - n N A ~ H b ”
| yarstar [0 10(3[oresPunz:altoare campului vérsta si valoarea “m
entru campul sex.
LOCATIE: Clear P . p’\ . n .
i e Ea— Revenim in formular prin butonul Form. Inchide-
= = ﬂ rea formularului se face prin butonul Close.

Fig. 5.1. Formular asociat varstei.

Sarcini de laborator
1. Folositi formularul pentru baza de date ghizi si afisati doar elevii care sunt repartizati
la parter.

2. Afisati doar elevii din sali indiferent de sala!
Indicatie. Folositi caracterul de substituire ? sau *. Ex: ,,sala?” sau ,,sala*”

5.2. Cautarea si editarea informatiilor prin Edit->Find

0 modalitate des folosita pentru cautarea si pozitionarea cu sau fara corectarea unei
valori se face prin Edit>Find. Fereastra care se deschide permite selectarea operatiunii
si precizarea domeniului de cautare: foaia de calcul curenta sau registrul curent. Se
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poate cauta pe coloana sau linia anterior selectata sau n tot registrul. Pentru o comanda
Find All se scrie si un raport cu adresele celulelor gasite, care permite o pozitionare
directa si rapida pe foaia de calcul si celula.

Exemplu:

Dorim sa cautam ghizii cu varsta de 10 ani si am completat fereastra de dialog Edit>Find
ca Tn imaginea alaturata. Butonul Find All a afisat un inventar al celulelor unde s-a
gasit valoarea.

1 Find and Replace
1 NUME WARSTA

| EARNEN 0] Find | Reglace |
3 |BEBE 0

M 4 10ANA 10l Fodwhat:  [io ~] [NoFormatset |  Format... «|
5 |IONUT 12
6 VICA 10
7 |MARIA 10} within: [Sheet v| I Match case
g ey I—H pory— I Match entire cell contents
10 Look in: Ivalues - Options <<
1
:g Frdal | [Endnext | Close |
14 Book | Sheet | Name |Cel |Value | Formula [a
15 Bookl.xls g
16 Bookl.xls  ghizi(3) 46843 10
17 Bookl.xls  ghizi (3) $6$4 10
18 Bookl.xls  ghizi (3) $8§6 10 v
i« » nl{ vacanta / fiof® ceis) found

Fig. 5.4. Fereastra Find and Replace contine celulele cdutate din toate foile registrului

5.3. Functia de cautare VLOOKUP

Operatiile de cautare analizate pana acum au folosit lista Excel ca tabel unde se
cauta si constante pentru cdutare. Dar ce ne facem cand valoarea cdutata este variabila
si se gaseste Tntr-o lista, iar zona de cautare este Tn alta lista? n plus, Tn urma cautérii
dorim nu o pozitionare pe linia unde se gaseste valoarea, ci chiar o alta informatie.

Vom folosi functia de cautare Vlookup cu formatul general:

VLOOKUP(ce-se-cauta; unde-se-cautd; coloana-pentru-raspuns; True/False),

unde <ce-se-cautd> reprezinta adresa celulei care contine valoarea ce se cautd, <unde-
se-cauta> reprezinta o listd organizata pe cel putin doua coloane, din care prima coloana
este cea In care se cauta. Raspunsul poate fi valoarea din coloana specificata in parametrul
3. Cautarea poate fi exacta (parametrul al 4-lea este False) sau aproximativa (True).

Daca este o cdutare exacta, atunci se foloseste linia unde s-a gasit valoarea cautata.
Daca este o cautare aproximativa, atunci se foloseste linia anterioara celei pe care s-a
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gasit o valoare mai mare. Tn acest ultim caz, domeniul de cautare trebuie ordonat crescétor
pentru prima coloana.

Sa urmarim modul de lucru cu functia Vlookup prin exemple.

Exemplul 1.

Cautare exacta
— formatul functiei este VLOOKUP(ce-se-cauta, unde, ce se intoarce, FALSE)

La un depozit en-gros se vand produse de mobild pe baza unor comenzi facute de
clienti. Acestia au la dispozitie un catalog si comanda contine doar codul produsului
si cantitatea. Depozitul trebuie sa Tnregistreze comenzile si sa calculeze valoarea
fiecarei comenzi.

Analiza problemei

Sunt doua categorii de informatii de intrare. Pe de o parte, informatii despre produse,
cum ar fi codul, numele, pretul. Pe de altad parte, informatii despre comenzi: numele
clientului, produsul si cantitatea solicitata. Informatia de iesire este valoarea fiecarei
comenzi pentru care avem nevoie de preful produsului — care se gaseste Tn alta lista.
Deci va trebui sa o cautam!

Proiectarea foii de calcul:

Lista cu produse se afla Tn domeniul B2:D7, iar comenzile sunt Tn domeniul G3:17.
Dorim sa asociem pretul produsului de pe fiecare comanda stiind codul sau.

_————————————
A B © D E F G H | J K

1 cod_produs  nume_produs  pret_produs
2 birou C_345 120 codul produsului client cantitate pret valoare
3 tabela de 120 masa tip A 200 140 sc. Albina 20 220 4
4 cautare are 140 scaun BNTRD 220 450 sc. Albina 100 a0 g
[ E;g;::’: 450 raft carti ] 160 sc. Wiespea S5A 5 230 1
5 iFormatia 146 raft carti_tip b 34 100 sc . Albina 107 #mea Tog
7 cautata 160 masa calculator 120 popescu b 2 200
8 pe celelalte coloane - -
9 gasim informatii care functia de cautare exacta are ultimul

10 pot fiintoarse de parametru FALSE

11 functia de cautare B

ﬂ j7=YLODKUP{g7;produse;3;FALSE)

13

Fig. 5.3. Cautare exacta prin Vlookup. Organizarea foii de calcul

Rezolvare:

Pasul 1. Proiectdm zona pentru baza de date cu produse. in prima coloan4 se va gasi
codul, apoi numele si pretul fiecarui produs. Formatam la tipul dorit. Denumim domeniul
B1:D1000="produse".

Pasul 2. Proiectam zona de comenzi care va contine pentru fiecare comanda codul
produsului cerut, clientul si cantitatea.

Pasul 3. Adaugam o coloana Pref. Vom pune formula J3=Vlookup(G3;produse;3;False )
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Cum se executa functia? Se cautd valoarea din G3 in prima coloana din domeniul
»produse”. Daca se gaseste, se ntoarce preful din coloana a doua. Dacd nu se gaseste
valoarea cautatd, atunci functia intoarce o eroare de tip #N/A. (nu exista valori
disponibile).

Pasul 4. Verificam cu date de test. Observam mesajul de eroare daca nu se gaseste
codul.

Exemplul 2:

Cautare exacta
— formatul functiei este VLOOKUP(ce-se-cauta, unde, ce se intoarce, FALSE)

Dorim o foaie de calcul pentru un mic FXE - A 200020
magazin ce vinde telefoane celulare.
Operatorul trebuie sa afle rapid
informatii despre o persoana plecand
de la numarul ei de telefon. Observati
in captura ecran o astfel de foaie Tn
figura alaturata. Baza de date contine,
pe langa numarul de telefon al
proprietarilor de telefoane mobile,

A B c D

nurnar de telefon persoanadinstitutia
ionescu mircea

valoarea cautata:
cautare exackta

=VLOOKUP{A4;kelefoane; 2;FALSE)

O~ 0 M e b=

9 |lista abonatilor telefonici

. ~ 10 numar nume adresa
numele si adresa acestora. In zona |11 222372 ionescu mircea str. Pacurari nr 77
vizibila se va putea introduce numarul |12 222444 vasilescu ioana str. Dumbrava nrd
. . 13 123123 taxi-plumb gara
de telefon Sl automat se va af|§a 14 232323 taxi-rapid str. Frumoasa nr.d
numele persoanei — daca numarul U= L1567 faxmad nosta

exists! Fig. 5.4. Organizarea foii pentru cdutare exacta

Cum se procedeaza?

Pasul 1. Cream lista cu informatii despre proprietari, pe care am numit-o ,,telefoane”.
Numerele de telefon nu sunt ordonate.

Pasul 2. Am plasat o valoare de test Tn zona A4 ca fiind numarul de telefon pe care il
vom cdauta.

Pasul 3. Am pus formula Tn celula C4=Vlookup(A4; telefoane;2;False) si o copiem in
rest — pe cel putin 4 celule!

Pasul 4. Am verificat functionarea formulei, dand valori care se gasesc in lista, dar si
unele care nu se gasesc, caz Tn care s-a afisat un mesaj de eroare

Deci

Cautarea exacta se solicita prin ultimul parametru (False) atunci cand domeniul de
valori unde se cauta nu este ordonat.

Cum functioneaza cautarea exacta? Valoarea data in functie este cautata pe prima
coloana in domeniul de cautare pana cand:

a. se gaseste o valoare egala — caz Tn care functia se pozitioneaza pe linia acestei
valori si intoarce valoarea corespunzatoare gasita in coloana 2 (adicd numele persoanei)

b. ajunge la sfarsitul domeniului de cdutare — caz in care Intoarce mesajul de eroare #N/A
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Atunci cand cautarea esueaza functia afiseaza un mesaj standard #N/A. Este

bine sa specificam un mesaj adecvat. Pentru aceasta putem folosi functia
iSNA(), care intoarce True daca prin evaluarea parametrului s-a obtinut o situatie de eroare
tip #N/A, sau functia iSERROR(), care trateaza orice caz de eroare.

Vom scrie deci formula pentru celula J3=
=iF(iSNA (Vlookup(G3;produse;3;False));"cod eronat”; Vlookup(G3; produse; 3; False ))

@ Tratarea erorilor. Functile iSNA, iSERROR()

Sarcini de laborator
1. Duplicati foaia de calcul ,comenzi” si lucrati urmatoarele sarcini Tn noua foaie.

2. Asociati la lista comenzilor inca o coloana n care sa obfineti prin cautare numele
produsului comandat, luand pentru fiecare comanda codul produsului din prima coloana.

3. Creati o zona de cautare pentru clienti Tn care sa codificati clientii si sa retinefi
numele si adresa si contul la banca. Codul clientului sa fie un sir.

4. Stergeti din coloana Client a bazei de date despre comenzi valorile text, formatati la
intregi si puneti coduri care se repetd, nu neaparat ordonate.

5. Adaugati coloanele Nume_client si cont_la_banca preluand prin cautare valorile
corespunzatoare codului de client pentru fiecare comanda in parte

Exemplul 3:

Cautare aproximativa intr-un interval de valori
— formatul functiei este VLOOKUP(ce-se-cauta, unde, ce se intoarce, TRUE)

La o editura se acorda reducere in functie de numarul de carti comandate. Astfel,
pentru comenzi mai mari ca 65 buc. se acorda 30%, intre 10 si 30 buc. se acorda
5%, iar intre 30 si 50 reducerea este de 20%.

Dorim o foaie de calcul care sa Tnregistreze comanda si sa calculeze reducerea.
Observati Tn imaginea de mai jos imaginea foii de calcul.

Ffe =WLOOKUP(HS reducere; 2, TRLE)

= H

1 nr_carti  reducere

2 1 0 comanda_nr cant procent reducere
ﬂ 10 5% 12345 din 1352005 10§ 0.050

4 30 10% 12346 din 1/4/2005 29 0.05

5 50 20% 1000 din 1/5,2005 4 ]

5 (5] 30% 2340 din 252005 a5 0z

7 3400 din 552005 G5 03

& 3456 din 752005 70 03

Analiza problemei

Avem nevoie de o baza de date despre comenzi unde sa retinem datele despre fiecare
comanda si cantitatea solicitata. O alta categorie de informatii se refera la procentele
de reducere si conditiile acordarii lor. Judecam astfel: Daca se comanda mai putin de
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10 nu vom avea reducere. Prima reducere, Tn valoare de 5%, este pentru 10 buc. A
doua valoare este reducerea de 10% pentru 30 buc. Deci intre 10 si 29 buc. reducerea
este aceeasi, de 5%.

Trebuie sa stim cum functioneaza functia de cautare VLOOKUP inexacta.

Functia cauta pe coloana pana cand:

a. intalneste o valoare egald — caz n care se opreste si se pozitioneaza pe linia gasita;
b. intéaneste o valoare mai mare decat valoarea cautata — caz in care se pozitioneaza
pe linia anterioara ultimei valori;

c. ajunge la sfarsitul tabelului — caz Tn care se pozitioneaza pe ultima linie.

Proiectarea foii de calcul

Pasul 1. Vom construi tabelul de cautare punand numarul de bucati limita pentru fiecare
procent.

Pasul 2. Proiectam baza de date pentru comenzi (coloanele G:H).

Pasul 3. Pe coloana /i punem formula de cautare aproximativa i3=Vlookup(G3;
reducere;2;true) si copiem pe coloana.

Pasul 3. Punem valori de test si urmarim functionarea formulei.

Sarcini de laborator

1. S$tim ca daca media este peste 9.50 elevului i se da premiul 1, daca este intre
9.50 si 9 obtine premiul 2, iar daca este de la 9 la 8.50 obtine premiul 3.

2. Adaugati coloana Premiu_var_if si puneti formula de atribuire automata a premiului
prin functia if.

3. Adaugati coloana Premiu_var_lookup si folositi pentru calcularea premiului functia
Vlookup.

4. Deschideti registrul Balcaniada. Separati in doua foi datele astfel Tncat sa aveti:

a. Tnfoaia de calcul Ghizi o baza de date despre elevii ghizi cu: nume-ghid, varsta,
locatia, scoala-de-unde-vine, sex, codul-musafirului de care se ocupag;

b. Tn foaia de calcul Participanti o baza de date cu toti participantii cu urmatoarele
campuri: cod-participant, nume, tard, varsta, sex, disciplina de concurs, bursa,
taxe_si_alte_cheltuieli. Observati ca legatura dintre ele se face prin codul
participantului.

5. Realizati o alta foaie de calcul, concatenand datele din cele doua baze. Veti copia
foaia ghizi si veti asocia fiecarui musafir, prin functia Vliookup numele, tara, varsta, sexul,
disciplina de concurs.
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Test 4 .

Testul vizeaza evaluarea cunostintelor si a deprinderilor de a cauta valori in liste Excel
Deschideti registrul ,,inspectorat” si pozitionati-va in foaia de calcul ,scoli.

1. Folositi Edit>Replace si modificati valoarea ,,da” la,,DA” si ,,nu” la ,,NU” automat
pentru toate liniile atat in coloana unde am retinut daca are cantina, cat si in coloana
pentru camin. Folositi Edit=>Find si cdutati in foaia de calcul ,,scoli” toate articolele
unde numarul de clase este egal cu 10.

2. Am dorit sa scriem cu rosu adresa si cu majuscule cuvantul /asi din adresa numai
pentru scolile din aceasta localitate. Pentru aceasta am folosit comanda Edit>Find
->Replace All. Urmariti fereastra de dialog. Credeti ca am completat corect? Unde am
gresit? Cum pot sa repar?

1 bani_elev ‘
2 Find and Replace
3
4 nr_c nume flla_dresa Fing  Replace |
ﬂ 1 G. lbraileanu Str, C. Negri, nr5lasi | Find whatt Tos = ) -
B 2 sc. Gen nr,2 IAS| Str. Culturii, nr.34, Harlau 0 ‘. [1asi =] | review |
7 3 M. Eminescu Str. Pacii, nr.3 IAS] Replace with: [1AST =] |
g ; ma::tona: bSt;.l gentrala, r':51IIAS[ within: I_Sheet w| ¥ Match case
ationa -dl Copou, nr.45 lasi r )
10 St Im Rows = Match entire cell contents
. n: [Formuas — ~]
12 Lookin: |Formulas
13
14 Replace Al | Replace | Frdal | [ Endnext |

3. Creati o altad foaie de calcul cu numele Profesori in care sa retineti datele despre
profesori: numele, salariul de baza, vechime (in ani), codul scolii unde lucreaza. Puneii
valori pentru 5 profesori, din care 3 sa lucreze la aceeasi scoala. Folositi pentru scoala un
cod numeric cuprins intre 1 si 10 (O daca nu lucreaza!).

4. Completati prin cautare Tntr-o noua coloana numele scolii unde lucreaza, stiind ca
codul scolii este chiar numarul curent din baza de date Scoli.

5. Scrieti Tn celula mesajul ,,nu lucreaza” daca nu se gaseste codul scolii.

6. Completati tabelul ,,profesori” cu o noua coloana ,,profil” in care sa puneti profilul scolii
unde este titular profesorul. Completati cu valori din baza de date Scoli folosind functia Viookup!

7. Sa se afiseze pentru fiecare profesor sporul de vechime in munca, stiind ca daca
vechimea este intre 5-10 ani se acorda 10% din salariu, intre 11 si 20 ani se acorda 15%,
intre 21-25 de ani se acorda 20%, iar peste 26 de ani se da 25% din salariul de baza.

a. folositi IF si construiti formula in coloana sporl;
b. folositi VLOOKUP si construiti formula in coloana spor2.
8. Formatati coloana spor2 astfel incat profesorii care nu au spor sa aiba celulele goale.

Fiecare sarcind va fi notata cu céte 1 punct + 1 punct din oficiu.
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Gruparea si totalizarea

Lectia 6

datelor

v’ Totalizare

v’ Tabele pivot

6.1. Subtotalizarea datelor organizate in liste Excel

Gruparea articolelor unei liste Tn functie de valorile dintr-una sau mai multe coloane si
obtinerea unor sume, medii, valori maxime sau minime pentru grup sunt operatii realizate
automat de Excel prin meniul Data—> Subtotal.

Fereastra de dialog Subtotal permite fixarea criteriului de grupare prin selectarea
coloanei din lista At each change in, a functiei de totalizare din lista Use function, a
locului unde se vor calcula valorile prin selectarea casetelor de validare corespunzatoare
coloanelor din tabelul sursa (Add subtotal to). Fiecare grup de articole poate fi plasat pe o
noua foaie daca activam comutatorul Page break between groups. De asemenea liniile de
totalizare pot fi asezate Tnaintea grupului sau dupa (Summary below data).

Aceeasi fereastra permite anularea subtotalizarii prin butonul Remove all.

Exemplul 1.
Folosind baza de date a ghizilor si ghiduselor din lasi dorim sa aflam numarul de copii
de pe fiecare sala.
1|23 A B T D —
1 Subtotal ri_g|
X 2 NUME VARSTA LOCATIE SEX FRUNE
3 ANDREI 14 hol f f ocnmz =
4 GICA 12 hol f _
5 GABI 10 hol m 'f;:f‘m -
= |6 3 hol Count Add subtotal to:
- | 7 BEBE 10 parter f [~ NUME -
- B I0ANA 10 parter m kzm
= = 2 parter Count
[ - 10 VICA 10 sala 1 f ¥ Reclace garert subtotals
11 IONUT 12 sala 1 m Y ——
= EJMARIA 10 sala 1 m W Summary below data
- 13|LEO 13 sala 1 m o]
- 14 4 sala 1 Count = i | x N
- 15 9 Grand Count
1B
Fig. 6.1. Subtotalizarea datelor
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Cum facem?

Pasul 1. Selectam tabelul.

Pasul 2. Ordonam dupa campul Locatie.

Pasul 3. Deschidem fereastra Subtotal prin Data—> Subtotal.

Pasul 4. Fixam criteriul de grupare alegand din lista At each change coloana ,,Locatie”.
Pasul 5. Selectam functia Count.

Pasul 6. Indicam locul unde se va face numararea liniilor din grup ca fiind coloana
vérsta. Tabelul se transforma si apar liniile de subtotal si de total general. Putem edita
mesajele introduse de Excel.

Important este ca aceste valori se actualizeaza automat odata cu modificarea valorilor
din grup.

Observati nivelurile de grupare de pe primele coloane ale foii de calcul.
Putem obtine o forma centralizata sau detaliata daca actionam butoanele de
expandare plasate Tnaintea tabelului prin care se afiseaza sau se ascund
detaliile la nivelul dorit.

I

Sarcini de laborator
1. In baza de date Ghizi obtineti numé&rul de elevi ghizi pe grupuri de varste.

3

|
|
|

+ |+

|

Fig. 6.2. Butoane de expandare la nivelul grupului

2. Copiati situatia centralizatoare in alta foaie de calcul, formatati astfel ncat sa aiba
titlu, spatii separatoare intre subtotaluri, mesajele scrise in roméaneste.

3. Obtineti o situatie centralizatoare a elevilor ghizi pe locatii calculand varsta medie
pentru fiecare locatie.

4. Obtineti doar varsta medie pe fiecare locatie, fara detalii, in alta foaie de calcul.
Formatati-o in vederea tiparirii la imprimanta.

Exemplul 2.
Obtinerea unei situatii centralizate pe doua nivele de grupare
FRrIIA  I R - Dorim o situatie centralizatd a numarului de
1 scolari pe sali, pentru fiecare sala separand fetele
= = o g
- 4| TOTAL GHIZI g| de baieti.
I_I_ + 5 HOL 3
= 8 FETE 2 =
- P p— +|  Cum am facut?
= 11 Pasul 1. Am ordonat tabelul dupa doua chei:
- 12 PARTER 2 . .
o [13 FETE 1 locatie si sex.
I‘. 1? BAIET! ! Pasul 2. Am deschis Data->Subtotal si am pus
i, ]g SALA1 FETE 1 grup pentru locatie ca n exemplul anterior. Am
l o 2 BAIETI 3| dezactivat butonul Summary below data.
: i Pasul 3. Am deschis din nou fereastra Subtotal
27
= pentru subgrup pentru coloana Sex.
g Pasul 4. Am inchis butonul de expandare la nivelul
« 4 »[vacama,(\‘on,(sreets[sreeu,(m}\g detaliilor.
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Pasul 5. Am formatat tabelul schimband textele implicite, inserand linii separatoare,
ascunzand coloanele neinteresante

Sarcini

1. Obtineti Tn foaia de calcul ghizi situatia centralizata a varstei medii pe scoli si
pentru fiecare scoald separat pentru fete si baieti.

2. Afisati in alta foaie de calcul situatia numarului de musafiri pe tari, pentru fiecare
tara, pe sexe si grupe de varsta.

3. Modificati in situatia centralizatoare unele valori (de exemplu schimbati varsta unui
musafir sau tara) si vedeti daca se reflectd aceasta corectie in randurile centralizatoare.

4. Modificati situatia Tn sensul introducerii unor noi linii sau stergerii unor linii. Se
actualizeaza liniile de total?

6.2. Tabele pivot

Obtinerea unei situatii centralizatoare de tip matricial avand datele centralizate din
doua puncte de vedere se poate face prin asistentul Pivot Table Wizard. Apelata prin
optiunea Data->Pivot Table, aplicatia asistent ne va indruma pas cu pas pentru realizarea
situatiei centralizatoare.

Exemplul 2:

Dorim sa numaram copiii pe varste si sex pentru fiecare sala sau total. Raportul poate
aparea sub forma prezentata mai jos.

Vom explica modul de lucru cu tabele pivot rezolvand problema.
ESee———————— ————————————————|

A B C D E F G H

1 [LOCATIE (Al | || Fig.6.3. Situatia
2 [NUME WARSTA LOCATIE SEX 222222277 3

| 3 |ANDREI 14 haol f [Count of NUME [SEX ] numarului de

1 GICA 12 haol f VARETA vl m Grand Total » Arsts si
5 GABI 10 hol m 10 2 3 g|| COP!! e varsta si
& BEBE 10 parter i 12 1 ] 5| sex filtrate la nivel
7 I0ANA 10 pater  m 13 1 1|| 2272222

B VICA 10 sala 1 f 14 1 1

9 NONMUT 12 sala 1 m Grand Taotal 4 5 =

10 | MARIA, 10 sala 1 m

11 |LEC 13 sala 1 m

12

Pasul 1. Precizam care este tabela de date sursa. De obicei, este o listd de date
Excel. Daca se doreste crearea unei tabele pivot din altd baza de date — de exemplu o
tabela Access — va trebui sa fie
stabilitd comunicarea directs intre PivotTable and PivotChart Wizard - Step 1 of 3

aplicatiile Access si Excel! Where s the data that you want to analyze

P 12.S lect o R B e e py py oy e (+ Microsoft Excel list or database
asul 2. Se selecteazd portiunea P it st

din tabela care va reprezenta sursa - —

de date. Fig. 6.4. Fixarea datelor sursa
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Pasul 3. Ultima fereastrd de dialoga Table [ ar T e T e PIX
Pivot Wizard ne permite sa alegem | inereisthe dsta that you want to use?

plasarea tabelei pivot in altd foaie de |range: [ENETETTIN .  Growse. .

calcul sau n aceeasi foaie unde sunt coce | <ok [[oe> | o |
datele sursa.

Prin butonul Layout se trece la proiec- Fig. 6.5. Fixarea domeniului pentru datele sursa
tarea formei si continutului tabelei pivot, iar prin butonul Options se deschide pagina
cu optiuni suplimentare (daca se va face totalizarea automata pe linii sau/si coloane,
daca se va actualiza
tabela odata cu
deschiderea foii de
calcul care contine
datele sursa, daca se

PivotTable and PivotChart Wizard - Step 3 of 3 RIx

‘Where do you want to put the PivotTable report?

. " New workshest
realizeaza un @ Existing worksheet
autoformat tabelei | . [TEE—
etc.) Click Finish ko create your PivotTable report.
@l Layout... options... | Cancel | <pack | [ Enisn ]

Fig. 6.6. 77777 situatiei pivot

i
LF B Fig. 6.7. Pentru proiectarea tabelei pivot
se executa Drag&Drop de la camp la zona
tabelei.

)
A
i

YARSTA

,_
2
]
m

Fig. 6.8. Plasarea criteriilor de
grupare pe linii si coloane. Filtrul
este la nivel de pagina: /ocatie.
Operatia este de numarare.

e
5
»

ROW

PivotTable Field

Source field: val

Fig. 6.9. De obicei, in cazul Tn care campul plasat
este nenumeric se asociaza functia Count, iar daca
Summarize by: este numeric se asociaza functia Sum. Putem
schimba functia prin dublu-clic pe functia din zona
Data. Se deschide o fereastrd de dialog PivetTahle
Field, de unde vom putea alege functia dorita.

Name: ISum of val
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Pagina Layout prezinta macheta tabelei. Zona Page va folosi la filtrarea datelor din
tabela pivot. In zona Row vom plasa campul/campurile din tabela sursa pe care le
dorim pe linii. Zona Column va cuprinde campul/campurile dorite pentru coloanele
tabelei rezultat.

Zona Data se refera la continutul tabelei (aflat la intersectia liniilor cu coloanele)
Poate sa fie valoarea unui camp sau o functie.

Tot aici vom putea fixa formatul datelor afisate prin butonul Number.

Odata terminata proiectarea tabelei pivot, aceasta se deschide Tn aceeasi foaie de
calcul sau Tn alta si are asociate doud elemente de interfata foarte utile:

SEX | - PivotTable FieldList ~ x | Prin operatii de
Count of NUME [LOCATIE < |[VARSTA = E)ersgrittems ko the PivotTable tragere Sl plasare cu
parer parter Total [hol mouse-ul pUtem
SCOALA - 10 12 10 | NUME / schimba rapid
Caol. Mational 2 0 2 ] YARSTA i H
lic. Cantemir 1 1 2 1 gmmm continutul din tabela
lic. Eminescu 1 0 1 0 pivot, inversa liniile
Grand Tatal 1 1 5 1 Efsex | |
~|scoaLa ~| || cu coloanele,
< > adauga/sterge
P crltgrll{le de grupare
pe linii/coloane.

Fig. 6.10. Fereastra Field List

1. Fereastra Pivot Table Field List contine toate campurile selectate initial din tabela
sursa.
2. Bara de hutoane PivotTable permite modifi- S —mm = 1 EICEER
carea tabelei pivot prin schimbarea aspectului

si/sau a continutului.

3. Meniul PivotTable contine mai multe operatii pe care le putem desfasura asupra
tabelei pivot.

BivotTable ~| 79 il Astfel, putem cere sa se formateze tabela sub forma unui
_itl P Raciort | raport, sa se creeze un grafic sau sa se apeleze aplicatia
. asistent.
g PivotChart . . R
' Comanda Refresh data este utila de fiecare datad cand se
_IE wizard... _ modifica sursa pentru a actualiza tabela pivot.
| $ RefreshData !

Sarcini de laborator
Folositi registrul Balcaniada. Completati-l cu datele necesare rezolvarii sarcinilor.

1. Afisati o situatie matriciala a numarului de musafiri pe tari si varste.

2. Modificati situatia pivot prin adaugarea la nivel de pagina a campului sex si afisati:
a. Numarul de musafiri fete pe tari si varste.
b. Numarul de baieti pentru fiecare tara si varsta.
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3. Schimbati forma situatiei punand pe linii sexul, pe coloane varsta si la nivel de
pagina tara. Ce obtineti?
4. Realizati o tabela pivot pentru varsta medie a ghizilor pe scoli si locatii.

5. Modificati raportul pentru a obtine varsta medie a musafirilor. Se poate prin fereastra
Field?
6. Modificati datele din baza de date. Adaugati un elev, modificati varstele sau locatiile.

Observati daca aceste modificari se reflecta automat in rapoartele facute. Ce facem ca sa
le actualizam?

7. Creati un raport cu sumele totale corespunzatoare burselor pentru fiecare tara si
disciplind de concurs. Dorim ca la sfarsitul raportului sa nu se calculeze totalul general,
ci numai pe fiecare linie in parte.

6.3. Folosirea campurilor calculate in tabele pivot

Sa presupunem ca pentru participantii la concurs organizatorii ofera o bursa, dar fiecare
elev are de achitat si anumite taxe. Deci lista participantilor va contine campurile: nume,
tara, punctaj, bursa, taxe, clasa.

Se doreste o situatie matriciala A B C D E F
a sumelor totale acordate drept 1 nume tara punctaj bursa taxe clasa
o, o p 2 Albulescu Mircea romania 10 100 10
burse pe tari si clase. Sa se adauge |3 Dobrescu Paula  romania 7 100 20
idi 3 4 Chiru Ludmila romania 10 200 30 1
totalul taxelor si diferenta de plata. 5 Jlonescu Madaiinalgrecis p 0 0 X

Observati situatia dorita.

Prin ce diferd tabelul centra-

2
3 clasa_v] lizator de celelalte? Prin faptul ca
4 tara w|Data - 9 10 12| Total pe tara n ..
5 bulgaria burse 000 40 400 a0l 1n zona de date avem 3 functii:
3] taxe 30 30 30 90 lei . | _
7 rest de plata 970 370 370 1,710 lei Sum(bursa)’ sum(taxe) §I Sum(reSt
B grecia burse 200 600 800 lei de—plata).
g9 taxe 0 10 50 60 lei .. . . .
10 rest de plata D 190 50 740 lei Implicit, aplicatia asistent de cre-
fljromania | burss L L inlel are a tabelelor pivot accept
12 taxe 30 30 0 60 lei p pta o
13 rest de plata 170170 0 30 eif - singurd functie totalizatoare. Pentru
14 Total burse 1,200 lei 800 lei 1,000 lei 3000 lei N .
15 Total taxe B0 lei 70 lei B0 lei 210 lei celelalte campurl care s€ numesc
1? Total rest de plata 1,140 lei 730 lei 920 lei 2,790 lei Cﬁmpuri calculate (CalCUlated erIdS)
folosim Insert->Calculated fields.
Cum facem?
Pasul 1. Vom proiecta o tabeld pivot [Sum of bursa [clasa_~]

A n . . n . tara - 9 10 12|Grand Total
precizand campurile folosite pentru randuri bulgaria 7000 400 200 1600
(tard), coloane (clasa) si functia totalizatoare grecia 200 600 800
( (b )) romania 200 200 400
sumiburse)). Grand Total 12008001000 3000

Pasul 2. Ne pozitionam pe foaia de calcul
unde am obtinut tabelul pivot si construim primul camp calculat. Deschidem fereastra de
dialog pentru inserare camp calculat prin Insert" Calculated Fields. Tn lista Fields sunt
afisate campurile bazei de date Excel. Putem sa le inseram n formula prin butonul Insert
Fields.
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e 7% Tn_ caseta cu text Name vom Qa nume
— 1 diferit de numele de camp, chiar daca

- X3 - ﬁ valoarea este chiar cea din campul taxe.
Tn caseta cu text Formula vom insera pre-

cedat de semnul egal, campul faxe. Ob-
servati formula. Apoi apasam butonul Add.

Forpula: I= laxe|

Fig. 6.12. Inserarea unui camp nou cu
valoarea unui camp existent. Dupa
construirea formulei apasam butonul <add>
si noul camp calculat este automat trecut n
Field list.

Pasul 3. Adaugam la tabela pivot campul diferenta

ntre bursa si taxe astfel: Insert Calculated Field
a) Deschidem fereastra Insert->Calculated Fields. Name: [cmp_diferente
b) Dam un nume campului si o formula de calculare.
i R Formula: |= bursa- taxe
c) Prin butonul <add> se adauga campul calculat la
lista de campuri si implicit Tn tabela pivot.
A B C D E F G H 7 Fig.6.13. )
1 |PivntTahIe Field List X lnserarea unui
g T | Drag items to the PivotTable Camp nou cu
s repork

4 [tar ~|bata ~ 9 90 i2[Grend Total valoarea
5 bulgaria Surn of bursa 1000 400 400 1800 [ nume calculata
5 Sum of crmp_taxe an 30 30 a0 [ tara
7 Surn of crnp_diferente 970 370 370 1710 ] punctai
g grecia Sum of bursa 200 600 300 ]
E Sum of cmp_taxe o 1 & gof | EPree Observati Field
10 Surn of cmip_diferente 0 190 550 7o | Efee List extinsa cu
11 rarnania Sum of bursa 200 200 400 [ clasa cémpuri le
12 Sum of crp_taxe 30 30 0 G0 | cmip_taxe .
13 Sur of crp_difsrente | 170 170 0 30| | 5 cp_diferente calculate numite
14 | Total Sum of bursa 1200 800 1000 3000 cmp_taxe §i
15 | Total Sum of crmp_taxe G0 70 30 210 R
16 | Total Sum of cmp_diferente 1140 730 920 2750 | Add To | Row Area -|| cmp_diferente.

Observatie. Daca dorim inversarea functiilor in zona de date se poate folosi aplicatia
asistent apelata din meniul PivotTable.

Putem da alt aspect situatiei matriciale folosind Format->Autoformat.

7 Format Repart...
il Pivarchart Lista formulelor afisata prin meniul
[F wieard... PivotTable>Formulas->List Formulas.
Delete...
] A B c Oy
Group and show Detal » i [Calculated Field l
| Formulas 4 | Calculated Field. .. 2 |Solve Order Field Formula
Order b 3 1 cmp_taxe =taxe
4 2 cmp_diferente =bursa -taxe
Salve Order.. 5 3 cmp_nr_elevi  =punctaj
Table Optians. .. List Formulas &
¥ = 7 Calculated ltem
IEVOtTaHe. s [ﬂ BERER | = &y 8 Solve Order Item Formula
9

Fig. 6.14. Meniul contextual Pivot Trash
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6.4. Reprezentarea prin grafic a situatiei matriciale prin
Pivot Chart

Odata proiectata situatia matriciala, putem sa alegem ca forma de vizualizare a
rezultatelor nu numai raportul sub forma tabelara, ci si sub forma grafica. Acest lucru se
poate solicita prin butonul PivotChart de pe bara de butoane PivotTable sau din meniul
contextual. Se sugereaza un grafic ale caror elemente le putem redefini prin meniul Chart.

Foarte important este ca avem posibilitatea filtrarii datelor din grafic prin listele asociate
liniilor, coloanelor si continutului (daca avem mai multe functii in zona de date).

p 1000
clasa «
burse [T}
bulgaria mib
ol
burse
grecia
ramania i
Fig. 6.14. Raport
sub forma de
’ grafic
Drop Data Items Here |

Situatiile centralizatoare matriciale sau de tip tabela pivot au cateva caracteristici
importante:

1. Sursa de date poate fi un tabel Excel sau o baza de date Access, sau alte surse
externe;

2. Pot fi rearanjate interactiv pentru a afisa anumite aspecte necesare analizei datelor.
Utilizatorul poate hotari ce functii se utilizeaza, ce vor contine coloanele si liniile tabelei
pivot, daca se va calcula sau nu totalul pe linii/coloane/general.

3. Se poate aplica un filtru asupra datelor care vor fi vizualizate Tn tabela pivot.

4. Tabela pivot are campuri ce corespund, n general, campurilor din baza de date
sursd, dar pot fi si campuri calculate (prin formule, functii). Tabelul se restructureaza
automat, interactiv, prin operatii de schimbare a pozitiei campurilor.

5. Daca datele din tabelul initial se modifica este necesara actualizarea prin optiunea

Refresh Data din meniul PivotTable sau butonul ¥ .
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Sarcini de laborator

*Activitatea de comercializare a citricelor in cadrul societatii ,,LACRIMA” se face
prin vanzatori ambulanti angajati. Fiecare vanzator trebuie sa comunice ce produs a
vandut, unde (localitatea), cand (luna) si cét (valoarea). Se cere:

A. Sa se proiecteze o foaie de calcul pentru baza de date.

B. Formatati foaia de calcul si stabiliti reguli de validare. Se vor afisa mesaje de informare
si de alerta Tn cazul introducerii eronate. Se va interzice introducerea unei valori eronata
doar Tn cazul lunilor; n rest se poate accepta si o altd valoare decét cea din lista.

Se stie ca:

e vanzatorii sunt lonescu, Albulescu, Vasilescu si Marinescu;
e lunile sunt scrise sub forma prescurtata lan, Feb, Mar;

e |ocalitatile sunt iasi, Bacau, Zaldu, Suceava, Cluj;

¢ produsele vandute sunt Banane, Porto, Lamai;

e valoarea vanzarilor este cuprinsa Tn intervalul 1-1000.

C. Afisati baza de date ordonata pe luni, produse, localitati, persoane.

D. Aranjati datele astfel incat sa obtineti o situatie a vanzarilor medii pe luni prin
subtotalizare.

E. Afisati o situatie centralizatoare a sumei totale obtinute prin vanzare pe localitati,
pentru fiecare localitate calculand ca subtotal suma vanzarilor pe sortimente de produse.

F. Aflati prin filtrare directa care sunt valorile vanzarilor de banane Tn localitatea lasi
in luna ianuarie si ce vanzatori le-au realizat.

G. Sa se obtina un centralizator al vanzarilor pe localitati si pe luni. Pentru fiecare
localitate se va detalia cantitatea total vanduta pe produse. Se va folosi subtotalizarea.

H. Obtineti un tabel pivot pentru selectarea lunii si afisarea vanzarilor totale pe persoane
si localitati din luna respectiva.

I. obtineti un tabel cu suma vanzarilor realizate de fiecare persoana sau toate la un loc
pe luni, localitati si produse.

J. Pentru fiecare vanzator se inregistreaza atat castigurile, cat si cheltuielile de desfacere
a produselor n fiecare localitate si

« . . | All -
lund pentru fiecare tip de produs. |~ Lt l
Adaugati doua coloane si completati- prod v
. |pers w ||Data wlbanane lamai  porto  |Grand Total
le cu valori oarecare. ionescu Sum of castig 800 200 600 1600
. . . R o Sum of beneficiu 500 80 30 610
K. Afisati o situatie Tn care sa Sum of cost 300 1200 570 990
insumati castigurile, costurile gi |elescs |Sumofeasty 5o L
beneficiile pentru fiecare persoana/ Sum of cost 0 0 500 500
H albulescu Sum of castig 1000 300 1300
produs/localltate. Sum of beneficiu 480 40 0 520
L. Selectati doar vanzarile de Sum of cost 520_ 260 0 780
. . . . Total Sum of castig 1800 500 1300 3600
portocale din luna ianuarie cu valori  |[Total Sum of beneficiu 980 120 230 1330
cu prlnse 'l\ntre 500 §| 1000. Total Sum of cost 520 380 1070 22?0!
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M. Obtineti o situatie a vanzarilor sub forma luna si valoarea | B I E |
total vanduta. Atentie! lunile apar in ordine cronologicd, nu |1 Situalia vanzarilor
alfabetica! 2 |

Tn plus, este necesara formatarea tabelului. g :':.::w V"’O"":’?m

N. Modificati datele din luna ianuarie adaugand o noua |9 feb 700
linie cu valoarea 300. Obtineti acum acum tabelul ordonat |11 mar 200
descrescator, dupa valoare! 12

13 Total 1600

(.«
(Test 5 %

Testul urméreste evaluarea abilitatilor de grupare si totalizare a datelor Excel.

1. Deschideti registrul inspectorat. Verificati sa existe baza de date Scoli care sa contina
cel putin campurile urmatoare: cod, nume scoald, localitate, tipul, filiera, profil, specializare,
numar de clase, numar de elevi din care numar de fete, valoare de inventar, fond de investitii,
daca are camin, daca are cantina etc. Addugati eventual datele necesare rezolvarii sarcinilor
urmatoare. Verificati ca sa existe cel putin doua filiere, cu cel putin trei profile diferite, cu
cel putin 3 specializari diferite. Se poate ca o anumita specializare sa fie la mai multe
profile (ex. ,,Matematica-informatica” la profilul militar si la cel teoretic).

2. Aflati cati elevi sunt la fiecare specializare in parte si total pe inspectorat. Afisati in
foaia de calcul sit_1I.

3. Desenati graficul numarului de elevi pe specializari (obtinut la sarcina anterioara).

4. Aflati cate scoli sunt Tn total la fiecare profil, din care cate au camin si cate nu
folosind subtotalizarea. Afisati in foaia sit_2.

5. Afisati sub o forma matriciala numarul de clase din scoli pe profil (pe linie) si
localitati (pe coloana) cu posibilitatea filtrarii scolilor care au camin de cele care nu au
camin.

6. Folositi tabela pivot creata anterior si modificati forma astfel Tncat sa putem obtine
numarul de elevi total pentru fiecare specializare si localitate, fara nici o filtrare.

7. Realizati un grafic pentru situatia pivot obtinuta in sarcina anterioara.

8. Realizati o situatie care sa cuprinda numarul de elevi, numarul de fete si numarul
de baieti pe profiluri si pe localitati (atentie, va trebui sa folositi campuri calculate!)

9. Realizati graficul situatiei pivot obtinuta ca tabel in sarcina anterioara si obtineti
doar graficul numarului de baieti pe o localitate aleasa de voi.

Nota. Fiecare raspuns se va nota cu 1 punct + 1 punct din oficiu.
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Lectia 7 . .
ecta 7 prohleme financiare

v' Functii financiare pentru fluxuri constante
v’ Functii financiare pentru fluxuri variabile

Conceptul de baza in problemele financiare este valoarea banilor Tn timp. Valoarea
unei sume se schimba Tn timp datoritd potentialului castig de pe urma investirii sumei.
Ne Tntrebam adesea: Ce este mai valoros? 1 milion azi sau 1 milion peste 2 ani? Cum
judecam? E clar ca este mai valoros azi un milion, pentru ca, daca I-am depune o la
banca (fara risc!) cu o dobanda de numai 3% pe an obtinem peste 1 an 1,030 mil. iar
peste 2 ani 1,060 mil.!

Deci o problema ar fi sa dam suma initiala pe care o investim, o dobanda si sa afléam
suma viitoare. O alta problema ar fi sa aflam in cat timp am putea rambursa un imprumut,
cunoscandu-se comisionul sau dobanda platita la fiecare termen, ratele platite fiind egale.

O alta problema ar fi sa calculdm ce investitie ar fi mai avantajoasa: sa depunem la o
banca si sa platim rate constante sau sa investim la o firmd; unde achitdm sume variabile?

0 modalitate de rezolvare ar fi simularea situatiei cu ajutorul foilor de calcul parame-
trizate, ca Tn lectiile anterioare

O alta modalitate este folosirea functiilor financiare oferite de Excel. Sunt doua
categorii de functii:
a. pentru fluxuri constante de bani cum ar fi: PV (Present value — valoare curenta), FV

(Future value — valoarea viitoare), PMT (payment — rata), NPER (number of periods —
numar rate), RATE (rate O — dobanda).

b. pentru fluxuri inegale de plati cum ar fi IRR (internal rate of return) si NPV (net
present value — valoare curenta neta).

7.1. Functiile financiare pentru fluxuri monetare
constante

Formatul general este acelasi pentru toate functiile pentru flux constant folosite pentru
o investitie sau Tmprumut:

| Functie (rate; nper; pmt;pv;[tip]

unde
Rate = procentul dobanzii pe o perioada de timp
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Nper = Numarul total de perioade de timp de achitare a imprumutului sau depunere in
investitie

pmt = Plata (suma) periodica

pv = Valoarea la Tnceputul unei investitii — sau imprumutul

fv = Valoarea la sfarsitul unei investitii

tip = Tipul platii — ultimul parametru ia valoarea 1 pentru o plata la inceputul perioadei
si O pentru o plata la sfarsitul perioadei (implicit este O si poate lipsi!)
Dandu-se oricare 4 dintre acesti parametri, exista o functie care 1l calculeaza pe al

5-lea. De exemplu, pentru PMT (= suma periodica) trebuie sa stim valoarea prezenta, rata
dobéanzii, numarul de perioade si valoarea viitoare.

Sumele care reprezinta plati sunt introduse ca valori negative, iar sumele care reprezinta
Tncasari se introduc ca valori pozitive.

1. FV(rata; nper; pmt;pv;[tip])

calculeaza valoarea viitoare a unei investitii bazata pe depuneri regulate si constante
un numar de perioade la o ratd a dobanzii fixa.

Rata = dobanda la banii depusi pe o perioadd, nper = numarul de perioade, pmt =
suma ca rata sau plata periodica, pv = suma initiald depusa.

Exemplul 1.

Dispunem de un cont de economii in care depunem lunar cate 100 lei. Rata dobanzii la
banca este 3% pe luna. Cat vom avea in cont peste 10 luni daca initial am depus 100 lei?

Functia este = FV(3%;10;-100,-100) = 1281 lei, din care noi am depus efectiv 100 +
100*10 = 1100 lei, iar restul de 181 sunt sume prin capitalizarea dobanzii.

Sumele platite bancii se trec Tn functia financiara cu minus!

Nu e obligatoriu sa avem

A E c [ E F S -
i valoarea initiald depusa.
2 |suma_initiala 100 Exemplu FV(7%,10,-100)=
3 |dobanda 3% dobanda 3% o,
4 | suma_lunara 100 nr_rate 10 FV(7 /°’ 10’_100’0)
5 rata_perindica -100 | Observati Tn imaginea
B |luna suma valoare-initiala -100 5 ;
7 ] 100 valoare viitoare 1,281 Capturata (,),foale de calcu!
g 1 03 pentru ver|f|careq_mOQUIU|
g 2 309 de lucru cu functiile finan-
=FY(F3,F4,F5,F6 .
0 3 418 ( ! ciare.
1 4 531
2 5 647 Am plecat de la formulele
13 g ggg SERRIEITGIRE cunoscute din lectiile ante-
e 5 1016 rioare. B7 = B2 B8 =
3 9 1145 suma_lunara + B7 +
-— N .. .
! 10 1281 (B7*rata_dobanzii) si am
| construit alaturi functia FV.

Fig. 7.1. Valoarea viitoare a unei depuneri regulate la banca.
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Sarcini
1. Aflati cat voi obtine daca banca la care am depus 500 lei are dobanda de 5% pe an
si eu am platit 10 luni? Nu am avut nici o depunere initiala.

2. Am dat fratelui meu 100 $ cu promisiunea ca dupa un an sa-mi returneze 400 lei.
Oare am facut bine? Acum 100 $ valoreaza 350 lei dar am aflat c& dolarul va creste cu
cel putin 10%.

3. Observati foaia de calcul urmatoare. Formulati o problema pentru aceasta!

E F G H
explicatii constante formula valoare rezultat
3 | dobanda 9.60%
nr_rate 10
5 | rata_periodica 0.00 lei
valoare viitoare ? =FV(F3,F4,F5,F8) | 50,019.06 lei
valoare prezenta -20,000.00 lei

2. PV(rata;nper;pmt, [fv],[tip])

Calculeaza valoarea prezenta, actualizata, a unei investitii. Rata = dobanda la banii
investiti, nper = numarul de perioade, pmt = plata sau rata lunara (fie o dam, fie o primim)
fv = valoarea pe care dorim sa o obtinem in viitor, tip = O daca ratele se platesc la
fnceputul lunii sau —1 daca ratele se platesc la sfarsitul perioadei.

Exemplul 2.

Daca doresc sa obtin la banca peste 10 luni 1281 C E F
lei, care ar fi suma pe care ar trebui sa o depun
initial? Stim ca banca ofera 3 % pe luna si lunar

. . 0,
voi depune 100 lei. dobanda 3%
) ] ) nr_rate 10
Este de fapt inversul problemei anterioare. La rata_periodica -100
functia FV stiam céat depun initial si voiam sa aflu valoare-initiala (100. 115]
cét voi obtine, la functia PV imi propun, stiind c3 valoare viitoare 281
trebuie sa obtin o anumita valoare peste o anumita
perioada, sa aflu cat depun initial. =PV(F3,F4,F5,F7)

Functia folosita este PV(3%,10,-100,1281)

De ce trebuie sa punem rata-periodica cu minus?
Pentru ca este o plata catre banca, deci se scot Fig. 7.2. Valoare prezents
bani din buzunar.

Suma viitoare pe care dorim sa o obtinem ne va fi

datad de banca, deci va fi trecuta cu plus.

Functia PV intoarce o valoare pe care trebuie (ACUM) sa o depunem (o vom scoate din
buzunar!), deci ea apare ca numar negativ.
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Sarcini de laborator
1. Aflati céat ar trebui sa am initial daca lunar nu pot plati nimic!

2. Aflati, daca numarul de rate este 20 si dobanda de la banca creste la 5%, cét va
trebui sa depun initial la o0 suma asteptata de 5000 Lei, fara sa mai platesc lunar ceva.

Exemplul 3

Mihai are nevoie de un concediu de 2 ani undeva la munte pentru a-si redacta romanul
la care viseaza. El a estimat ca pe luna i-ar fi necesar 2000 lei. Banca la care are cont
Mihai practicd o dobanda de 24% pe an. Cat ar trebui sa depuna ACUM in cont Mihai
pentru ca sa poata pleca Tn concediu si sa primeasca la inceputul fiecarei luni suma
dorita?

Unitatea de timp este luna. Dobanda bancii trebuie calculata la aceeasi unitate de
timp, deci vom pune dobanda =24%/12. Durata este 18 luni.

Rata lunara este interpretata ca o plata periodica a bancii catre Mihai, deci vom pune
+2000. Valoarea viitoare este ceea ce s-ar afla Tn cont la terminarea perioadei deci O.
Vom folosi PV(24%/12, 24,2000,0,0)

Valoarea prezenta este

dobanda 2.00% 24% annual=2%lunar ceea ce Mihai ar trebui sa
nr_rate 24 2ani=24 luni plateasca acum bancii —
rata_periodica 2000 ce wa primi de la banca deci este cu minus.
valoare viltoare 0 cewvaaveain cont

valoare prezenta [358 584 417 =P%(F3,F4 FS F7 17 plata la finele lunilor
[37 5827.85) =P%(F3,F4 F& F7 0 )-plata ratelor la inceput

Sarcini de laborator

1. Aflati cat va trebui sa plateasca Mihai daca dobanda este de 17% anual si doreste
sa primeasca cate 1500 lei la finele fiecarei luni timp de 1 an si jumatate si s@ mai aiba
si in cont la revenire suma de 3000 lei!

2. Observati foaia de calcul urmatoare. Formulati o problema pentru ea.

E F G H
explicatii constante formula valoare rezultat
3 | dobanda 9.60%
4 | nr_rate 10
5 | rata_periodica 0.00 lei
6
7 | valoare viitoare 50,000.00 lei
8 | valoare prezenta ? =PV(F3,F4,F5,F7) -19,992.38 lei
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3. RATE(nr-per; pmt; pv; [fv]; [tip];[procent])

calculeaza dobanda hancara pentru o anumita plata (pv) rambursata in perioade egale
de timp. Fv este valoarea ce va ramane dupa efectuarea tuturor platilor; tip are aceesi
semnificatie ca la celelalte functii, iar procent sfatuieste Excel ca rata dobanzii poate fi
mai mare ca 100% (implicit este sub 99%)

Exemplul 4
Se face un Tmprumut de 203900 lei, care se va rambursa in 20 luni, platind cate
20000 lei lunar. Ne intereseaza care este dobanda aferenta imprumutului.

Suma Tmprumutata este valoarea prezenta = pv = 203900 lei (o trecem cu plus). Plata
lunara = pmt = -20000 lei (va fi cu minus).

Parametrul fv este O, pentru ca dorim sa achitam Tntreg Tmprumutul.
Functia este rate (20; -20,000; 203900,0) = 7.5% rata dobanzii la banca.

Sarcini de laborator
Observati foaia de calcul urmatoare. Formulati o problema pentru ea!

E F

explicatii constante formula valoare rezultat
3 dobanda ? =RATE(F4,F5,F8,F7) 9.60%

nr_rate 10
5 rata_periodica 0

valoare viitoare 50,000.00

valoare prezenta (20,000.00)

4. Functia NPER(rata;pmt;pv;[fvIltip])

Calculeaza numarul de perioade de rambursare a unui Tmprumut sau de depozitare
intr-o investitie.

Exemplul 5

Care este numarul de luni Tn care trebuie achitat un Tmprumut de 203900 lei, daca
rata dobanzii la banca este de 7.5% si lunar platesc 20000 lei?

Suma de 203900 lei este o suma pe care o avem — deci o vom pune cu plus si
reprezinta parametrul pv, iar 20000 lei reprezintd suma pe care o platesc, deci va
avea Tn formula semnul minus si se trece in parametrul pmt.

Functia folosita este = nper (7.5%; —20000; 203900) = 20 (luni).
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Sarcina

Observati foaia de calcul urmatoare. Formulati o problema care sa fie rezolvata cu
ajutorul acesteia!

E F G H
explicatii constante formula valoare rezultat
3 dobanda 9.60%
4 nr_rate 2 )=NPER(F3,F5,F8,F7 10
5 rata_periodica 0.00 lei
6
7 valoare viitoare 50,000.00 lei
8 valoare prezenta -20,000.00 lei

5. PMT(rata; nr-per; pv;[fv];[tip])
rata sau plata periodica pe parcursul nr-per de timp.

Determina suma achitata periodic pentru plata unui Tmprumut precizat in parametrul
pv (este valoarea pe care o luam ACUM si o vom achita in sume egale dupa cele nr-per
perioade de timp). Parametrul fv este zero daca ne propunem sa achitdm imprumutul. Fv
are semnificatia ultimei rate pe care o vom plati. Deci, Tn termenii functiilor financiare,
suma trebuie sa fie negativa!

Exemplul 6

Pentru construirea locuintei banca Junior m-a creditat cu 200 mii Euro la o dobanda
de 8% pe an. Trebuie achitat creditul Tn 30 ani. Care vor fi ratele mele lunare?

Pentru ca 200000 este suma primita de la banca, o vom trece Tn parametrul pv =
+200000, dar rata lunara va trebui sa fie platita, deci se va afisa cu minus. Formula
este = Pmt (8%,30,200000,0) =-17765

E F G H

explicatii constante formula valoare rezultat
3 | dobanda 8.00%
4 | nr_rate 30
5 | rata_periodica ? =PMT(F3,F4,F8,F7) -17,765.49 lei
6
7 | valoare viitoare 0.00 lei
8 | valoare prezenta 200,000.00 lei

Sarcina de laborator

Proiectati o foaie de calcul care sa serveasca pentru situatiile de imprumut. Va trebui
sa satisfaca toate cererile unui client: a. sa afle care este suma pe care o poate imprumuta,
b. care este numarul de rate, c. cat are de platit ca rata, d. ce dobanda achita?
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1.2. Functii pentru fluxuri monetare variabile

6. IRR( grup-bani; procent)

Calculeaza rata interna de rentabilitate preconizata pentru o serie de plati sau incasari
care nu se fac regulat si nici nu sunt egale. Rata interna de rentabilitate corespunde la
procentul de dobanda pentru care valoarea actualizata a Tncasarilor viitoare este egala cu
valoarea investitiei initiale. Rata este o valoare cuprinsa de obicei Tntre 0% si 100%, iar
daca este previzionata o rata mai mare trebuie sa folosim si ultimul parametru (procent!).

Este de fapt o varianta a functiei RATE, dar cu sume variabile.

Exemplul 1

Pentru investitia mea de 10000 $ am primit urmatoarele sume: in primul an 1000,
apoi 5000, 5000, 6000 $. Care este rata dobanzii?

Suma investita va trebui pusa cu minus pentru ca reprezinta o suma data, celelalte
sume sunt cu plus pentru ca am primit banii!

Observam ca la rate constante am putea aplica functia RATE pe durata de 4 ani cu un
avans dat. Dar cum valorile nu sunt aceleasi vom folosi functia iRR (-10000, +1000,
+5000, +5000, +6000, 200%) = -14%

A B C D E
20 initial -10000 -10000 -10000 10000
21 Luna 1 10000 1000 1000 -1000
22 luna 2 20000 5000 0 -1000
23 Luna 3 80000 5000 4000 -1000
24 Luna 4 10000 6000 1000 -1000

=IRR(B20:B24;200%
=IRR(C20:C24;200%
=IRR(D20:D24;200%
=IRR(E20:E24;200%

—_— - — —

179.03%

20.40%

-16.15%

-28.71%

7. NPV(rata-de-schimb; grup-bani)

Calculeaza valoarea prezenta pentru un grup de plati viitoare. Este similara functiei
PV, doar ca se aplica la sume periodice variabile.
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Exemplul 2

Fie o ratda a dobanzii de 5%/an si o investitie initiala de 20 milioane. Sumele pe care
le asteptam sunt 8 mil. dupa primul an, apoi 5 mil. in la doilea si in urmatorii 4 mil.,
4 mil., 2 mil. lei.

Care este valoarea prezentd a incasarilor? Dar valoarea neta a investitiei?

Calculam = NPV(5%;8000;5000;4000;4000;4000) = 22034 mii lei (reprezinta
valoarea prezenta a Tncasarilor viitoare)

Daca din aceasta valoare scadem valoarea investitiei obtinem venitul net 22,034
mil — 20 mil. = 2,034 lei venit net!

Sarcini de laborator

1. Doresc sa depun aceeasi suma de 10000 lei la mai multe firme care ofera sume lunare
diferite, ba chiar sunt unele care nu dau bani o luna sau doua. La o firma mi se cere sa platesc
ntr-o lund 1000 $! Am centralizat datele in tabelul de mai jos. Pe care firma s& o aleg?

Firma X FirmaY Firma Z Firma T

dobanda 3% 3% 2% 5%

luna 1 2000 5000 5000 5000

luna 2 3000 1000 1000 3000

luna 3 0 1000 1000 0

luna 4 3000 1000 1000 3000

luna 5 4000 1000 1000 -1000

luna 6 1000 1000 10000 4000

investitie initiald 10000 -10000 ~10000 -10000

2. Vreau sd-mi cumpar o masina care costd 5000 $. Am economisit 500 $, iar restul
trebuie sa-i imprumut de la o banca. As dori ca sa termin Tmprumutul in 5 ani. Banca
Viorica cere o dobanda de 24% pe an. iar banca Margarina doar 2,4% pe luna. Cat am de
achitat rata lunara la fiecare banca?

3. Am mostenit o avere de 1 milion $ si doresc sa-i investesc intr-o afacere cu un castig
de 5% pe an. Cred ca pot sd-mi petrec restul vietii pe o insula tropicala cu 80.000 $ pe an.
a. Cati ani Tmi vor ajunge banii? Doresc sa primesc banii cuveniti la Tnceputul
fiecarui an.
b. Daca as gasi o banca cu o ratd de 10%, cati ani voi trai linistit?
4. Sa presupunem ca aveti 20000 lei si doriti sa-i investiti astfel incat sa obtineti
50000 fin 2 ani. Care ar fi dobanda? Dar daca am dori sa obtinem 5 milioane?
5. Varul Sandel mi-a cerut sa investesc in firma lui cei 10000 euro pe care Ti am.
Mi-a promis ca imi va da anul viitor 2000 euro, peste 2 ani 3000 euro, apoi 4000 euro si
la sfarsitul celui de-al patrulea an inca 5000 euro.
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Am aflat ca cea mai mare dobanda la bancile comerciale este de 12% pe an. Ce sa
fac?

5. Care sa fie dobanda unei investitii de 100 mil. lei daca primesc lunar 10, 15, 0, 2,
4,6 mil. lei?

(.«
(Test 6 %

Testul urméareste sd evalueze abilitatile de a transpune in functiile financiare problemele
reale intalnite in viata de zi cu zi. Atentie la formularile acestor probleme.

Copiati tabelul urmator pentru fiecare problema in alta foaie de calcul si completati-I cu
valorile constante corespunzatoare problemei. Anulati functiile si rezultatele care nu
intereseaza in problema!

E F G H
L Constante i g . valoare
2 | Explicatii EXEMPLE Functii financiare rezultat
3 | Dobanda (rate) 7% =RATE(F4,F5,F8,F7)
4 | nr_rate (nper) 30 =NPER(F3,F4,F8,F7)
5 | rata_periodica(pmt) 25,000.00 lei =PMT(F3,F4,F8,F7)
6
7 | valoare viitoare (fv) 200,000.00 lei =FV(F3,F4,F5,F8)
8 | valoare prezenta (pv) | 1,000.00 lei =PV(F3,F4,F5,F7,0)

1. Am 20.000 lei pentru a-i investi acum ca depozit la 0 bancé. In fiecare an pl&nuiesc
sa investesc Tnca 5000 lei. Banca Junior oferda o dobanda de 8% pe an. Cati bani voi
acumula in 10 ani?

2. Firma mea doreste sa investeasca in firma , Electronic MSDC” o suma de bani
pentru ca aceasta oferd o dobanda de 17% anual. Lunar am putea depune cate 20000 $
si am dori sa cunoastem care sa fie nivelul investitiei initiale astfel incat dupa 20 luni sa
obtinem 10 milioane!

3. Visul meu este sa devin milionar! Doresc sa acumulez un milion de euro. Am 100.000
euro investiti de la care castig 10% pe an. Dacad depun 25.000 euro in fiecare an, cand
voi avea suma dorita?

4. Sa presupunem ca aveti 20000 lei si doriti sa-i investiti astfel incat sa obtineti
50000 7n 2 ani. Care ar trebui sa fie dobanda?

5. Care sa fie valoarea lunara pe care o avem de platit pentru a rambursa un imprumut
de 203900 lei Tn 20 luni, daca dobanda este de 7.5%?
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Analiza datelor si estimarea

Lectia 8 tendintelor

Construirea scenariilor
Tehnica Goal Seek
Analiza datelor prin Data Table

Functia trend

Analiza si estimarea prin grafice si Trendline

AN N N NN

8.1. Analiza datelor prin construirea scenariilor

Un scenariu este o foaie de calcul parametrizata care pentru un set de valori ale
parametrilor afiseaza instantaneu rezultatele calculate. Mai ales atunci cand necesitatile
de analiza sau prezentare determina reluari ale configuratiei parametrilor sau trecerea
rapida de la o configuratie la alta utilitarul Scenario Manager este de real folos. El este
apelat prin Tools->Scenarios. Sd vedem cum functioneaza rezolvand o problema.

Exemplul 1

O familie doreste sa depuna la bancad o suma lunara. Daca banca practica o dobanda
de 7% pe an, suma initiala este de 100 lei si suma lunard este de 200 lei. Cat va
economisi dupd 10 ani? Se doreste [ yy 5 z 5 E

si afisarea sumelor din contul ban- 1 dobanda [ I
car in fiecare luna. 2 suma-lunara 200] | dobands, suma
o ) o 3 suma_start 100 |unara, suma initiala
Care va fi situatia contului si suma 4
finald daca dobanda se pastreaza la 5
° e o e o 6 luna suma_banca
7% dar modificam suma initiala la (7] 1 100, T55=53
200, 300, 500? Dar daca se mo- 8 2 3m
o n =| *dobanda)
difica dobanda la 5%? 190 3 ?gg e e
Rezolvare: 1 5 909
. - 12 B 1115
P.asull .1. Fixam parametvru deﬂlucru 120 14 22061
ai foii de calcul adica dobéanda, 121 115 32448
sumele initiale si lunare. gg H? gg‘g; T T
. inb k
Pasul 2. Facem o serie cu pasul 1 |f124 118 33623 [loam P
pentru numarul lunii, serie care se |} 113 SR
N . 126 120 3441
incheie la 120. —=

Fig. 8.1. Schema de calcul fara scenarii
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Pasul 3. Punem formula pentru prima lunda B7=suma initiala.
Pasul 4. Punem formula pentru luna a doua B8=B7+B7*dobanda/12+suma_lunara.
Pasul 5. Copiem formula pana in luna 120.

Pasul 6. Apelam utilitarul Scenario Manager prin meniul Tools. Introducem pentru
fiecare scenariu numele si domeniul de celule folosit pentru parametri. Celulele nu
trebuie sa fie neaparat adiacente. Se scriu valorile fiecarui parametru pentru scenariu
si se precizeaza celula/ celulele unde se va citi rezultatul.

O privire comparativa asupra rezultatelor asteptate se realizeaza prin butonul Summary
care afiseaza un tabel centralizat al intrarilor si iesirilor din fiecare scenariu.

ScrarioSurmary 7)) MBS
1 |$BH1:5B%3 by (Al B
Enter walues For each of the changing cells. Report bype 2
L: dobands | * Seenarie summary 3 |{lEkliZa
[ Scenarin PivotTable report 4 |$BY1:9B43 w|Total
2 suma_lunara [200 5 |d5_[200_s100 30893
3 R$a |IDD Result czlls: G d5_1500_s500 7764
- [Es1za) =] || 7 |47_1200_s100 34417
B |d7_1300_s100 51524
ok | cane ‘ 3 | d7_I500_s100 85743
10
se fixeaza intrarea se fixeaza iesirea analiza comparativa

Sarcini de laborator

Populatia tarilor dezvoltate ale lumii a fost de 1.245 mil. la sfarsitul lui 1996 si a
crescut cu o ratd de 0.4% pe an. Populatia celorlalte tari a fost de 4.486 mil. si a crescut
cu o ratd de 1.9% pe an. Creati o foaie de calcul pentru a previziona numarul locuitorilor
planetei Tn 2025. Care va fi ponderea numarului de locuitori ai tarilor dezvoltate fata de
total?

8.2. Atingerea unui obiectiv. Utilitarul Goal Seek

. . A B C O E F
Un alt instrument pentru analizarea | 1 yopanda 7% '
datelor este utilitarul Goal Seek. 2_|sumarlunara A0
) ) 3 | suma_start 100
De cele mai multe ori, Tn rezolvarea ; :
unei probleme plecim de la anumite valori | & juna suma_banca [ 1 0 x
de intrare si vedem la ce rezultat ajungem. |7 ! 100 | Bvshengnceki — [sos1
8 2 301
Sunt si cazuri in care stim ce dorimsa | 2 2 =2 T
obtinem si ne intrebam care sa fie valoa- |,,, T 7 jp—
. Y] . ~ Ul r
rea potrivita la intrarea Tn procedura de gz ::; ;33‘(2333 s I Donea paste
10 ani
calcul. 125 119 34019,
126 120 344

Spunemnca avem o problema de tip Fig. 8.2. Foaia de calcul cu fereastra Goal Seek
,Goal Seek” .

pentru dobanda
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Exemplul 2

Reluam problema bancara ante- A c D E
rioard. Ne propunem si obtinem é dﬂhanlda 1245'8
peste 10 ani suma de 50000 Lei. - iﬂm: g::r:a sl Goal Seek Status
Ne intrebam ce dobénda ar trebui | 4 - Goal Seeking with Cell B126
sa aibd banca? Sau ce suma ini- |5 found a solution.
tiala sa depunem la dobanda cu- ? luna : 5“""‘—"‘“1'5‘0‘ -
renta? Sau ce suma sa depunem 8 2 301 | current value: 50000
lunar, pastrand ceilalti parametri | ° 3 505
constanti? i 4 7o
o =2 116 47029
Pentru a rezolva se lanseaza utili- |23 17 47759 functl-_w:iectiv X
. Suma in banca peste
tarul Goal Seek prin Tools>Goal |124 118 48498 {10 ani P
Seek. 125 119 49245
126 120 50000

Se fixeaza in fereastra de dialog
referinta asupra celulei rezultat si

Fig. 8.3. Gasirea unei solutii: dobanda de 14%

valoarea asteptata se scrie Tn celula respectiva. Se introduce de asemenea adresa
celulei parametru de intrare.

Utilitarul ,,potriveste” valorile in celula parametru si anunta gasirea sau nu a unei
solutii!

0 problema rezolvata. Planul financiar al familiei lonescu

Familia lonescu castiga 20 mii lei pe luna, iar cheltuielile sunt: 3 mii taxe de intretinere,
2 mii alimente si 8 mii alte cheltuieli.

Visul lor este sa-si cumpere o casa care valoreaza 500 mii.

Pentru aceasta decid sa depuna tot restul de bani la o banca care are o dobanda
anuald de 10%. Ei spera ca veniturile lor vor creste cu 9% pe an, iar cheltuielile doar cu
5%. Au strans deja o suma ca avans, dar nu stiu daca este suficienta pentru ca sa cumpere
casa peste 25 ani!

Proiectati o foaie de calcul pentru planul financiar al familiei lonescu pe 25

Realizati scenarii si salvati-le in foi diferite. Tipariti-le la imprimanta.
Realizati un centralizator al scenariilor. De ex. Valoarea la banca peste 25 ani
n conditiile unei sume initiale variate, o dobanda constanta.

Care ar trebui sa fie veniturile realizate de familie pentru ca in 10 ani sa obtina

Care ar trebui sa fie procentul de crestere a salariului pentru ca sa-si cumpere

a.
de ani.
b.
c.
d.
la banca 500000 lei?
e.
casa in 10 ani?
f.

Ce suma initiala trebuie depusa la banca astfel incat in 25 ani sa obtina banii
de casa (in conditiile dobanzii de 10% pe an si a cresterii salariale de 9% si
a cresterii cheltuielilor cu 5%)?
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Analiza

Planul financiar Tnseamna simularea veniturilor si a cheltuielilor pe parcursul unei
perioade de 10 ani. Din venituri se scad cheltuielile si restul se depune la banca.

Care vor fi intrarile?

a. Elementele de cheltuieli: taxe, alimente, alte cheltuieli si procentul de crestere
anuald a acestora; b. salariul si procentul de crestere; c. suma initiala de care dispune
familia pentru Tnceperea contului.

Care vor fi iesirile?
Sumele anuale economisite la banca si suma dupa 10 ani!
Ce calcule se fac?

a. Se insumeaza cheltuielile initiale din anul de pornire si se genereaza valori pentru
anii urmatori considerandu-se o rata de crestere data. Deci daca plecam de la total cheltuieli
initiale Tn suma de 100 lei si rata de crestere de 5% pe an obtinem Tn anul urmator
valoarea = 100+100*6%/12 =100,50 lei, peste doi ani valoarea din banca va fi 100,5 +
100,5 * 6%/12 = 110 lei s.a.m.d. b. Daca se porneste de la un salariu initial dat se
genereaza veniturile Tn anii urmatori presupunand ca va exista si aici o rata de crestere.
Formulele sunt similare cresterii cheluielilor. €. se depune anual la banca diferenta venituri-
cheltuieli. d. Banca acorda o dobanda la suma existenta — Tnainte de a depune familia
economiile sale, deci Tn fiecare an vom calcula suma totald Tn banca ca fiind suma
economisita + dobanda la suma anterioara.

Proiectarea foii de calcul
Pasul 1. Se fixeaza parametrii de intrare ca Tn imagine

E10 - f =F9+FS"dobinda
A B C D E F €] H

1 |wenitur 200 dobanda-banca 20%

2 [taxe =) crestere-salar 10%

3 mancare a0 crestere-c 5%

4 |alte 45

5 [total cheltuieli 100 irritial 0

53

7

g |an venituri cheltuieli suma-depusa dobanda suma-finala-la banca
L 1 00.00 100.00 1DD.DDI_ 0.00 —= 100.00

10 2 22005 HE-AR -+ Fanp i 235.00

1 3 Z47-A5 HHE2S 13176 =25200 413.75

12 4 266.20 116.76 150.44 496.50 B46.94

13 5 20232 121.55 171.27 77633 947 59

14 B 32210 127 B3 194 47 13711 1331.59

15 7 354.31 134.01 22030 15597 .90 1818.21

16 g 359.74 140.71 249.03 2181.85 2430.88

17 =] 428.72 14775 28097 2917 .05 3198.03

18 10 471.59 15513 316.46 3837 B4 4154.09

19

20 Circular Reference v X
2t - E A
22

Fig. 8.4. Afisarea legaturilor dintre celule se face prin Tools>Formula Auditing=>Trace.
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Veniturile (B2), taxe (B3), alimente (B4), alte cheltuieli (B5), Rata dobanzii bancare
anuale (E1), rata de crestere a veniturilor (E2), rata de crestere a cheltuielilor E3), suma
intiala economisitd de familie (E5).

Pasul 2. Se proiecteaza structura bazei de date scriindu-se identificatorii de camp si
formatand la numeric Tntreg cu 2 zecimale.

Pasul 3. Se proiecteaza coloana A ,an” cu o serie cu pasul 1.

Pasul 4. Se proiecteazd coloana B (,venituri”) astfel: B9 = B2; B10 = B9 + B9 *
crestere_salar — se copiaza B10 Tn coloana.

Pasul 5. Se proiecteaza coloana C ,cheltuieli” astfel C9 = B5; C10 = C9 + C9 *
crestere_chelt si se copiaza C10 Tn coloana.

Pasul 6. Se proiecteaza coloana D astfel D9 = B9 — C9 care se copiaza in rest.

Pasul 7. Se proiecteaza coloana E astfel E9 = initial + initial*dobinda, E10 = F9 +
F9* dobanda se copiaza Tn restul coloanei E.

Pasul 8. Se proiecteaza coloana F astfel F9 = D9 + E9 si se copiaza Tn rest.

Pasul 9. Se inregistreaza scenariile prin utilitarul Scenarios Manager apelat prin meniul
Tools>Scenarios.

Pasul 10. Se obtine raportul comparativ al valorii finale dupa 10 ani folosind butonul
Summary din fereastra Scenarios.

Pasul 11. Se apeleaza la utilitarul Goal Seek prin Tools>Goal Seek, fixandu-se celula
de rezultat F18 la valoarea sumei finale.

Sarcini de laborator

1. Hotelul Albatros oferad pentru cazarea pe o noapte pretul promotional de 1000 lei.
De asemenea, se acorda reducere pentru grupuri. Astfel: daca grupul are mai putin de 5
persoane, reducerea este de 5%; intre 6-9 persoane reducerea este de 12%; intre 10 si
19 reducerea este de 15%, iar peste 20 reducerea este de 19%.

a. Proiectati o foaie de calcul care sa permita aflarea exactd a pretului de cazare
pentru o persoana din grupul din care face parte!

b. Managerul hotelului are si un anumit tarif pentru clientii fideli. Lor li se aplica alta
grila de reducere: pana in 5 persoane reducerea este de 8%; intre 6-9 reducerea este de
14%; intre 10-19 reducerea este de 18% iar peste 20 reducerea este de 22%. Modificati
foaia de calcul pentru noua situatie.

2. Elevii clasei a X-a vor sa plece Tn vacanta cu corturile la mare.

Pentru aceasta s-au informat si au obtinut preful unui bilet de drum dus-intors. Tariful
de cazare in satul de vacanta este redus cu 10% (pentru elevi) daca grupul este intre 10-
15 persoane, cu 20% daca grupul este Tntre 16-20 persoane si cu 25% daca grupul este
mai mare de 21 persoane.

De asemenea, se poate lua masa in sat. Pentru fiecare zi se plateste separat micul
dejun, pranzul si cina. Fiecare elev poate sa aleaga meniul complet sau numai o parte din
el. Si aici s-ar putea negocia un procent de reducere, dar la fata locului (in cazul cel mai
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optimist, procentul este de 30% reducere indiferent de numarul de persoane care iau
masa, dar numai pentru acei elevi care se angajeaza pentru meniul complet)

Grupul de prieteni doreste sa afle care ar fi suma maxima pe care ar trebui sa o aiba
fiecare asupra lui pentru a acoperi cheltuielile de transport si cazare si eventual diferenta
rezultatad din reduceri! Aflati si suma totala necesara excursiei.

Imaginati diferite scenarii. De exemplu, daca grupul ar fi de 22 de persoane care ar
solicita meniu complet si ar beneficia de reducere la masa de 30%? Sau daca grupul ar
fi de 13 persoane, care solicita doar pranzul?

Afisati variantele pe alte foi de calcul.
Tipariti variantele.

8.3. Tabele de simulare construite prin Data Table

O alta facilitate oferita de Excel este construirea rapida a tabelelor de simulare (numite
si tabele de variatie) folosite in procedeul de analiza a unui situatii.

Un tabel de simulare este vazut ca un domeniu de celule care ne aratd cum variaza
rezultatele aceleiasi formule cand unul sau doi parametri variaza.

8.3.1. Folosirea Data->Table cu un parametru variabil

La o banca dobanda practicata pentru depozitele populatiei este de 30% pe luna.
Clientul doreste sa stie valorile obtinute peste 1, 2, 3, 4, 5 sau 6 luni, daca depune suma
de 100.000 lei.

O metoda rapida este folosirea tabelelor de simulare construite automat prin Data" Table
Observati foaia de calcul pentru
aceasta problema. A 8 ¢ [ b T E

Pasul 1. Construim tabelul iniial
cu indicatorii si valorile respective.

tabelul initial

indicatori
Depunere initiald 100000

OO~ O, =W

Vom folosi functia FV cu parametrii G 0%

A = = < . umdr_ lun| ”
dobanda lunara; numar luni; depu- Valoare viitoare 904 31000 ler. |=Fv(07,08,-06)
nere initiala. 0

| 19t i . |luna evolutia valorii depuse
Pasul 2. Construim variatia valorii 7% e

viitoare dupa numarul de luni.

a. Vom realiza un tabel cu doua
coloane. Pe o coloana (C) vom pune
numarul de luni. Pentru problema

noastra vom pune o serie liniara cu  fig, 8.5. Organizarea foii pentru simularea evolutiei
pasul 1, termen initial 1. depunerilor Tn timp
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b. Pe cealalta coloana (D) deasupra primei luni se pune adresa relativa a functiei FV
din tabelul initial (ex. D9).

c. Se selecteaza tabelul C11:D17.

d. Se alege optiunea Table din meniul Data. In fereastra de dialog vom scrie n caseta
cu text Column input cell adresa variabilei dupa care se face simularea adica $D$8 (numarul
de luni).

e. Observam completarea automata a tabelei cu valorile functiei FV in raport de numarul
de luni, pastrand egali ceilalti doi parametri: suma initiald si procentul dobanzii.

Valorile de
1 2 3 4 intrare
904,310.00 lei 100000 | 230000.00 | 399000 | 618700
\ Functia din tabelul \ Valorile calculate de
initial are adresa D9 functia FV

Observatie. Tabelul pentru simulare se poate construi si pe linii. In acest caz, vom
pune adresa functiei pe un rand si vom scrie valorile parametrului cu un rand mai sus.

Table 3]
Row input cell: |$osa| 'k]

Column input cell: | 'k]
Fig. 8.6. Cand tabelul de simulare este ordonat pe linii,
x ] conce ‘ completam adresa parametrului in fereastra Row input cell.

Sarcini de laborator
1. Construiti tabelul de variatie a aceleiasi functii FV cand | gou input cel:
procentul dobanzii ia valorile 30%, 25%, 27%, 17%, 10% Si | coumninputcal: ~ [s087

15%. oK, | Cancel

2. Construiti tabelul de variatie a aceleiasi functii FV cand
suma achitata initial variaza de la 100000 la 5000 cu pasul
1000.

3. Construiti tabelul de variatie a aceleiasi functii FV cand
se cere sa se afle suma viitoare dupa 5 luni, 12 luni, 24 luni,
30 luni si 36 de luni.

Fig. 8.7. Tabelul este
aranjat pe coloane

8.3.2. Folosirea Data->Table cu doi parametri variabili

Ne propunem sa calculam sumele primite de la banca daca depunem initial 100000 lei
intr-o luna, 2, 3, 4, 5, 6 luni, daca dobanda bancii este 30%, 40%, 50%, 60% pe luna!

Este o problema de calcul a functiei FV avand un parametru constant (suma initiald) si
doi parametri variabili (numarul de luni si dobanda).
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Vom folosi tot Data->Table si tabelul functiei FV din prima problema.
Vom construi o matrice care va avea pe linii numarul de luni si pe coloane dobéanzile.

Adresa functiei =D9 Valorile dobanzii

c d e f g |
21| 904.310,00 lei 30% 40% 50% 60%
22 1 100000 | 100000 100000 100000
23 2 230000 | 240000 250000 260000
24 3 399000 | 436000 475000 516000
25 4 618700\ 710400 812500 925600
26 5 904310 || 1094560 1318750 1580960
27 6 1275603 | 1632384 2078125 2629536

Numarul de perioade

Aici vor fi rezultatele trecute automat de Data->Table
Ex. D23 = valoarea obtinuta dupa 2 luni la o dobanda
de 30% cu aceeasi suma initiala de 100 mii.

a. In zona C22:C27 vom varia numarul de luni, deci vom construi o serie numerica
avand pasul 1. In domeniul D21:G21 vom scrie valorile dobanzii.

b. Tn coltul stanga sus al tabelului trecem adresa functiei FV din tabelul initial (=D9).

c. Selectam fintreg tabelul C21:G27. " Table rz|®

d. Deschidem fereastra de dialog Data—>Table. -
. i ell:
Vom completa Row input cell cu adresa D7 = para- ek Ll
metrul doband3, iar Column input cell cu D8 = adresa | Soumninputcel:  |$045 X
variabilei numar luni din tabelul initial (vezi fig. 8.5). ok | conce ‘
e. Observam completarea automata a tabelului
selectat. Fig. 8.8. Completarea parametrilor

din tabelul initial
Sarcini de laborator

1. Construiti variatia FV pentru numarul de 6 luni, daca suma initiald pleaca de la
100000 la 1 milion si daca dobanda lunara este de 5, 8, 11, 17%

2. Construiti variatia FV pentru o dobanda de 17% lunar si variati suma initiala si
numarul de luni.

8.4. Previzionarea evolutiei unui fenomen

Evolutia viitoare a unui fenomen se poate construi prin Edit>Fill>Series daca acesta
are o evolutie liniard sau exponentiala.
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Daca insa datele existente Tn perioadele precedente nu respecta regulile de constructie
a unei serii si dorim sa previzionam valori viitoare, putem folosi liniile de tendinta construite
prin grafice sau functia TREND.

Functia TREND ntoarce valori previzionate avand ca suport de plecare datele obtinute
ntr-o perioada precedenta.

Exemplul 1
Se Tnregistreaza profitul obtinut de o societate M N
comerciala pe parcursul a 9 luni de activitate (in 20 1 3
milioane lei). Se doreste previzionarea profitului 21 2 5
probabil Tn lunile urmatoare. 22 3 8
Vom folosi functia statistica TREND(). Urmariti Tn tabelul 23 4 1
alaturat valorile pentru numarul lunii (M20:M31) si || 24 5 6
pentru profit (N20:N28). In celula N29 apeldm functia | 25 6 8
Trend. Completam in fereastra de dialog a functiei Trend 26 . 9
linia Known_y’s cu domeniul cunoscut de valori ale |37 8 11
profitului N20:N28. Pe linia Known_x's completam 28
domeniul de variatie a lunilor M20:M28. Pe linia 2 9 23
New_x's vom completa domeniul de variatie a lunilor 30 10
viitoare M29:M31. L
31 12
TREND
Known_y's [N20:128 X Pentru celulele urmatoare fa-
Known_x's [M20:M28 =l cem o copie a formulei din
New_x's |M29:M31 =/ N29 pentru a vedea valoarea
estimata a profitului Tn urma-
=i }'ﬂ toarele luni.

Fig. 8.9. Completarea functiei TREND

8.4.1. Folosirea graficelor. TRENDLINES

Folosirea utilitarului pentru constru-
irea graficelor Excel este deja cunoscut. | %97 o
Vom realiza un grafic al valorilor cunos- 20
cute din primele 9 luni prin Insert>Chart. 15 | |
Pentru a previziona profitul ne vom po- | 1g < + Serigs]
o . L o rn & [ Format Data Series...
zitiona pe un punct din grafic si alegem 5 - o o
. . . - t Type...
din meniul contextual optiunea Add e . o
. 0 T = . ) source Data...
Trendline
' 0 2 4 B E| Add Trendline. ..
Trendlines este o metoda de a sugera e
. . . I
o evolutie viitoare pe baza datelor din -
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trecut. Tn fereastra de dialog Trendline>Type selectdm tipul evolutiei. Sunt mai multe
tipuri de evolutii bazate pe diferite formule de ecuatii.

Pasul urmator este sa indicam n pagina Options numarul de perioade pe care dorim
sa extindem previziunea noastra.

Fig. 8.12. Alegerea numarului de perioade

Add Trendline viitoare se face prin caseta Forward.

Putem solicita afisarea ecuatiei care a stat la
] Options ] baza previziunii.

Trend/Fegression type
Ifeg i Format Trendline

//‘J r\/ m Patterns] Type OPtiDnsl

Linear Loagarithrnic Erellramtel Trendline name
r = = {* putomatic:  Linear {Series1)

//. f " Customn: |
. : —.J‘j’ Z 3 Forecask

Power Exponential Mowing feverage Forward: in 3: Urits
Biased aon series: Backward: [0 5] Unis
Fig. 8.13. Alegerea tipului de evolutie. [~ Set intercept = i

I Display equation on chart
I Display R-squared value on chart

Urmariti Tn imaginea capturata linia de evolutie data de Trendlines.
Observati o predictie pentru un tip de trend polinomial.

25
20 ¢ 35 4 ¥=1.7833x - 06944 _
15 » — e
o |« Seriest | 25 s 7 + Seriesl
" o n & |[' Fomat Data Series... 20 7
e . —
5 no Chart Type... 15 4 Linear
‘ o) 10 . 3 (Series1)
0 T v T 1 Source Data... 5 - 1{5
0 2 4 B & add e, N . ‘ |
Cloar 0 5 10 15 20

Fig. 8.13. Fixarea tendintei de tip polinomial
X este numarul de perioade, ecuatia prezice profitul (y) in functie de perioadd. R este

corelatia Tntre valorile prezise de ecuatie si valorile actuale. Patratul R este utilizat pentru a
indica variatia valorilor fatd de linia de trend.

Sarcina de laborator

1. Schimbati tipul si aflati care a fost evolutia de acum 5 luni a profitului!
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2. Sa presupunem ca un chestionar are numai 5 intrebari: intrebarile 1 si 2 au 2
variante de raspuns DA/NU; intrebarile 3 si 4 au 5 variante a, b, c, d, e iar la intrebarea 5
trebuia acordata o notd de la 1-10. Se doreste o foaie de calcu pentru prelucrarea

chestionarelor astfel incat sa se obtina sub forma tabelara si grafica pentru fiecare intrebare
222272

Exemplu
nr. nume . intrebare
chenar | persoana Sex | ocupafie | cost 1 2 3 4 5
1 Albu F elev 15 DA | DA a a 10

2 Barbu F student 21 NU DA b a 9

intrebare 1

Total nr. persoane cu DA ____
nr. persoane cu NU ___
TOTAL

DA
ONU

fara raspuns

nr. persoane .....
din care Femei din care nr. femei cu DA
nr. femei cu NU

din care Barbati din careinr. barbati cu DA

nr. barbati cu NU
etc.

[
(Test 7

Testul vizeaza evalurea abilitatilor de a opera cu functii financiare si de a construi
tabele de simulare si grafice.

1. Determinati rata lunara pe care o are de achitat o persoana care a contractat un
fmprumut de x lei cu o dobanda de y% anual, stiind ca se doreste achitarea n z luni!

2. Construiti tabele de variatie
a. cand variaza dobanda;
. cand variaza suma Tmprumutata;
cand variaza numarul de rate;
cand variaza si dobanda si numarul de rate;

® oo o

cand variaza suma Tmprumutata si dobanda.
3. Construiti graficul variatiei functiei pentru punctul a.

4. Construiti graficul variatiei functiei pentru punctul d.
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Gestiunea listelor de date in

Lectia 9 Word

Ce este o lista sau o baza de date Word
Introducerea datelor utilizand formulare

Filtrarea si cautarea informatiilor

<N R X

Sortarea

O lista sau o baza de date Word este un tabel in care informatiile au o anumita
semnificatie si sunt structurate astfel: prima linie indica structura bazei de date si contine
numele coloanelor (heading). Celelalte linii contin valorile propriu-zise (records). Coloanele
(Fields) au nume distinct. Nu sunt linii sau coloane vide. Fiecare articol trebuie sa aiba
cel putin o valoare care sa Tl
faca unic n cadrul tabelei.

pentru a crea anumite tipuri de tabele, astfel:

e Pentru o tabeld care include formate grafice (liste cu simboluri sau numerotate),
formatarea individuald a celulelor si divizarea celulelor pe diagonald — folosim
Microsoft Word

e Pentru o tabeld care include calcule complexe, analize statistice sau diagrame
folosim Microsoft Excel

e Pentru cautari rapide si sortari folosim Microsoft Access sau Excel

e Pentru tabele relationale folosim Access

e Pentru o tabela care este inclusa Tntr-o prezentare folosim PowerPoint
e Pentru o tabela vizibila pe Web folosim Front Page sau Word

Pentru gestiunea tabelelor organizate ca baze de date folosim bara de butoane Data-
base.

add new sort insert find
record ascending database record

-

B 8 & 2 L E‘E @ &

data
form

manage manage | | sort update mail merge main

fields fields ascending fields document
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Ce facilitati ofera Word pentru tabele organizate intr-o baza de date?

. editarea articolelor prin intermediul unui formular

. adaugarea unui articol nou

. stergerea unui articol

. corectarea articolelor

. cautarea articolelor care indeplinesc o anumita conditie
. ordonarea articolelor

. tratarea tabelei ca sursa de date pentru corespondenta

. preluarea datelor din surse externe ca tabela Word

ONO O P~ WN

9.1. Folosirea formularelor in tahelele Word

Dacd avem o baza de date mare, cu multe articole si campuri, este util sa folosim
formularul asociat prin butonul Data Form din bara Database.

Formularul prezintad un singur articol. Fiecare camp este prezent prin numele si valoarea
pentru articolul curent. Putem sa ne deplasam la orice articol, fie din aproape Tn aproape,
fie indicand numarul acestuia. Se pot adauga noi articole (butonul New) se pot sterge
(butonul Delete).

O facilitate a formularului este si posibilitatea de cadutare si pozitionare in baza de
date pe articolul care indeplineste conditia pusa. Butonul Find deschide o fereastra de
dialog prin care se introduce valoarea cautata si campul unde se cauta.

—

P [tj312005 ﬂ addhew |

client: |SC. Albatros WLI
comanda_nr: |12345
produs: 10 Restore
Zank: 0,05 | Find... |
prek: |12

Find in Field @

Find what:

Record: L] | 4 |1 » ‘ p|| In Field:
T )
J Fig. 9.1 Formularul

Close permite actualizarea

si cautarea.

Sarcini de laborator
1. Creati un tabel tip baza de date cu vanzarile din primul semestru care sa aiba
structura (cod, denumire produs, ian, feb, mar, apr, mai, iun, total).

2. Adaugati 4 articole.
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3. Folositi formularul pentru a cauta si a va pozitiona pe articolele care au vanzari in
februarie de 4 unitati.

4. Folositi formularul pentru a adauga alte 2 articole.
5. Folositi formularul pentru a sterge articolul 3.

6. Pozitionati-va rapid pe primul articol.

7. Stergeti ultimul articol si apoi anulati operatia.

9.2. Sortarea listelor Word

Pentru operatia de aranjare a datelor dintr-o listd Word putem folosi meniul Table>Sort.
Fereastra de dialog permite introducerea campurilor dupa care se va face ordonarea si

sensul ordonarii. _ _
Sort EIE|

Exemplul 1 S —
Dorim aranjarea listei comenzilor cronologic, | ldats =] e foate ¥ A PR
pentru aceeasi data pe clienti si pentru ace- | wsingi [Paragraphs ]
lasi client crescator dupa numarul comenzii. | then by

Ca g [dlisnt =1 Type: |Text J i+ Ascending
Observati in fig. 9.2 modul de completare " Descending

a cerintelor. Avem grija ca butonul radio | Using: [Farsgraphs =
Header row din sectiunea My list has sa | Thenby .
H H ~ 2 = H comanda_nr - Type: m ¢ Ascending
fie activat, ceea ce Tnseamna ca primul = = © Descending

rand al tabelei contine numele cAmpurilor. | Using: [Paragraphs [

Se poate solicita si ordonarea dupa o |M/sthss
. o o o . (* Header row " Mo header row
singura coloana daca folosim butonul Op-
tions si selectam Sort column only. Qptiens. . ok | cancal

Fig. 9.2. Sortarea tabelei Word.

9.3. Operatii asupra campurilor

Este util, mai ales in cazul tabelelor mari, sa putem face operatii asupra structurii

tabelei: sa redenumim coloane, sa —
ad3ugdm sau s stergem campuri. [akacstiaes )X
Aceste operatii se pot activa prin Field name: Field names in header row:
fereastra de dialog Manage Fields || urit-masura]

deschisa prin butonul Manage Fields
de pe bara Database.

Remove

fik

Rename...

Fig. 9.3. Fereastra de manipulare a

. . a4 Close |
campurilor.
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Sarcini de laborator

a. Folositi tabelul vanzarilor din primul semestru si sortati-l dupa numele produsului.
b. Adaugati campurile data, pret si introduceti valori in acestea.

c. Redenumiti campul denumire la nume_produs.

d. Adaugati un nou camp, denumit unitate de masura si introduceti valori in acesta.

e. Redenumiti campurile ian la ianuarie si feb la februarie.

9.4. Efectuarea calculelor in tabela Word

Pentru a face diferite calcule .
9 i Fig.9.4.
putem sa folosim Table>For- pygiectarea
mula dupa ce ne pozitionam pe unei Eormula:
celula unde dorim rezultatul.  formule |=SUM(LEFT)
Word are cateva functii pe Vordse Burnber Format:
Lo realizeaza |# e _
care le putem alege din lista prin : 5
Paste function. fereastra Paste function:
Formulele sau expresiile Formula. v | li
sunt combinatii de termeni si MOoD -
. t ? MOT "_IOK | Cancel
operatori. il lon
; L L _*/ o [ |PRODUCT 4 E 7
Operatorii sunt: +,-,*,/, % B oo > : 3
(procent), =, <.,>, >=, <=, <>. SIGH

Termenii pot fi numere, referinte de celule din tabelul curent sau din alt tabel, precum si
functii.

Cateva functii: AVERAGE(), COUNT(), MAX(), MIN(), PRODUCT(), SUM(), AND(), OR(), IF().

Referintele la celule sunt adrese absolute si sunt numite A2, B1 etc., unde litera este
numele coloanei, iar cifra identifica linia la intersectia cadrora se afla celula la care se
face referire.

Exemplul 2
Fie tabelul urmator cu 6 comenzi. Vom calcula media aritmetica a prefurilor cu for-
mula =average (62:G7) sau cu =average(G:G)
Nr_crt data client comanda_nr produs Cant pret valoare
Chapter 1| 1/3/2005 SC. 12345 Mere 10 12 120
Albatros
Chapter 2| 1/4/2005 SC. Abbba 12346 Pere 20 2
Chapter 3| 1/5/2005 Popescu M 1000 Mere 40 34
Chapter 4| 2/5/2005 SC. Divanu | 2340 Mere 20 56
Chapter 5 5/5/2005 ionescu 3400 Pere 100 7
Chapter 6 7/6/2005 Sc 3456 Nuci 100 12
Harghita
total 290
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Formula = sum(ahove) face suma pe coloana curenta plecand de la linia anterioara
celulei unde este formula pana la o valoare spatiu sau invalida sau pana se ajunge la
capatul tabelului.

Formula = f2*g2 calculeaza valoarea pret*cantitate pentru o prima comanda.

Referirea celulelor din alte tabele fatd de tabela unde se evalueaza formula se poate
face daca tabela este de tip referinta (bookmark).

Cum se definesc referintele de tip Bookmark la un tabel?
Dorim sa ne referim la tabelul cu produse comandate de clienti prin numele ,,Comenzi”.

Bookmark EE

Bookmark name:

Pasul 1. Se selecteaza tabelul. 2

Pasul 2. Se deschide fereastra de dialog
Insert->Bookmark si se scrie numele referintei.

iy

Cum se folosesc referintele tip bookmark?
Tn formule, bookmark-ul precede adresa celulei.
Exemple:
_ Formu!a = average (comenn G:6) face me- | _ .. & mame ¢ Location
dia preturilor (coloana G) din tabela pe care am  Hidden boakmarks
numit-o ,,comenzi”. add . | |E°T|
Formula = sum(comenzi F2:F5) face suma can-

titatilor comandate pentru primele 4 comenzi.  Fig. 9.5. Fereastra Bookmark.

Formula = sum(comenzi F5) introduce in celula rezultat valoarea gasita in tabelul
Comenzi, coloana F, linia 5.

Atentie!

Formulele se recalculeaza manual. Daca Tn tabel se modifica valoarea unei celule ce
a fost folosita Tntr-o formula se poate reflecta aceasta modificare Tn valoarea intoarsa de
formula prin tasta <F9>.

Pentru a calcula rapid suma se poate folosi butonul Autosum de pe Tables and Borders
Toolbar.

[~

Sarcini de laborator

Fie un tabel cu vanzarile de apa minerala Tn primul semestru.
1. Calculati totalul pentru fiecare produs.

2. Calculati totalul pen-

. o . cod denumire total ian feb mar | apr mai iun
tru fiecare luna si totalul 1 borsec 9 4 5 4 5 5
2 biborteni 3 4 4 2 5 6
general. 3 izvorul alb 4 4 7 4 1 0
3. Scrieti pretul unui li- | 4 PO 2 12 |5 7 8 ®
tru de apa minerala intr-o |5 stana  de 3 4 5 6 2 8
= . |
celuld a altui tabel. 2 > T3 138
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100 fiecare rand valoarea pret.

Pret/l 4. Adaugati in tabelul intitial o noud coloana pe care o numiti Pret si puneti la

5. Adaugati o noud coloana unde sa calculati valoarea vanzarilor totale pe produs.

6. Aflati media aritmetica a vanzarilor din luna a 3-a.
7. Aflati cea mai mare cantitate vanduta in luna mai.

8. Aflati cea mai mica cantitate vanduta dintre toate produsele si Tn toate lunile.

9.5. Preluarea datelor din surse externe in tahela Word

O baza de date gestionata de Word poate proveni si dintr-o sursa externa: o lista Excel,

o tabeld Access sau Oracle etc.

Pasul 1. Folosim butonul Insert database de pe bara Database
care deschide o fereastra de dialog. Butonul Get Data permite
selectarea fisierului pe care dorim sa-| folosim. Poate fi un fisier
Excel sau o baza de date (Access, FoxPro, Oracle etc.)

Pasul 2. Apasam butonul Insert Data si prin fereastra de dia-
log Select table selectam din lista foilor de calcul care sunt in
registru Excel sau din lista tabelelor si a view-urilor din baza
de date numai fisierul dorit. Atentie! Este bine sa activam
comutatorul First row of data care determina copierea tabelului
din foaia de calcul cu primul rand interpretat ca nume de camp.

Pasul 3. Putem decide daca vor fi inserate Tn tabelul din
documentul Word toate sau numai unele articole ale caror
numere de ordine sunt cuprinse intr-un interval (fereastra de
dialog Insert data).

|

Data source

Data options

Loy opi. |

Insert the data into the docum

s

Pasul 4. Articolele obtinute pot fi supuse operatiei de filtrare, sortare si selectare a
campurilor dorite Tn tabelul destinatie Word prin fereastra de dialog Query Option.

Pasul 5. Tabelul poate fi formatat alegandu-se dintre sabloanele de AutoFormat.

Exemplul 3

Avem intr-un registru Excel cu numele Scoala.xls informatii prelucrate sau nu despre
toti elevii scolii din anul 2000 si pana in prezent. Registrul contine mai multe foi (In
foaia de calcul cu numele Absolventi avem lista elevilor care au absolvit liceul Tn anii
trecuti, iar in foaia Elevi se afla lista elevilor curenti ai scolii etc.).

Dorim sa obtinem o baza de date Word cu numele, CNP, nr-buletin, clasa si media
elevilor care au absolvit anul acesta clasa a Xll-a si care au media generala peste 5.
Daca sunt elevi care nu au absolvit, atunci media lor fie nu este calculata, fie este mai

mica de 5.

Lista finala trebuie sa contina elevii ordonati alfabetic pe clase.
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Cum procedam?

Select Table

Pasul 1. Din bara de butoane

Database vom selecta butonul In- Mame , Description | Modified Created Type
sert database si apoi butonul Get B coduri 4/1)2005 5:22:09 PM 4172005 5:22:09 PM  TABLE
data si alesem fisierul Scoala.xls B criteri 4/1)2005 5:22:09PM  41/2005 5:22:09 PM  TABLE
s g s 2| | E destinatie 4{1J2005 5:22:09PM 4172005 5:22:09 PM  TABLE
Pasul 2. Din fereastra Select ||Eelv 4/1J2005 5:22:09 PM - 4172005 5:22:09 PM  TABLE
table se alege foaia de calcul Elevi. || Eel} 4{1/2005 S:Z2:00 M 4712005 5:22:.09PM  TABLE
. . o [ elevig_ 41)2005 5:22:09 PM 4172005 5:22:09 PM  TABLE
t.PalsuI 3. ?e fljxe:ﬁaﬂn u;narul tde B elevifcriteria 4/1J2005 5:22:09 PM 4172005 5:22:09 PM  TABLE

articole ca fiin in fereastra ||—

ra

Insert Data deschisa prin butonul
cu acelasi nume din fereastra

principala a operatiei de definire a sursei de date.

Pasul 4. Deschidem fereastra de dialog
Option pentru a filtra articolele.

Fig 9.6. Selectarea tabelului din lista de tabele a registrului

Query

Insert Data

Insert records

fe 1l
" Erom:

[ Insert data as field

o]

Zancel

Fig 9.7. Precizarea numarului de articole

Query Options

Filter Records ] Sort Records ] Select Fields ] Fig. 9.8. Fereastra Query/Filter
Field: Camparison: Compare
- - 12 . . .
Jeasa =] [eaudts =l Pasul 5. Precizarea filtrului se
|and x| |med_gen | |areater than - s face prin Query Options, Filter.
Equal to ; H
|and =] | ] e eaualto Obseryap modul de CE)nstruwe a
] | Less than [ expresiei. Se alege campul,
‘ireater than | [ . . [
Less than or equal — operatorul si se scrie valoarea.
| _I | J Greater than or equal

Query Options

Fiter Records  Sort Records l Select Fields ]
Sork by

* fscending

El

|clasa

Then by

* fscending

" Descending

" Descending

Fig. 9.9. Fereastra Query/Sort

Pasul 6. Fixarea cheilor de
ordonare se face Tn fereastra
Query Option, Sort Records. Se
pot fixa maxim 3 chei. In
problema noastra vom fixa ca
prima cheie clasa, apoi numele
elevului.
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Cseiect el
Query Options Query/Select Fields
Eiter Records | Sort Records  Select Fields I Pasul 7. Selectarea

Figlds in data source: Selected Fislds: campurilor din lista

pume I T TS Excel se face tot

clasa clasa .

cain Select Al b med_gen prin fereastra de

pursa dialog Query

med_rom Option—>Select

med_mate . L R

med.info fields. Initial, Tn
ambele fereastre se

afla toate campurile
listei Excel.

v Include field names

Pasul 8. Se formateaza tabelul prin butonul Autoformat si se verifica corectitudinea
manevrelor. Observati baza de date Excel inserata in documentul Word.

' nume ' cnp ' buletin | clasa | medie
Albulescu 1234567898 | mx 12345 | 12a 10
Mircea
Dobrescu 1222234567 | mc 23459 | 12b 7
Paula

| Chiru Ludmila | 20909672269 | dx 23458 | 12a | 10

Sarcini de laborator
a. Creati un registru Excel cu douad foi de calcul. Prima foaie, cu numele Farmacii,
contine datele generale despre farmacii — codul, numele, adresa.

b. A doua contine date despre medicamente (cod, nume, mod de prezentare, indicatii,
contraindicatii, pretul, procentul de compensare).

c. A treia foaie contine stocurile de medicamente cu structura (cod farmacie, cod
medicament, stoc).

d. Creati un document Word care sa contina o situatie a stocurilor de medicamente
care se compenseaza pentru toate farmaciile care au valoarea stocului mai mare decat
5000 Lei. Inserati datele din Excel preluand un tabel care sa aiba numele, codul si
adresa farmaciei, numele medicamentului, codul, mod de prezentare, indicatii, contra-
indicatii, pretul, cantitatea in stoc, procentul de compensare.

e. Transformati tabelul preluat din Excel astfel:
e stergeti coloanele adresa, indicatii, cod_medicament, contraindicatii;
e adaugati coloana pref_compensat.

f. Calculati Tn Word pretul compensat al fiecarui medicament.

g. Calculati in Word pretul mediu compensat al tuturor medicamentelor.
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h. Separati tabelul pe farmacii, cu fiecare farmacie pe foaia proprie. Copiati capul de
tabel la fiecare foaie. Puneti data raportului Tn dreapta jos si numarul foii in stanga sus.
Formatati tabelele.

Sfat. Compuneti Tntr-o foaie de calcul tabelul cu toate datele ,,lipind” datele din cele
doua foi si apoi copiati doar valorile Tn alta foaie pentru a le insera Tn documentul Word.

9.6. Baza de date Word pentru corespondenta
(Mail merge main source)

O importanta facilitate oferita utilizatorilor de catre Microsoft Word este de a fuziona
datele din baza de date cu machete (sabloane) scrise ca documente Word pentru
personalizare. Tn felul acesta pot fi concepute scrisori, etichete, plicuri cu aceeasi forma
generala, dar care folosesc informatiile din baza de date sursa si devin documente
particularizate.

Pentru acest lucru putem folosi Mail Merge Wizard.
Pasii de baza sunt:

1. Deschidem sau cream o macheta sau un document principal (main document) care
contine textul si grafica comuna tuturor documentelor personalizat obtinute prin acest
utilitar.

2. Deschidem sau credm tabelul sursa (data source) care este un fisier ce contine
informatia ce va fi inserata in documentul principal.

3. Adaugam sau personalizam pe sablon campurile de legatura (field merge) din sursa
de date care vor personaliza documentul.

4. Verificam rezultatul combinarii Tn exemplarele personalizate obtinute din acelasi
sablon.

Exemplul 4

Pentru inscrierea la bacalaureat toti elevii vor depune la secretariatul liceului o cerere
cu aspectul prezentat in continuare.

Pentru simplificarea lucrului, secretariatul doreste sa completeze automat aceste cereri
pentru elevii din clasa a Xll-a, mai ales ca datele personale ale elevilor sunt deja
gestionate Tntr-un fisier Excel. Foile pot fi apoi distribuite elevilor pentru a fi semnate
de catre acestia si depuse la secretariat.

Analiza problemei
Tn primul rand, identificdm campurile variabile din macheta cererii.

Tn imaginea al3turatd am subliniat aceste campuri. Avem nevoie de: numele elevului,
numarul de buletin si seria, CNP, clasa si media.

TEHNOLOGIA INFORMATIEI §1 A COMUNICATIILOR ® CLASA A XI-A




08.05.2006

Va multumesc,

Domnule Director,

Subsemnatul/a Panainte M. Irina Ioana, legitimata cu A.1. seria MX nr.
247110, CNP 2700817921167, cleva in cls a XII-A a Lic. De Informaticd — Iasi
va rog a-mi aproba prezentarea la examenul de bacalureat In sesiunea funie-iulie

2006. Mentionez cd am absolvit a clasa a XII cu media 9.77

Fig. 9.11.
Exemplu de
cerere
personalizata

Panainte Irina loana

Catre Directorul Liceului De Informatica ,,Gr. Moisil”” — Ia$i

Secretariatul liceului dispune de un
registru Excel cu numele Scoala.xls
unde sunt Tnregistati toti elevii in
care foaia de calcul Elevi contine
lista elevilor Tnregistrati.

Pasul 1. Apelam utilitarul Mail
Merge Wizard prin Tools—>Letters
and Mailings.

Acest utilitar ne va prezenta pas
cu pas operatiile necesare. Putem
trece la pasul urmator sau putem
reveni la pasii anteriori.

Pasul 2. Alegem sursa de date din
fisierul Excel folosind pentru
aceasta optiunea Use an existing
list si prin Browse alegem fisierul
si din acesta foaia de calcul.

Pasul 3. Din lista Excel selectam
articolele necesare, le ordonam

Mail Merge v X

Select recipients

® Lse an existing lisk
Select from Cutlook contacts
Type a new lisk
Use an existing list
Use names and addresses from a file or a database,

Browse, ..

Step 3of 6
g Mext: Write vour letker

41 Previous: Starting document:

Fig. 9.12. Utilitarul Mail Merge permite deplasarea la
pasul urmator si la cel precedent

etc. Modul de inserare a datelor din surse externe a fost deja prezentat.

Pasul 4. Compunem documentul principal si in zonele variabile inseram campul de
legatura cu baza de date prin butonul insert Merge Field de pe bara de butoane Mail

Merge deschisad automat.

Pasul 5. Vom previziona rezultatul prin butoanele de deplasare existente in fereastra
Preview your letters. Putem gasi o anumita persoana prin butonul Find a recipient.
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| 2]%]|

To sork the list, click the appropriate column heading. To narrow down the recipients displaved by a
specific criteria, such as by city, click the arrow next to the column heading. Use the check boxes or
buttons to add or remove recipients from the mail merge.

List of recipients:

|v M | hd |:| T buletin ¥ clasa | | * medie | *| camin | *| bursa | ¥/ &
Albule,., 1234, mx 12345 1Za 10 da 100 1]
Chira ... 2090... dx 23455 1Za 10 nu 200 30
Dobre...  1222... mc 23459 12b 7 da 100 20

Filter, and Sort

Filter Records l Sork Records ]

Figld: Camparison: Compare ko

|medie j |Greater than or equal j |5|
| 1 I 11 LI

Fig. 9.13. Lista afisata de Mail Merge permite selectarea manuald a articolelor — prin caseta de validare
din fata primului camp sau prin verificarea unei conditii introdusa prin fereastra de dialog Filter.

Domnule Director |

Subsemnatia mnumes legitimat'd cu abwfelirzs, CNF xonpe, elevis
In clasa gclagas VA rog a-mi aproba prezentarea la examenul de
bacalurest Tn sesiunea iunie-ilie 2006.
Mentionez c& am absolvit cls a Xl la Liceul de Informatica ™Tn anu
2006 cu media smedies
W& multumese,

gnurmes.

05.05.2006

Fig. 9.14. LMacheta cereri are campurile trecute Tn zonele variabile

Sarcini de laborator

1. Realizati o baza de date Excel cu clientii unei firme. Retineti numele, adresa, codul
fiscal, daca este persoana fizica sau juridica (societate comerciala, societate pe actiuni,
asociatie familiala etc.).

2. Trimiteti persoanelor fizice cate o felicitare de Anul Nou pe care sa o compuneti in
Word.

3. Trimiteti persoanelor juridice cate o somatie de plata compusa tot in Word.

88 TEHNOLOGIA INFORMATIEI §1 A COMUNICATIILOR ® CLASA A XI-A




(s, ¢
(Test 8

Testul verifica abilitatile de lucru cu tabele Word si legatura cu Excel

1. Realizati Tn Word un tabel pentru evidenta manualelor scolare la biblioteca. $tim ca
manualele scolare cu caracter gratuit sunt folosite 4 ani. Fiecare elev care a primit cartea
trebie sa o Thapoieze (eventual).

Tntr-un tabel treceti: cod-carte, titlul, autorul, editura, pretul, clasa, numarul de
exemplare primite, numarul de exemplare comandate, numarul de exemplare distribuite
fn anull, anul2, anul3, anul4 si numarul de exemplare returnate de catre elevi in anull,
anul2, anul3, anul4.

2. Realizati Tn acelasi document Word un tabel cu datele fiecarei edituri (nume, adresa,
cont-la-banca etc.).

2. Introduceti date (maxim 10 carti de la 3 edituri) folosind formularul Word.
3. Aranjati tabelul cartilor pe clase si titlu si tabelul editurilor alfabetic dupa nume

4. Puneti formule pentru a calcula:
a. valoarea fiecarui titlu primit (cantitatea primita*pret).
b. diferentele intre distribuit si returnat in fiecare an si total.

5. Formatati ambele tabele. Dati-le un titlu. Plasati referinte tip bookmark la cele
doua tabele.

6. Realizati pentru biblioteca fise cu situatia fiecarui manual. Situatia este compusa
ca document standard si cuprinde numele liceului, sigla, adresa acestuia, numele
bibliotecarei sau orice informatie credeti ca este utila. Partea variabila va fi preluata din
tabel: codul-manualului, numele manualului, autorul si clasa, preful, cantitatea comandata,
cantitatea primita si diferenta (cantitativ si valoric). Puteti adauga si alte variabile.

7. Copiati tabelul intr-un registru Excel si calculati valoarea totala pe edituri a cartilor
trimise scolii.

8. Realizati o corespondentd personalizata pentru fiecare editura, aratand valoarea
cartilor comandate si cea primitd de la editura prin asocierea tabelului Excel realizat la
punctul anterior cu un document Word cu textul compus de voi.
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Lectia 1 O

Problema securitatii datelor

v’ Protectie in Excel

v Protectie in Word

10.1. Protectia datelor in Excel

Microsoft Excel ofera cateva niveluri de protectie pentru a controla cine poate accesa
si modifica datele tabelelor Excel. Un registru de calcul poate fi utilizat in comun, simultan,
intr-o retea de calculatoare, fiecare utilizator avand posibilitatea de a vedea schimbarile
facute de ceilalti utilizatori. Acesta se numeste modul Shared (partajat) de functionare a
registrului. Modul Protected permite utilizarea exclusiva a registrului de catre un utilizator.

10.1.1. Protectia la deschiderea registrului

Se va permite accesul la registru numai utilizatorilor care cunosc parola. Se procedeaza
astfel:

e Se actioneaza File->Save as.

e Se deschide fereastra Tools—>0ptions—> Security, unde se fixeaza parola de acces la
registru. Daca dorim ca parola sa fie data Tnainte ca utilizatorul sa intre in registru, vom
folosi Password to open. Daca dorim ca parola sa fie ceruta Tnainte de inchiderea registrului,
vom folosi Password to modify.

e Se inchide fisierul (cu suprascriere).

Registrul poate Tn Tntregime sa fie deschis numai pentru vizualizare daca se activeaza
comutatorul Read-only Recommended (vezi figura 10.1).
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Options

Yiew l Calculation ] Edit ] eneral ] Transition ] Custom Lists | Chart |

Save

Colar ] International l Error i_hecking l Spelling

File encryption settings For this workbook

Password to open: |

Advanced. ..

File sharing settings For this workbook,

Password to modify: |

I Read-only recommended

Ciicik =l Siacak e, |

Fig. 10.1. Optiune pentru deschiderea numai pentru vizualizare

10.1.2. Protectia elementelor unui registru

Se realizeaza prin Tools—>Protect Workbook.
Daca se activeaza butonul Structure, utilizatorului
nu i se va permite sa realizeze operatii cu foi de
calcul (sa adauge, sa stearga, sa redenumeasca
foi sau sa vada foile ascunse). Daca se activeaza
comutatorul Windows, utilizatorul nu poate sa
modifice pozitia, dimensiunea ferestrei unde este
deschis registrul.

Protect Workbook

2]

Protect workbook For
[v Skructure
[ Windows

Password (optional):

Cancel

o]

Fig. 10.2. Protectia elementelor unui
registru-foi de calcul

10.1.3. Protectia foii de calcul

Protejarea foii de calcul
— printr-o parola sau nu- in-
terzice accesul la unele ce-
lule. Se realizeaza prin
Tools—> Protections—> Protect
Sheet. Se poate da o parola.

Implicit, Tn foaia de cal-
cul toate celulele sunt blo-
cate; astfel, operatia de
instalare a protectiei inhiba
accesul la Tntreaga foaie.

Allaw all users of this worksheet ko;

[v Zelect locked cells
[v Select unlocked cells
Fornat cells
[+ Format columns
v Farmat rows
v Insert columns
v Irsert rovs

v Delete colurmns
[v Delete rows

Fig. 10.3. Fixarea
restrictiilor asupra
elementelor foii de
calcul: sa nu se
poata modifica
formatele, sa nu se
poata insera sau
sterge linii sau
coloane, sa nu se
poata sorta, constitui
subtotalizari sau
tabele pivot etc.
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De aceea, Tnainte de a aplica protectia
se vor selecta celulele la care accesul este
permis prin Format->Cells>Protection si
dezactivarea comutatorului Locked.

Anularea protectiei asupra foii de calcul
se face prin Tools—>Protections—>Unprotect
sheet.

Border

¥ Locked
I Hidden

Fig. 10.4. Fixarea protectiei la celulele selectate

10.1.4. Urmarirea corectiilor facute de utilizatori in modul Share

Microsoft Excel poate sa pastreze informatii despre cum s-a modificat foaia de calcul.
De fiecare data cand un utilizator modifica datele din foaie, acestea se Tnregistreaza intr-
un istoric. Acest lucru este esential atunci cand foaia de calcul este utilizata simultan de

mai multi utilizatori Tn retea.

Exemplul 1
Am fixat operatia de urmarire a corectiei si observam cine si cand a modificat valoarea
din celula.
= i ' Fig. 10.5. Urmarirea
2 |NUME WARSTA LOCATIE pantiru, 06.03.2006 16:50: - cogrectiei
3 ANDREI 14[sala 1 T |Changed cell C3 fram 'hol' o 'sala 1°, ;
4 GICA, 12 hal i Celula C3 a fost
5 GABI 10 hol m || modificata!
E BEEE 10 parter f | ;

2]l

I¥ Track changes while editing. This also shares your workboak,

Highlight Changes

Highlight which changes

© when: [ - |

[~ who: |E\teryone -

[ where: | E=

[+ Highlight changes on screen

v List changes on a new sheet

Urmarirea modificarilor este posibila doar in modul de lucru Shared workbook. Fiecare
actiune poate fi anulatd sau pastrata. Istoricul pastreaza ultimele modificari (in mod
implicit, din ultimele 30 zile). De fiecare data cand se inchide registrul se sterg din
istoric acele informatii care nu se Tncadreaza n termen.

Fig. 10.6. Mecanismul de Tnregistrare a
corectiilor asupra unei baze de date se
activeaza prin Tools=>Track
Changes->Highlight Changes si in fereastra de
dialog se fixeaza, eventual, domeniul de celule
vizat.

Corectiile pot fi urmarite pe ecran sau in alta
foaie de calcul.

Istoricul corectiilor se poate pastra in alta foaie de calcul — History — si poate fi
consultat pentru a se decide daca modificarile pot fi acceptate sau trebuie anulate.
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A B C D E F G H | J < =

Action New Ol Action  Losing
i _Number w|Date  ~|Time w|Who w|Change  w|Sheet w|Range w|Value w|Value v|Type ~|Actior
3 37 06.03.2006  16:50 pantiru  Cell Change ghizi (4) C3 sala 1 hol

9
40 The history ends with the changes saved on 06.03,2006 at 16:50.
41
o)

Fig. 10.7. Foaia de calcul History contine informatii despre modificarile foii.

Accept or Reject Changes

Change 1 of 36 made ta this docurnent:
pantiru, 06,03, 2006 16:42:

Changed cell A16 from '<blank:" ta 'bb'.

Fig. 10.8. Lista corectiilor poate fi afisata si
direct pe ecran, Tn caseta de dialog
urmand sa decideti imediat daca salvati
corectia sau nu (optiunea Highlight
onscreen).

Reject | Accept all | Reject all |

10.2. Protectia datelor in Word

1. Protectia prin parola la deschiderea documentului se face prin Tools->Options
—>Security. Introducem parola Tn caseta text Password to open.

2. Protectia prin parola la modificarea documentului se face prin Tools->0ptions
—>Security. Introducem parola n caseta text Password to modify.

3. Protectia formularului Word se face prin butonul Protect form de pe bara de butoane
Foms. Anularea protectiei se face prin butonul Reset Form fields. naintea distribuirii in vederea
completarii unui formular de catre utilizatori acesta trebuie protejat astfel incat utilizatorii sa
actioneze numai Tn zonele desemnate. Acest lucru se face prin Tools—>Protect Docu-
ment->Forms. Se atribuie o parola. Utilizatorii care o cunosc pot sterge protectia si schimba
formularul. Utilizatorii care nu cunosc parola nu pot decéat sa acceseze campurile formularului.

4. Urmarirea modificarilor se face folosind Tools—> Protect document—> Tracked changes.

Sarcini de laborator*

Patronul echipei de fotbal Dinamo doreste sa stie Tn orice moment unde a jucat sau va
juca echipa sa, cu cine, cand, la ce ora. Desigur, ar dori si un clasament a jocurilor
desfasurate, Cate goluri au marcat jucatorii din echipa sa si cat au primit la fiecare meci,
precum si totalul pe echipe. De asemenea, patronul echipei Dinamo este interesat sa stie
cate bilete s-au pus in vanzare fata de capacitatea stadionului, cat este castigul obtinut
de echipa Dinamo la fiecare meci jucat, cat este castigul total de la momentul inceperii
evidentei. Uneori patronul de la Dinamo doreste sa stie si care este castigul estimat
pentru perioada urmatoare (in functie de biletele deja vandute la meciurile urmatoare si
de un pret mediu cunoscut pentru fiecare stadion Tn parte). Se cere sa faceti analiza
problemei si sa proiectati un registru pentru patronul echipei Dinamo. Stabiliti care sunt
utilizatorii registrului si care date sunt ,,secrete”.
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Lectia 1 1

Macroinstructiuni

si obiecte de control

v'  Ce este si cum se defineste o macroinstructiune
v’ Executia unei macroinstructiuni

v’ Asocierea macroinstructiunii la un buton

O macroinstructiune cuprinde o secventa de comenzi. Ea se memoreaza si poate fi
executata ori de cate ori avem nevoie.

11.1. Cum se realizeaza o macroinstructiune?

Pasul 1. Se stabileste ce se doreste a se realiza cu ajutorul macroinstructiunii si se
fixeaza cum se va realiza acest lucru: secventele sau manevrele intr-o anumita ordine. Se

face un plan de actiune.

Pasul 2. Se alege Tools>Macro>Record New Macro... care deschide o fereastra de

dialog.

Macro »

Customize. ..

» Macros... Alt+FS

@ Record New Macro..,

Pasul 3. Se introduce un nume semnificativ al macrocomenzii si o scurta descriere.

Record Macro

2] x] Putem sa asociem o combinatie de
taste pentru lansare rapida (Shortcut
Key) De exemplu <Ctrl><M>.

Pasul 5. Se deruleaza manevrele
dorite exact Tn ordinea intentionata.

Macro name:
Vacrod
Shortcut key: Store macro in;
CtrH-l_ IThis workbook
Description:

j Fiecare manevra este nregistrata ca o
instructiune.

Macro recorded 06.06.2004 by pantiru

Pasul 6. Se opreste inregistrarea prin
Tools—>Macro—> Stop recording.
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11.2. Cum se activeaza o macroinstructiune?

1. Prin shortcut, daca ati fixat o astfel de combinatie. De exemplu tastam <CtrI><M> pe
registrul unde am memorat macro-ul.

2. Prin Tools—>Macro—> Macros, care deschide fereastra de dialog pentru alegerea macro-
instructiunii. Putem lansa n executie prin butonul Run.

3. Prin activarea unui buton care are asociata ca actiune macroinstructiunea.

11.2.1. Cum se asociaza macro-ul unui buton pe bara cu instrumente?

Pentru crearea unui

buton folosim din meniul & [& ¥ X Close BR - <7

princial comanda View A Image and Text
Commandss Macror, EE S | 5<on > S
Commands—> Macros. =
Executam manevra Drag& Toobars  Commands | Options I Assign Hyperlink

Drop si plasam butonul
Custom Button pe bara de | To add a command to a toolbar: select & cate
butoane a ferestrei Excel | Command out of this dialog box to a toolbar.

Assign Macro. ..

(toolbars). Din meniul con- C°F°9°ri°" Commangs:
textual atasat butonului ;‘?Ei?n“;a“d Hep ] Custom M
glegem Assign Macros si AutoShapes ) Custom B
indicam numele pe care Chartina

dorim s&-| atribuim macro-  Fig. 11.1. Fixarea macro-ului la un buton
instructiunii.

Putem schimba imaginea butonului sau/si putem atribui acestuia un nume.

11.2.2. Cum se asociaza o macroinstructiune unui buton de comanda?

Macroinstructiunea poate fi asociatéd unui buton (sau altui obiect) din foaia de calcul.
Pentru aceastd operatie se foloseste bara de butoane Control toolbox. Se selecteaza butonul
de pe bara si se contureaza pozitia si dimensiunea obiectului pe foaia de calcul cu mouse-ul.

Control Toolbox + X Fig. 11.2. Bara de instrumente

& Butonul Design permite construirea si/sau editarea obiectelor de pe

foaia de calcul.

W [ o & Bu.tonul Properties permite afisarea listei proprietatilor asociate
. obiectelor de pe foaie.

= B = A Py Butonul View code afiseazd codul program asociat obiectelor.

Pasul 1. Vom plasa butonul pe foaia de calcul astfel: se selecteazd cu mouse-ul de pe
Control toolbox si apoi se contureaza forma acestuia pe suprafata foii de calcul.
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Pasul 2. Vom edita obiectul asa cum se arata n continuare.

Vom deschide fereastra de proprietati prin
meniul contextual asociat butonului de
comanda (clic dreapta). Unele proprietati au
valori implicite, cum ar fi culoarea de fundal
sau culoarea textului asociat. Sunt multe
proprietati pe care le-am proiectat deja cand
am conturat obiectul pe foaia de calcul:
pozitia, latimea, lungimea. Putem sa le
schimbam. Vom folosi Tnsa proprietatea
Caption care asociaza textul explicativ buto-
nului. De asemenea este util s& dam nume
intern butonului pentru a ne referi la acesta
(proprietatea name)

Am proiectat forma butoanelor. Am proiectat macro-
instructiunile. La acest pas trebuie si le legdm. In modul
de lucru Design vom deschide meniul contextual asociat
butonului si vom alege optiunea Assign Macro... care
deschide fereastra cu macroinstructiuni. Vom alege macro-

instructiunea dorita.

Properties @

|commandButton5 CommandButton ]
Alphabetic | Categorized |
(MName) CommandButtonS ~
Accelerator
Autoload False
AutoSize False
BackColor [ a+s000000Fe
BackStyle 1 - fmBacksStyleOpaque
meciuri |
Enabled True

Assign Macro

jutton1027 Click

Bookl.xls!Macrol
Macro3
[Book1 . xls!Macro3

e =EMBED("Forms.CommandButton. 1"

c ] E F £}

o o
o CommandButtons
g Cut

Copy
Paste

Properties

P

Wigw Code

fl Fig. 11.3. Fixarea macro-ului unui buton
de comanda

Editarea textului asociat butonului se face
prin meniul contextual CommandButton
Object—>Edit.

Odata butonul proiectat pe foaia de calcul,
acesta are asociatd o metoda =EMBED(..)
Pentru ca noi vom asocia ca actiune o macro-
instructiune, va trebui sa stergem Formula

——
T

Grouping 3

Order 3

CommandButton Object }l Edit ’

bar.
Tn aceasts situatie, editarea se face prin
fereastra Properties.

11.4. Alte obiecte de control pe foaia de calcul

1. Obiect tip Image

Putem insera imagini prin obiectul Image la care vom selecta, din fereastra de proprietati,
linia cu proprietatea Picture si vom alege fisierul imagine dorit.

2. Obiect tip Label

Putem folosi un obiect tip Label pe foaia de calcul, caruia Ti fixam proprietatea Caption.
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Exemplul 1

Sa presupunem ca retinem patru categorii de informatii: despre jucatori, echipe, meciuri
si stadioane in zone diferite ale aceleiasi foi de calcul.

Fiecare buton de comanda are asociat o macroinstructiune de

B deplasare la zona de date indicata.
Macro-ul cu numele GO_echipe este proiectat astfel:
R Pasul 1. Ne pozitionam in fereastra ,,principal” si deschidem meniul

Tools>Macros—>New.

Pasul 2. Atribuim macrocomenzii numele: go_echipe.

jucatari | Pasul 3. Selectam foaia de calcul ,baza” si celula AAL.

Pasul 4. Selectam foaia de calcul ,Principal”.

Pasul 5. Oprim inregistrarea actiunii prin Tools>Macros->Stop macro.

stadioane

Zona pentru meciuri incepe la celula A1, zona pentru echipe Tncepe la celula AA1, zona
pentru informatii despre stadioane incepe la celula A200, iar cea pentru jucatori la
celula AA200.

Foaia principala va contine 4 butoane pentru selectarea automata a zonei din foaia de
calcul necesaa unui utilizator.

A B C D E i AA AB

1 meciuri echipe

2

3 echipal echipa2 data loc scor cod nume_echipa grupa
| 4 |steaua dinamo 01.01.2006 1[1-4 1 steaua a

5 dinamo steaua 01.022006 226 2 dinamo a

B 3 rapid a

7 4 uta b
200 stadioane jucatori
201
202 cod nume_stadion loc nr_locuri cod nume_jucator data_na
203 1 ghencea bucuresti 500 1 popescu 11.12.1
204 2 2 ionescu 01.031

Proiectarea macro-urilor (macroinstructiunilor)

Proiectam 4 macro-uri care vor avea misiunea sa dirijeze controlul catre zonele de date.
Macro-ul Go_meciuri se va proiecta astfel:

Pasul 1. Ne pozitionam in fereastra ,,principal” si deschidem meniul Tools=>Macros—>New.
Pasul 2. Atribuim macroinstructiunii numele: go_meciuri.

Pasul 3. Selectam foaia de calcul ,,baza” si celula A1 (unde Tncepe zona pentru meciuri).

Pasul 4. Ne intoarcem si selectam foaia de calcul ,principal”.
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o - Assign Macro

Pasul 5. Oprim Tnregistrarea actiunii B
prin Tools>Macros—> Stop Macro. Grouping » || Macro name:
Asocierea dintre macro Si buftonul de Order v || [go_echipe
comanda se face prin proiectarea _ '

Lo . . Assign Macro. ., . apel_mac
butonulm_. [n modul Design dgschl— - _ completare meci
dem meniul contextual cu optiunea |¥ FormatPicture... ' qo_echipe

Assign Macro.

(5.4
(Test 9 L%

Se va verifica nivelul cunogtintelor si al deprinderilor de operare cu macro-uri .

Se va puncta fiecare sarcina cu 1 pct + 1 pct din oficiu

Deschideti registrul de calcul ,inspectorat”.

1. Proiectati o foaie de calcul “olimpiada_judet” care sa contina
numele elevului, disciplina, clasa, scoala de unde vine, premiul.
Puneti 10 articole Tn care sa fie maxim 2 scoli, maxim 3 discipline,
premiul va fi 1, 2, 3 sau 4 (pentru mentiune). 1 pct

2. Proiectati o foaie de calcul numita “principal” astfel:

a. nu va avea gridlines; 0.5 pct
b. va avea o imagine de fundal-poza inspectoratului; 0.5 pct
c. se va scrie textul “inspectoratul scolar” cu Word Art; 0.5 pct
d. va avea un obiect tip Label cu numele realizatorilor aplicatiei. 0.5 pct

3. Proiectati butoane de comanda pentru:
a deplasarea in foaia de calcul scoli si sortarea alfabetica a scolilor 2 pct

b. deplasarea in foaia de calcul profesori si obtinerea unui liste
centralizatoare a numarului de profesorilor pe catedre. 2 pct

c deplasarea n foaia de calcul olimpiade, unde se va face o tabela pivot
cu numarul elevilor premianti pe scoli si discipline. 2 pct
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Numere aleatoare
si simulari

Lectia ]. 2

v'  Functia de generare RANDOM

v"  Simularea Monte Carlo

Tntr-o lume atat de complex3 ca aceasta in care traim, a lua decizii este un act foarte
dificil, pentru ca trebuie sa se tina cont de o multitudine de factori care pot avea o
evolutie variata. O cale de a rezolva problemele decizionale este de a construi un model
fizic sau matematic si de a-I supune diferitelor teste. Orice intrare conduce la 0 anume
iesire. Prin simularea — pe suficient de multe valori — a intrarilor putem ajunge la o iesire
favorabila si actul decizional este simplificat.

Sa luam, de exemplu, un decident de la o statie de benzina care trebuie sa decida
numarul de pompe strict necesare pentru motorina si pentru benzina. Nu trebuie sa fie
nici prea putine, astfel Tncat sa se formeze cozi, dar nici prea multe, ca statia sa someze
si sa nu-si acopere cheltuielile! Prima intrebare pe care si-o pune decidentul este care
sunt factorii care influenteaza numarul de pompe? Va trebui construit un model al
functionarii statiei de benzina care sa simuleze sosirile masinilor cu o anumita ritmicitate,
duratele de servire, tipul de combustibil, cantitatile solicitate. Pentru fiecare set al
parametrilor de intrare se calculeaza functia obiectiv si se memoreaza aceste scenarii.
Acum decizia se poate lua mult mai usor!

Ne propunem sa discutam despre problemele de simulare si de estimare a evolutiei
unui fenomen folosind generarea aleatoare a datelor.

12.1. Functia Rand()

Functia Rand() genereaza un numar aleator subunitar - B
cu 15 zecimale, cuprins intre O inclusiv si 1 exclusiv. = B ¢ )
De fiecare datad cand este apelata, functia intoarce ;
alt numar. ﬂ 0 351034
Se poate solicita regenerarea numarului prin mane- ; gg&gg?;
vra manuala cu F9. 6 0.788432
<o . . 7 0.403029
Pentru a genera un numar intreg intr-un interval a-b | g =

folosim formula = int(Rand()*b)+a
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Sarcini

Scrieti Tntr-o celula functia Rand() si copiati-o Tn urmatoarele 5 celule. Ce observati?
Se pastreaza numarul din prima celula? Cate numere s-au generat? Copiati formula Tn
1000 de celule. Se repeta numarul generat?

Exemplul 1

Jocul ,,Cap-Pajura!”
Foaia de calcul va afisa ,cap” sau ,pajurd” in functie de un numar generat care
simuleaza aruncarea unei monede. Afisati 10 situatii!

Analiza
Probabilitatea ca 0 moneda sa cada pe o fata sau alta este egald de 50%
Vom asocia numarul generat fie la o fata, fie la alta. Cum?

Daca stim ca numarul generat de functia Rand() este cuprins intre O si 1, vom considera
ca moneda cade pe ,,cap” daca numarul se gaseste in intervalul 0-0.5 si vom afisa
»pajura” daca numarul generat este mai mare decat 0.51

Putem sa scriem formula urmatoare = if(rand()>0.5;”pajura”; " "cap”)

Mai simplu:

Daca avem o caciuld cu 10 bilete, pe 5 dintre ele vom scrie ,cap” si pe 5 vom scrie
»pajurd”. Sa numerotam biletele si sa spunem ca toate biletele de la 1 la 5 iTnseamna

=

,cap” si dela 6 la 10 Tnseamna ,pajura”.

Noi nu avem caciuld, dar avem calculator care poate sa genereze aceste valori si ne
revine sarcina sa le interpretam.

Pentru generarea numarului vom folosi formula =int(rand()*10)+1.

Putem scrie formula urmatoare =if (int(rand()*10)+1>5; ,,pajura”;"cap”).

Dar moneda poate sa cada si pe cant! Va trebui sa tinem cont si de aceasta posibilitate.

Presupunem ca in 45% din cazuri moneda cade pe o fatd, in alte 45% cade pe cealalta
fata, iar in 10% moneda cade pe muchie.

Cum asociem numarul generat la un eveniment? Daca numarul este intre 1 si 10 va fi
cam greu, va trebui sa lucram cu zecimale, mai bine sa generam un numar intre 1 si
100.

Primul pas este sa impartim toate cele 100 de numerele in trei segmente care corespund
probabilitdtilor de producere a evenimentelor, deci numerele generate intre 1-45 vor
corespunde ,,afisare cap”; cele intre 46-90 vor corespunde la ,,afisare pajura” iar cele
intre 91-100 la ,,afisare muchie”).

Sa scriem formula folosind if
=if(int(rand()*100)+1<46:"cap”; if (int(rand()*100)+1<91; ,pajura”’; " muchie”)

Dar, atentie, formula are o hiba, pentru ca de fiecare data cand se apeleaza functia
Rand() se genereaza alt numar!
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De aceea vom folosi alta metoda. Generam numarul o singura data si afisam mesajul
corespunzator cautand valoarea intr-o tabela folosind Viookup.

. Interval de Valoare in cautare
Eveniment Procent . L
numere inexacta
Afisare 1 167 1-167 1
Afisare 2 167 168-334 168
Afisare 3 167 335-501 335
Afisare 4 167 502-669 502
Afisare 5 167 670-836 670
Afisare 6 167 837-1000 837
Total numere 1002

Proiectarea foii de calcul

. o o ~ - = KUP(F |

Pasul 1. Proiectdm tabela de cautare Tn GaE - = WDOG ~ ﬁ:"abe al-de-':a”mf'z)
domeniul 13:J6 si o vom numi |1
,,tabela_de_céutare”. g | numar generat :ﬁ;sa' tabela -leI -:‘:.:;tale
Pasul 2. Scriem formula pentru generare ; fink{zand(2100) 11 g; cap ;? pajura
~ - chie muchie
in celula F3 =int(rand()*100)+1. : 1hlcgp —
Pasul 3. Scriem formula de afisare | [ o o
mesaj prin cautare in celula vecina. 9 70 pajura

10 22 ca
G3=vlookup(F3,tabela_de_cautare;2). | i &0 piu,a

Pasul 4. Copiem pe coloana si verificam
functionarea simularii prin F9!

Exemplul 2

Dorim sa simuldm aruncarea unui zar. Sa proiectam o foaie de calcul pentru 10 aruncari.

Analiza

Fiecare fata corespunzatoare unui numar are exact aceeasi probabilitate de aparitie.
Probabilitatea de aparitie a unui eveniment este 1/6 = 0,1666666, adica aproximativ
= 0,167 (lucram cu 3 zecimale!) deci vom lua 1000 de numere pentru ca 167 dintre
ele sa reprezinte probabilitatea doritad. (obs. Este o mica eroare la ultimul eveniment!).
Cum asociem numere fiecarui eveniment?

Daca vom genera un numar intre 1 si 167 inseamna ca zarul cade cu numarul 1, daca
numarul generat este intre 168 si 334 inseamna ca zarul afiseaza valoarea 2, s.a.m.d.
Sa urmarim tabelul de mai jos.

Eveniment Procent | Interval Valoare in tabela de cautare
numere

Cerere 5 buc 10 0-9 0

Cerere 15 buc 20 10-29 10

Cerere 20 buc 30 30-59 30

Cerere 25 buc 30 50-89 50

Afisare 30 10 90-99 90

Total numere 100
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Proiectarea foii de calcul

Pasul 1. Nu uitam sa folosim facili- T v N o ] P o
tatile seriilor de date: pentru prima tabela de cautare
coloand vom incepe cu valoarea 1 |™"* "™ *% 15; ;

si apoi prin Edit->Fill>Series scriem e 335 3
seria cu pasul 167 oprindu-ne 1a | |movooredoseins) 25 ;
1000. Pentru a doua coloana putem 836 6
folosi manerul Fill Tn seria cu pasul . -

1 pornind tot de la 1.

Pasul 2. Punem ntr-o celula formula de generare =int(rand()*1000)+1.
Pasul 3. Punem alaturi formula de cautare.

Pasul 4. Copiem si verificam functionarea prin tasta F9.

Exemplul 3

0 problema de simulare: problema stocurilor

Firma de vanzare a telefoanelor mobile ,,Cell-Compact” doreste sa isi deschida o
sucursala n alt cartier. S-au Tnregistrat cererile pe zi pentru produsul sau si s-a observat
ca in 10% din cazuri se cer 5 bucati, in 20% se cer 15 bucati, in 30% din cazuri se
cer 20 sau 25 bucati, iar numai in 10% se vand 30 buc. pe zi.

Se doreste sa se determine care sa fie stocul initial de telefoane pentru noua
sucursala astfel Tncat sa nu fie cereri neacoperite timp de 10 zile. Sa se simuleze
cererile. Sa se memoreze scenariile schimband nivelul initial al stocului la valorile
50, 100, 150, 200 si inregistrandu-se numarul de zile de ruptura de stoc.

Analiza

Date de intrare: stocul de la inceputul gestiunii.

Date de iesire: numarul de zile cu ruptura de stoc.

Prelucrari: in prima zi stocul initial este chiar stocul de inceput de gestiune.
Tn fiecare zi din stocul initial se scade cererea si se obtine stocul final.

Ruptura de stoc apare atunci cand cererea este mai mare decat stocul initial.
Stocul de la sfarsitul unei zile devine stoc initial n ziua urmatoare

Cum simulam o cerere? Vom genera un numar intre 0-99 si vom asocia ntervale de
valori numerice pentru fiecare eveniment:

Eveniment Procent | Interval numere | Valoare in tabela de cautare
Cerere 5 buc 10 0-9 0

Cerere 15 buc 20 10-29 10

Cerere 20 buc 30 30-59 30

Cerere 25 buc 30 50-89 50

Afisare 30 10 90-99 90

Total numere 100
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Proiectarea foii de calcul

Pasul 1. Proiectam tabela de cautare Tntr-o zona vizibila a foii de calcul pentru a putea
verifica corectitudinea datelor generate. Pentru verificarea suplimentara se poate asocia
o coloana Tn care sa calculam numarul de valori din intervale, deci procentul corespunzator
cererii prin scaderea valorilor din celulele vecine. Ex: H4=15-14.

Pasul 2. Completam stocul initial de gestiune in B2.

Pasul 3. Completam seria cu pasul 1 pentru numarul zilei.
Pasul 4. Completam numaérul generat B5=int(rand()*100).
Pasul 5. Completdm cererea C5=vlookup(B5, $i$4:$i$8, 2).

Pasul 6. Completam stocul initial al primei zile cu valoarea de Tnceput de gestiune
D5=B2.

Pasul 7. Calculam stocul final E5 = D5 — Cb.
Pasul 8. Punem o formula pentru a marca ruptura de stoc, ex Fb=IF(E5<0;"da”;"nu").

Pasul 9. Punem stocul initial al zilei urmatoare ca fiind cel final al zilei curente, deci
D6=Eb.

Pasul 10. Copiem toate formulele pe coloane.
Pasul 11. Completam celula Raspuns cu numarul de zile cu ruptura E2=COUNTIF(F5:F14,"da”).

Pasul 12. Verificam functionarea foii de calcul prezentatd mai sus ca pentru aceeasi
valoare de intrare apasand tasta F9.

Observam Tn imaginea foii de calcul ca 5 din zece zile sunt cereri neacoperite, ceea
ce, desigur, nu este avantajos pentru firma.

Observatie. Metoda simuleaza ,realitatea” si se apropie de ea cu atat mai mult cu cat
numarul de simulari este mai mare. Putem reface situatia pentru multe seturi de valori
generate si compara indicatorul ,,numarul de zile de rupturd”. Pentru aceasta vom centraliza
rezultatele Tn alta foaie de calcul.

Sarcini de laborator

1. Simulati situatia cererilor in cel putin 8 cazuri.

2. Calculati pentru fiecare simulare gravitatea rupturii ca fiind suma cererilor nerezolvate
n cele 10 zile.

3. Puneti un buton de comanda pe foaia de calcul care sa permita inregistrarea valorilor
indicatorilor Tn alta foaie.

4. Imaginati o foaie de calcul in care sa intervina aprovizionarea cu o cantitate x Tn
momentul Tn care stocul atinge o valoare y.
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Elemente de programare in
Visual Basic

Lectia 1 3

Mediul Visual Basic

Afisarea mesajelor prin Msghox
Introducerea datelor prin Inputbox
Instructiuni If, Select, Do While

NN NN

Microsoft Windows lucreaza cu obiecte. Un obiect este un lucru (o fereastra, o foaie de
calcul, un registru, un buton, un comutator etc.) caruia fi putem defini anumite proprietati.
De exemplu, un buton de comanda poate fi caracterizat prin textul explicativ asociat,
distanta n pixeli fatd de marginea din stanga a ferestrei unde este plasat, distanta fata de
marginea superioara a ecranului, Tnaltimea, starea vizibild sau ascunsa etc. Fiecare obiect
Excel (sau Access, sau Word) are definite toate proprietatile intr-o fereastra speciala Prop-
erties care se deschide din meniul View sau din meniul contextual atasat obiectului.
Utilizatorul poate seta anumite proprietati la valorile dorite sau accepta valorile implicite.

x|
||:md_sa|ul: CommandButton =
Alphabetic ICategDrized |
(Marne crnd_salut S
Accelerakor
Aukoload False
AutoSize Fal=e ﬂ
BackiZolor [] aHz000000
E‘;’;f:;"e 1 _fmBadStyle Fig. 13.1. Fereastra de proprietiti. Obiectul caruia i este descris3
Enabled True lista de proprietatl se poate alege din lista de obiecte.
Farit arial Pe linia de titlu se afiseaza automat numele obiectului.
E“Te:t"—"m g 2‘“3””'3”'31 Fiecare obiect are un nume intern — proprietatea name. In
2ig ) ” ”
Lt 01,5 exemplu name= cmdjsalut . .
Lacked True Un buton de comanda are un text asociat — proprietatea
Mouselcon (Mone) Caption. Iin captura Caption="salut”.
E:E‘L";ZPD'”ter E'B;t:‘a'”p";'”sep'j' Alte proprietati: pozitia (Height, Top, Left), culoarea de fundal
PicturePosition 7 - FrPickurePo (BackColor), culoareg pentru spris (Forel Color)l, stilul
Placerment 2 caracterelor (Font, size), imaginea asociata (picture).

Obiectele recunosc si raspund la anumite actiuni, numite evenimente.

Un eveniment este o activitate specifica si predeterminata, Tnitiata de sistemul de
operare (eveniment intern) sau de utilizator (eveniment extern) si la care un obiect stie sa
reactioneze. Exemplu: apdsarea pe butonul mouse-ului, miscarea mouse-ului, apasarea
pe o tastad sau Tntalnirea unei erori la introducerea datelor intr-un textbox (caseta cu text).
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Unui eveniment i se poate atasa o anumita procedura (este numita chiar Event proce-
dure) sau o macroinstructiune in limbajul Visual Basic. Metodele sunt proceduri asociate
unui obiect. De exemplu, o metoda asociatd la apasarea cu mouse-ul pe un buton de
comanda poate sa afiseze un mesaj sau sa activeze o anumita foaie de calcul, etc.

Calificarea obiectelor

Pentru a ne referi la obiecte trebuie sa cunoastem numele, proprietatile si metodele
sale. O proprietate sau o metoda se separa de obiectul calificat prin punct.

Exemple:

a) Cmd_salut.caption="salut” Fixam o proprietate a butonului cmd_salut
b) heets(“meciuri”).Select Se selecteaza-adica devine activ obiectul
de tip foaie de calcul cu numele “meciuri”
c) ActiveWindow.panels(1).Activate Se activeaza o zona (panel) cu numarul 1 din
fereastra activa

Visual Basic for Applications este un subset al limbajului de programare Visual Basic
si permite dezvoltarea aplicatiilor Tntr-o maniera programatica. Este important de semnalat
faptul ca VBA este utilizat de majoritatea aplicatiilor Office si putem transfera cod de la
o aplicatie la alta. Mai mult, datorita automatizarii OLE, putem integra complet aplicatiile
Office pentru a transfera date intre ele si a rula chiar o aplicatie din alta. Codul VBA este
retinut Tn module. Editarea unui modul se face in mediul Visual Basic Editor deschis din
Tools->Macro—>Visual Basic Editor sau direct la operatia de asociere a metodei unui obiect
prin Controls Toolbox, butonul View Code.

Toate modulele contin o parte de declaratii si o parte de proceduri. La fiecare pas
putem fi asistati de un Tnstrument foarte util Auto-List Members — care afiseaza proprietatile
si metodele adecvate. Comentariile se scriu precedate de un caracter apostrof.

13.1. Afisarea mesajelor prin functia Msghox

Sa presupunem ca pe o foaie de calcul dorim

un buton care sa afiseze data curenta. salut |

Nu dispunem de un macro care sa permita
afisarea unui mesaj, astfel incat vom proiecta pas

cu pas procedura asociata evenimentului Click al
butonului astazi este 09,03,2006

Pasul 1. Vom proiecta butonul de comanda “
fixand proprietatile -
Name =" Cmd_salut” si caption = “Salut”.
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Pasul 2. Vom scrie instructiunile necesare in aplicatia Visual Basic. Pentru aceasta
folosim butonul View Code de pe Control Toolhox sau vom executa dublu clic cu mouse-ul
pe butonul de comanda cmd_salut. Se deschide o fereastra de proiectare manuald a
procedurii Click Tn mediul Visual Basic.

Sa analizam putin aceasta fereastra.

Reintoarcere la Run — execut3 Break — forteaza

Stop -
Excel procedura oprirea procedurii

termina

i Microsoft Visual Basic - meciun®

Eile Edit View Insert Actiunea scrisa este

asociata
evenimentului click

# meciuri.xls - Sheet1 (Code)

|cmd_salut j ICIick

Private Sub cmd salut_Click()
X = NMNsgBox ("astazil este " & Date, vbOKOnly, "buna ziua")
End Sub

Procedura asociatd se numeste
“cmd_salut_click()”.
Observati functia Date pentru data sistem

Butonul se numeste
“cmd_salut”

Afisarea datelor si a mesajelor se poate face prin functia interna MsgBox care are
formatul general =MSGBOX(mesaj [, tip-butoane-si-pictogramel[,titlul)

- Microsoft Visual Basic - meciuri.xls

File Edit Yiew Insert Format Debug Run Tools  Add-Ins  Window  Help

MEE- # o yonom b MY ) ins) Fig. 13.2.
Proiectarea codului
in VBA se face foarte
usor datorita
instrumentului Auto

» meciuri.xls - Sheet1 (Code)

| cmd_salut j |Click

Private Sub cmd salut Click() List Members. Cand
¥ = MsgBox|("astazli este " & Date, vhOoEOnly, "buna ziua™) se recurloa§te 0
End Sub secventa de cod, se

deschide automat
lista de optiuni.

Argumentul <mesaj> contine informatia ce trebuie comunicatd si este singurul
obligatoriu. Butoanele asociate ferestrei pot fi: Ok, Cancel, Abort, Retry, Ignore etc. Se
pot folosi si pictograme cum ar fi semnul de intrebare, de exclamare, etc.
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Caseta de dialog pentru mesaj poate contine 7 tipuri de butoane care au asociata o

anumita constanta.

Constanta Valoare Buton
vbOKOnly 1 OK
vbCancel 2 Cancel
vbAbort 3 Abort
vbRetry 4 Retry
vblgnore 5 Ignore
Vbyes 6 Yes
Vbno 7 No

Pentru a sti pe care buton a apasat utilizatorul, vom folosi constantele asociate sau

valorile numerice.

Argumentul tip-butoane-si-pictograme permite definirea numarului de butoane, a tipurilor

si a pictogramelor asociate.

Constanta Afisare

vbokOnly Butonul OK

vbOkCancel Butoanele Ok si Cancel
vbAbortRetrylgnore Butoanele Abort, Retry, Ignore
vbYesNo Butoanele Yes si No
vbYesNoCancel Butonele Yes, No, Cancel
vbCritical Pictograma X ca semn critic (de interzicere)
Vbquestion Pictograma ? semn de intrebare
vbExclamation Pictograma ! semn de exclamare
vbinformation Pictograma i semn de informatie
Exemple:

x = MsgBox(“astazi este “ & Date,
vbInformation, “buna ziua”)

buna ziua

.
1)  astazieste 09.03.2006

[ 1]

x = MsgBox(“astazi este “ & Date,
vbExclamation, “buna ziua”)

! : astazi este 09.03,2006

[

x = MsgBox(“doriti continuare?”,
vbQuestion + vbYesNo)

Microsoft Excel

\__? / doriti continuare?

Yes No

x = MsgBox(“astazi este “ & Date, vbCritical,
“buna ziua”)

@ astazi este 09.03,2006
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Atentie! Vom lansa Tn executie metoda, adica ne vom reintoarce in Excel si vom apasa
butonul Cmd_salut. Dacd am scris corect procedura, atunci se va deschide caseta de
mesaje, daca nu, va trebui sa refacem procedura.

Observatie. Visual Basic dispune de alta functie pentru data sistem si anume DATE(),
pe care am folosit-o Tn exemplul prezentat anterior.

Sa facem cunostinta cu obiectele, proprietatile si metodele lor prin cateva exemple.

Exemplul 1

Pentru butonul de comanda cmd_meciuriam asociat un macro cu numele go_meciuri.
Observati in captura codul acestui macro.

Sub go_meciuri)

' go_meciuri Macro
| Macro recorded 07.03.2008 By pantiru | iy cazul macroinstructiunii go_meciuri,
, ne-am pozitionat pe foaia de calcul Baza,

Fevyboard Jhortcut: Ctrl+m X . N
apoi am activat celula Al din cadranul 1

Sheets(Mbaza") .Select (unde se gaseau datele despre meciuri),
AetiveWindow.Panes (1) . Activate dupa care am oprit macroinstructiunea.
Range ("AL™) . Select

End Sub

Deci

Am facut cunostinta cu clasa de obiecte Sheets, iar o instantd a acesteia este foaia de
calcul cu numele baza. Acestui obiect i s-a aplicat metoda Select. Fereastra activa
(ActiveWindow) are un obiect inclus, si anume cadranul 1 (panels (1), caruia i se
aplicd metoda Activate. Aceeasi metoda Select se asociaza si domeniului de celule
(obiectul Range).

Exemplul 2

Tn foaia de calcul principal dorim un buton care sa ne conducd direct in foaia de
calcul Clasament, sa ordoneze tabelul dupa numarul de meciuri jucate si sa faca o
subtotalizare dupa acest criteriu.

General) j |go_clasament

Zub go_clasament ()
!

go_clasament Macro

' Macro recorded 09.03.2006 by pantiru MaCrO—Ul GO Clasament a anegistrat
' Keyhoard Shorteut: Ctrltc selectarea foii de calcul clasament,
' Sheets{clasamentt).Select a tuturor celulelor, sortarea dupa

Cells.S3elect . .
Selection.Sort Keyl:=Range ("E2"], orderl:=xliscend COlO@Na B, subtotalizarea prin

OrderCustom:=1, MatchCase:=False, Orientation: Data=>Subtotals si pozitionarea pe o
Iatadptionl:=xl3ortMNormal o . .
Selection.3ubtotal GroupBy:=3, Function:=mxl3um, To CelLIla oarecare (Blg) pentru a |e§|

FEeplace:=True, Pagebreaks:=False, Jumoarybelow| d|n Starea de Selectie a fo||
Range ("L19") . 3elect
End Sub
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% meciuri.xls - Sheet1 (Code)

dute_in_clasam j |Click j

End Zub

Private Sub dute in clasam Click()
Application.Run ("meciuri.xls'go clasament™)

Exemplul 3

Pentru butonul dute_in_clasam am lansat in executie macro-ul
“Go_clasament” creat anterior. Observati calificarea numelui de
macroinstructiune prin numele registrului unde se gaseste.

Tn foaia de calcul clasament vom proiecta un buton care si anuleze subtotalizarea
datelor si sa revina Tn foaia principala.

- meciuri.xls - Module6 (Code)

General) ﬂ |revi|17(li|17clasam

Zub revin din clasami()
'
' revin din clasam Macro
' Macro recorded 09.03.2006 by pantiru
! Cells.3elect
Selection.RemoveSubtotal
Range ("C13") .3elect
Shests ("principal™) . Select
End Sub

Macro-ul revin_din_clasam a pornit din
foaia de calcul clasament, a selectat o
celula din tabel si a anulat operatia de
subtotalizare (Data—> Subtotals=>Remove
All), apoi s-a pozitionat pe o celuld si a
selectat foaia de calcul principal.

» meciuri.xls - Sheet4 (Code)

FEX)

cmd_revin_in_prine - |Click

Pentru butonul

Private Sub cwd rewvin in prine Click()

j Cmd_revin_in_princ am
asociat macro-ul

Sheets ("oclasament™) . Select . .
Application.Run ("revin din classm") revm_d/n_c/asam creat
End Sub anterior prin metoda
Application.Run.
Exemplul 4

Sub aceibuire]

acribuire Hacea
Bacco recocded 09,03,2006 by pantira

Range (“F15%) . Selact
hotiveCell.FormulaRlCl = "123"

Range ("FLEY) . Selece
hotbiveCell.FormulsB1Cl = "2349%

Tange ("F17¥) . Selecc

kobiveCell. FormulaflCl = "=R{-2]CsR[-1]C™
Hange ("FL3*) .Selecc

End Sub

Wal |

Realizam un macro prin care sa scriem doua valori si sa le adunam. Codul se poate
vedea folosind comenzile Tools>Macro->Visual Basic Editor.

Am selectat celula F15, unde am scris valoarea
123, apoi in F16 am scris valoarea 234 si am
adunat Tn celula F17.

Deci pentru selectarea unei celule se foloseste
Range(“adresa”).Select.

Pentru atribuirea unei valori in celula activa se
foloseste ActiveCell.FormulaR 1C1=valoare.
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Exemplul 5

Realizam un macro prin care facem manevra de copiere a unor date.

Sub copie_date()

' copie_date HNacro
' Macro recorded 02.03.2006 by pantiru

Am selectat foaia de calcul baza si am copiat toate

Sheets ("baza") .Select

Cells.select datele Tntr-o noua foaie de calcul.
gelection. Copy Deci pentru copiere se foloseste Selection.Copy
Sheets (Mmeciuri™) . Select . i
Sheets. hdd siActiveSheets. Paste.
Activesheet.Paste Inserarea unui foi de calcul se face prin
Range ("L14™) . Select
End Sub Sheets.Add.

Ce am invatat?

Selectarea unei foi de calcul Sheets("numele foii").Select
Selectarea unei celule Range("adresa").Select

Lansarea unui macro Application.Run ("numele macro-ului")
Activarea unei zone -panels- din foaia | ActiveWindow.panels(numarul

activa zonei).Activate

Atribuirea unei valori intr-o celula ActiveCell.FormulaR1C1=valoare

13.2. Introducerea datelor prin functia INBOX

Exista Tn Visual Basic o functie prin care solicitam informatii si receptam raspunsul
utilizatorului. Ea este Inbox() si are formatul general:

INBOX(sir-text-afisat-in-caseta, sir-titlu)

Exemplul 1

Solicitdm Tntroducerea numelui utilizatorului aplicatiei noastre Tntr-o caseta de dia-
log, ca in imagine. Dupa introducerea numelui, acesta se va afisa intr-un mesaj de
intdmpinare.

Cum facem?
Pasul 1. Proiectam butonul de

comanda. cere nume ’

Pasul 2. Deschidem editorul
Visual Basic prin butonul View
Code de pe Controls Toolbox. Se
deschide automat fereastra de
editare a metodei asociata eve- || [aeanoms
nimentului click al acestui obiect. T

Microsoft Excel E|

Saubari ALEXANDRA bine ati veni

aplicatia Fotbal
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ET T S rstructiunile de intrare 5

Fomat Debug Run Tods Addlns Window Heb de afisare. Rulam pentru verificare
oo [B]y ek MEE 2 @ e oz prin butonul Run. Daca apar erori, ele
w4 meciuri.xls - ST sunt imediat semnalate.
(CommndButions EJchx Observati codul metodei in fe-
;:iv;;:ufggxﬁs::‘::d:m?:aasiﬁrQ"apl:catla Fotbal™) reastra editorU|Ui'
y = MsgBox (" Salutari " & X & "bine ati venit"”)
End Sub

13.3. Luarea unei decizii in program: instructiunea IF

O structurd decizionala este o ramificare a instructiunilor care urmeaza evaludrii
conditiei. Instructiunea If are formatul general:

IF conditie THEN
Acpiunel
ELSE
Acpiune?2
END IF
Se citeste astfel:

Daca conditia este adevarata, atunci (THEN) se executa Actiunel, altfel (ELSE) se
executa Actiune2. In ambele situatii, dupa terminarea actiunilor se revine dupa End IF.

Exemplul 1

Sa presupunem ca in aplicatia FOTBAL avem unele date ,secrete” pe care le-am
ascuns Intr-o zona departata in foaia principal, incepand din celula AA1000. Ne
propunem sa verificam parola utilizatorului si, daca este cea dorita, sa-i permitem
accesul la zona secreta. Parola corecta este fotbal-toata-ziua.

Cum procedam?
Pasul 1. Proiectam un buton de co-

< w C ey ALIDD4 = 3
mandd cu urmatoarele proprietati: vy 25 A 2D = o=
name="cmd_salut”, Caption="date |9% nu uitati va intoarceti

1’ 997 in zona . Principala cu
secrete”. 998 <ctrl> <Home>
. o . 999
Pasul 2. Proiectam metoda click() |i000 date secrete

ca In imaginea capturata folosind [1091

. . 1002 data jucator  echipa  premiu salar alte-sporuri
metoda Select pentru a activa foaia |03 01012006 popescu steaus 100§ 20005 50005 eve
de calcul (obiectul se nume§te 1004| 02.03.2006 ionescu _rapid 20008 30005  400%
Sheets) si celula de pornire

(Range(“AA1000")).
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» meciuri.xls - Sheet1 (Code)
emd_salut v| |Click

Private Sub cmd_salut_Click() i
¥ = InputBox("dati parola de access la datele secrete”, "aplicatia F
If x = "fotbhal-toata-ziua" Then =

Sheets("principal”).Select

Range ("AA1000") .3elect

Else

y = MsgBox ("eroare, nu stiti parola!")

.

13.4. Instructiunea de selectie SELECT CASE.

Atunci cand avem de evaluat o conditie care poate lua mai multe valori, putem folosi
instructiunile IF imbricandu-le, dar mai simplu de scris este instructiunea Select. Urmariti
in exemplu Tnstructiunea Select case comparativ cu If.

If expresie=vall then Select case expresie
Actiune-1 Case vall . P
Ambele instructiuni se
else Actiunel executa astfel:
if expresie=val2 Case val-2 Se evalueaza expresia. Daca
then Actiune2 Actiune2 este egald cu vgll, atuncivse
else 1 va executa Actiunel, daca
else nu, va verifica daci este egal3
Actiunes Actiune3 cu val2. Dacé da, se va
end if End Select executa Actiune2, altfel se
end if executad Actiune3.
Exemplul 1

La aplicatia FOTBAL dorim sa intrebam utilizatorul ce informatii doreste sa vada:
despre meciuri, echipe, jucatori sau stadioane. Presupunem ca am separat in foi diferite
aceste informatii si le-am numit asigurand secretizarea registrului, in ordine: S1, S2,
S3, 4.

%, meciuri.xls - Sheet1 (Code)

|cthactuaI ﬂ |Click 5
Private Sub cmd_actual Click()
¥ = InputBox ("ce doriti sa actualizaci? Iﬂeciurl, Jucatori, Echipe, 3
Select Case x
Case "Meciuri®
Sheets ("31") .Zelect
oo R Dac3 cererea este corects
Sheets ("32") .Jelect i
case "Jucarori” atunci programul va activa
Sheets ("33") .Select . .. -
Case "Stadiosne” foaia de calcul solicitata, altfel
Sheets ("34") .Select d .
Cose Else va da un mesaj.
¥ = lisgBox ("eroare") Observati codul procedurii Tn
End Select . . o
End Sub imaginea capturata.
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13.5. Instructiunea de ciclu Do WHILE

Pentru acele actiuni care trebuie repetate se foloseste instructiunea DO.

DO WHILE conditie Cum se executi?
Actiune Se evalueaza conditia si atat timp cat conditia este
LooP adevarat3 se executa actiunea.

Exemplul 1

Sa presupunem ca la intrarea in aplicatia FOTBAL se deschide o foaie de prezentare
generala a aplicatiei. Pentru a accesa celelalte foi se cere o parola. Daca este corecta,
atunci se va deschide foaia principal care va dirija in continuare actiunile utilizatorilor.
Daca parola este eronatd se permite reintroducerea ei, dar de maxim 5 ori. Dupa
epuizarea incercarilor se inchide registrul! Pentru inchiderea registrului curent (obiectul
este ActiveWorkbook) se foloseste metoda Close, deci vom scrie: ActiveWorkbook.Close.

Variabila folosita este eroare, care marcheaza faptul ca parola este gasita prin valoarea

Z€ero.

* meciuri.xls - Sheet1 (Code) Eroare=adevarat

|mul_ulut vI . .
Nr_incercari=0
Private Sub cmd salut Click() H H

croare -1 = - Cat.tlmp nqt eroare si

nr_incercari = 0 nr_lncercar|<5 executa
Do While Not (eroare = 0) And nr_incercari < S introduce parola n variabila x
¥ = InputBox("dati parola de access") 1 ”

If x = "forbal® Then Daca x="fotbal
Sheets("principal”) .Select Selectez foaia Principala
eroare = 0

Pise eroare = fals
y = MsgBox ("eroare, nu stiti parola!") Altfel
nr incercari = nr incercari + 1 H H

End IT = Ma.resc nr_incercari

¥ = HsgBox("ati incercat de " & Val(nr_incercari) & " Sf_lf

Loop Sf_cat_timp

If nr_incercari = S5 Then

¥y = HagBox("ati incercat de " & Val(nr_incercari) & "ori, GATA", vbCritical)
ActiveWorkbook.Close

End If

End Sub

Microsoft Excel @

6 ati incercat de Sori, GATA

Daca nr_incercari=5 atunci dam mesaj si inchidem
registrul prin metoda Close.
Observati forma instructiunii msgbox pentru ultimul afis!

Problema rezolvata. Ghiciti numarul!

Va propunem proiectarea unui joc simplu. Calculatorul va genera un numar si operatorul
va Tncerca sa-l ghiceasca!
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Tncercarile se opresc atunci cand este
ghicit numarul sau jucatorul abandoneaza.

Fiecare situatie este marcata prin mesaje
semnificative, prezentate Tn imaginile
urmatoare.

dati un numar intre 1 si 10
Cancel

Microsoft Excel Microsoft Excel |X1

4 =

Cum facem?

Pasul 1. Proiectam butonul care declanseaza jocul.

Pasul 2. Prin View Code intram in editorul Visual Basic si scriem instructiunile jocului.
Generarea numerelor aleatoare in Tntervalul O-1 se face prin functia Rnd().

Pentru a obtine numere intre 1-10 vom folosi expresia INT(Rnd()*10)+1.

Variabila gasit, care tine controlul reluarilor, este initial zero. Daca se gaseste numarul
sau se abandoneaza jocul, valoarea sa devine 1.

Se repeta, cat timp nu s-a gasit numarul, introducerea unui numar de jucator si
compararea cu nr_computer. Daca sunt egale, se afiseaza mesaj si se seteaza gasit=1,
altfel se afiseazd un mesaj si se permite continuarea cu alt numar sau abandonarea.
Pentru aceasta am folosit in caseta de mesaje pe langa pictograma si vbOKCancel, pentru

meciuri.xls - Sheet1 (Code)

smmandButtond w| |Click

Private Sub ConnmndBucconB_Cllckt]
nr_computer = Int(Rnd() * 10} + 1
gasit = 0
Do While (gasit = 0)
¥ = InputBox("dati un numar intre 1 si 10 ", "ghici numarul'")
If Val(x) = nr_computer Then
m = MagBox("ati ghicit " & Chr(13) & "bravo", vbExclamation)
gasit = 1
Else
If Val(x) > nr_computer Then
m = MagBox ("numar prea mare " & Chr(13) £ "dati alt numar®™, vbExclamation + vbOECancel)
Else
m = MsgBox ("numar prea mic "™ & Chr(13) & "dati alt numar®, vbExclamation + vbOKCancel)
End If
If m = vbCancel Then
mn = MsgBox ("ati cedat prea usor'!", vbCritical)
gasit = 1
End If
End If
Loop
End Sub
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includerea butoanelor (OK care va permite continuarea) si Cancel (care prin pozitionarea
variabilei gasit=1 forteaza iesirea din ciclul While).

Observati ca functia chr(13) intoarce caracterul <New line> pentru a putea scrie pe
alta linie continuarea sirului!

Sarcini de laborator

1. Completati jocul astfel incat sa se numere incercarile si sa se afiseze la sfarsitul
jocului.

2. Completati jocul astfel incat, daca s-a rdaspuns corect, sa se poata juca din nou,
numdarandu-se de fiecare data si jocurile si Tncercarile din fiecare joc.

3. Completati jocul astfel Tncat sa se introduca chiar la Tnceputul jocului, de catre
jucator, intervalul de variatie a numarului generat.

4. Completati jocul pentru a fi jucat de mai mulfi jucatori. Se va introduce numele
fiecarui jucator.

Problema rezolvata. Cofetaria lui Mos Craciun

La un studiu efectuat intre orele 10-14 la cofetdria lui Mos Craciun din orasul nostru s-
a constatat c3 in fiecare minut sosesc copii! In 10% din cazuri sosesc 1 sau 2, in 20%
din cazuri sosesc 4 copii, iar in cate 30% din cazuri au venit cate 3 copii odata! Mos
Craciun nu poate servi mai mult de 3 copii pe minut si a facut cerere scrisa sa fie aduse
niste Craciunite Tn ajutor. S@ se simuleze activitatea cofetdriei si sa se verifice daca
cererea lui Mos Craciun este justificata. Care credeti ca ar trebui sa fie numarul ajutoarelor,
daca fiecare poate servi cate 3 copii pe minut?

Analiza problemei

Este tot o problema de simulare. Vom asocia valori numerice frecventelor de producere
a evenimentelor, astfel: pentru sosirea unui singur copil (frecventa este de 10%) vom
asocia numere intre 0-9; pentru sosirea a 4 copii (frecventa este de 20%) vom asocia
numere intre 10-29; sosirea a 5 copii (frecventa de 30%) o vom simula printr-un numar in
intervalul 30-59, iar sosirea a 3 copii cu aceeasi frecventa o vom simula printr-un numar
Tntre 60-89. Restul de numere intre 90-99 vor Tnsemna sosirea unui singur copil.

Datele de intrare: capacitatea de servire sau numarul de copii serviti pe minut
Numarul de copii sositi se va genera automat.

Date de iesire: lungimea medie a cozii, numarul total de simulari, numarul maxim de
copii care au stat la coada, numarul total de copii sositi, numarul total de copii serviti.

Prelucrari: in fiecare minut soseste un numar de copii, numarul de copii la coada este
egal cu numarul de copii sositi + numarul de copii aflati deja la coada Tn minutul servirii
minus numarul de copii serviti.

Vom folosi o foaie de calcul pentru simularea servirilor, avand ca parametru de intrare
capacitatea servirii si variind numarul de copii sositi.
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Pe o alta foaie de calcul vom centraliza rezultatele. Putem nregistra cate un scenariu
la apasarea unui buton de comanda sau/si mai multe odata.

Proiectarea foii de calcul pentru simulare. Am numit-o MosCraciun.

1. Am aranjat lista cu indicatori Tn domeniul A3:B9 astfel:

. capacitatea de servire este in celula B3 si am numit-o “capacitate”
. lungimea medie a cozii B5 =AVERAGE(G11:G131)

. numarul total de simulari=COUNT(C11:C1000)

. numarul maxim de copii la coadd=MAX(G11:G130)

. numarul de copii sositi=SUM(E11:E130)

f. numarul de copii serviti=B6*capacitate

2. Am proiectat tabela de cdutare a numarului generat in zona F3:17 si am numit-o
tabela_de_cautare.

3. Pe coloana C11:C130 am trecut minutul servirii, care se genereaza ca o serie
pornind de la 10:00 cu pasul 1 pana la 12:00.

4. Pe coloana D11:D130 am generat un numar aleator in intervalul 1-100, deci am
pus D11=int(rand()*100)si am copiat in rest.

5. Pe coloana E11:E130 am asociat numarului generat evenimentul, adica numarul
de copii sositi prin cautare n tabela de cautare £11==VLOOKUP(D1 1,tabela_de_cautare,4).

6. Pe coloana F11:F130 am pus capacitatea de servire.

F11=MIN(capacitate,E11) si F12==MIN(G11+E12,capacitate) pe care o vom copia
in urmatoarele 4 celule.

7. Pe coloana G11:G130 am pus numarul de copii la coada, astfel: GI1=E11-F11 si
GI12=G11+E12-F12, pe care il vom copia in restul coloanei.

®© O O T Q

A B c D E F G H [ J 4

1 capacitatea de tabela de cautare ==
2 servire este data in interval _[procent frecv.rellni_copii

3 |capacitate de servire 2 numar de copii/minut 0 10%(0.9 2

4 10 20%]10-29 4

5 [lungime medie coada 103 30 30%)30-59 5

B | numar total de simulasi | 120 60 30%60-89 3

numar copii la coada mﬂor;md este

7 |maxim 203] |© s 90 10%[90-99 1

8 [numar de copii sositi 44p| [simula sosirea copillor

9 [numar de copii serviti 240 “/ (om sucuste winkmial thotr & THaracul da copt 1n |

coada+sositi si capacitatea

10 minut numar_gen sosiri serviri 'Egiljg__._————'-_'_—_

1 ®  10:00 10 1 2 2

12 [Shnwiam activitates 10:01 17 4 2 4

13 in fiecare minut intre 10:02 15 4 2 6

14 orele 10 si 12, 10:03 16 4 2 8 - -

15 Pranpusen 10:04 47 5 2 1] ESREReazs

T ea

16 e ot 10:05 88 3 2 12

17 Vom inregistra 10:06 54 5 2 15

18 indicatorii in alta 10:07 20 4 2 17

19 foaie de calcul 10:08 1 4 2 19 -
129 11:58 57 5 2 203 -
130 11:59 94 1 2 202 =
131 hd
W 4 » ¥\ moscraciun { centraliz_mos [ smulare / centralz_smulare / |4l | gl
Ready Sum=1110.016667 HUM
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Proiectarea foii de calcul pentru centralizarea simularii (centraliz_mos)

Am considerat util sa calculam media indicatorilor din fiecare scenariu.
B4=capacitate; B6=average (c6:az6) si am copiat Tn rest.

Pe coloana C am pus

A B
primele valori prin copiere din | !
foaia de calcul cu simularea. |3 capacitate-senvire 3 3 T 3 2l
Atentie! Am copiat doar valorile |2
. . 6 |lungime medie coada 77 29 0 K| 103
prin COpy%PaSte SpeC|a|- 7 |numar total de simulari 120 120 120 120 120
C lelal | . f H B |numar copii la coada maxim 151 59 0 64 191
elelalte valori vor fi copiate [ g cqia copi sositi 425 116 414 424 431
automat prin executia unui 10 |media de copii serviti 300 360 720 360 240
. . 1
macro si inserate mereu intr-o | 12
noua coloana (D). 13
A B [ D
1
£z
=]
4 |capacitate-senire | I3 le
5
6 lungime medie coada =AVERAGE(CG6:AZ6) 29.3666666666667 0
7 nurnar total de simulari =AVERAGE(CT:AZT) 120 120
8 numar copii la coada maxim =AVERAGE(CB:AZ8) 59 0
9 media copii sositi =AVERAGE(C9:AZ9) 416 414
10 media de copii semiti =AVERAGE(C10:AZ1 360 720
1

Proiectarea macro-ului pentru Tnregistrarea Tndicatorilor in foaia de calcul de centralizare.

Tl vom numi inreg-mos.

Pasul 1. Ne pozitionam in foaia de calcul MosCraciun. Apasam F9 pentru un scenariu.
Pasul 2. Ne deplasam in foaia de calcul Centraliz_mos.

Pasul 3. Ne pozitionam pe coloana D, o selectam si Tnseram o noua coloana prin

Insert" Column.

Pasul 4. Ne intoarcem n foaia de calcul MosCraciun.

Pasul 5. Selectam domeniul B3:B9 si copiem prin Edit>Copy sau CTRL+C.

Pasul 6. Ne deplasam pe foaia de calcul Centraliz_mos si selectam celula D4.

Pasul 7. Lansam comanda Edit—->Paste Special cu selectarea comutatorului Value.

Pasul 8. Oprim inregistrarea.

Proiectarea unui macro pentru inregistrarea celor 10 scenarii se va face prin folosirea

Visual Basic for Aplication.

Pasul 1. Prin Tools=>Macro>New macro dam nume unui nou macro si in partea de
Tnregistrare selectam doar o celula. Inchidem Tnregistrarea. (Am preferat acest lucru pentru
simplitatea procedeului. In felul acesta am creat un nou modul pe care putem sa-I editam

prin VBA.)

LEcTIA 13 ® ELEMENTE DE PROGRAMARE IN VISUAL Basic

117




Sub copie_datei)
Ll
' copie_date Macro

' Macro recorded 09.03.2006 by pantiry

Sheets ("baza") .Select
Cells.Select
Selection.Copy
Sheets ("meciuri”) .Select
Sheets. Add
ActiveSheet . Paste
Range ("A14") .Select

End Sub

Pasul 2. Prin Tools>Macro>Macros deschidem fereastra cu toate macro-urile si ne
pozitionam pe noul macro.

Prin butonul Edit vom deschide fereastra VBA si scriem codul pentru executia repetata
a macro-ului “inreg_mos” ca in imaginea capturata a acestei ferestre.

Sarcini de laborator

Sa se proiecteze o foaie de calcul pentru Tnscrierea participantilor la Loto si afisarea
castigatorilor. Fiecare participant este Tnregistrat cu numarul biletului, numele si cele 6
numere alese de acesta. Numerele sunt intre 1 si 99. Extragerea numerelor castigatoare
determina determinarea automata a castigatorilor.

Pretul unui bilet este de 200 lei. Din totalul sumei obtinute prin vanzarea biletelor
60% se retine de catre firma organizatoare, iar restul se imparte castigatorilor! Atentie!
Este castigator doar acea persoana care are toate numerele extrase pe biletul sadu. Generati
aleator numerele castigatoare.
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Dezvoltarea proiectelor cu baze

v'  Ce este si cum se realizeaza un produs informatic
v’ Studii de caz
v'  Teme pentru proiectul final

Metodologia de realizare a oricarei lucrari, nu numai a unei lucrari informatice, trebuie
sa permita celui care realizeaza lucrarea sa raspunda la urmatoarele ntrebari: Ce trebuie
facut? De ce trebuie facut? Cum ar trebui sa se faca? Cand trebuie facut? Cine trebuie sa
faca? Cine raspunde? Unde se face? Cat va costa? Cine va beneficia de rezultatul lucrarii?

Procesul de realizare a unui produs informatic de o anumita complexitate poate si
trebuie s& fie structurat intr-o serie de etape/subetape/activititi bine determinate. in
realizarea produsului informatic sunt antrenate diferite persoane, nu numai informaticieni;
de aceea este necesard o buna organizare si specializare, o repartizare preciséa a sarcinilor;
se recomanda folosirea tehnicilor speciale adecvate dimensiunii proiectului si etapei
respective. Trebuie sa existe o documentare buna, intr-o forma standardizata, a fiecarei
faze parcurse.

Criteriul principal care trebuie sa stea la baza realizarii produsului este cel economic,
trebuie deci estimate corect costurile si beneficiile.

Etapa 1. Definirea problemei

Primul pas Tn efortul de a dezvolta un produs informatic este luarea contactului cu
clientul pentru clarificarea problemei puse. Care este problema ce trebuie rezolvata? S-a
inteles complet? Unde se va implementa produsul informatic? Ce variante de rezolvare
sunt? Nu gasim un produs pe piata soft care sa ne rezolve problema? Cat ar costa, ce
avantaje avem daca 7l vom proiecta noi pas cu pas, comparativ cu achizitionarea produsului?
Ce costuri estimative ar fi? Ce este mai avantajos?

Scopul esential al acestei etape este clarificarea problemei. Ganditi-va ce pierdere de
timp si bani pentru a rezolva impecabil o problema gresit pusa! Este un moment decisiv
pentru ca, uneori, clientul Tsi da seama ca nu poate suporta financiar efortul de proiectare
a produsului si renunta.

Etapa 2. Analiza

Este o etapa foarte importanta pentru ca permite stabilirea exacta a intrarilor, iesirilor
si prelucrarilor necesare rezolvarii problemei. Cine va utiliza produsul? Cine va introduce
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datele si cine are nevoie de informatiile oferite de produs? Prin interviuri, chestionare si
observari directe, prin cercetarea tuturor documentelor, actelor etc. se clarifica necesitatile
clientului si se stabilesc posibile variante de rezolvare. Mai concret, acum se fixeaza
care sunt datele de intrare si ce validari suporta, care sunt datele de iesire, in ce formate
se cer aceste date (tabele centralizatoare, grafice) cu ce periodicitate etc. Se fixeaza
principalele prelucrari ale datelor.

Se aleg produsele soft cele mai potrivite pentru a rezolva integral sau partial problema.
Se stie ca Excel este foarte adecvat in cazurile de simulare, de reprezentare automata a
graficelor si situatiilor centralizatoare. Daca avem situatii care cer la iesire rapoarte sau
comunicari mai elaborate putem folosi Word. Daca problema propusa este gestiunea unei
societati comerciale cu multe activitati, atunci va trebui sa ne gandim la un program de
gestiune a bazelor de date — de exemplu Access.

Etapa 3. Proiectarea

Daca hotdaram ca Excel este solutia pentru rezolvarea problemei noastre atunci va
trebui sa facem o schita pe hartie a registrului separand zonele de introducere sau prezentare
a aplicatiei de cele de date de intrare, de calcule si de cele de iesire.

e Tn zona de introducere este bine si prezentdm aplicatia si anumite indicatii de
utilizare. Uneori zona ocupa o prima foaie de calcul cu un design deosebit si care
serveste si ca panou de bord cu butoane pentru orientarea utilizatorilor printre foile
de calcul. Putem folosi si un meniu asezat pe bara de butoane.

e Tn zona datelor de intrare vor actiona operatorii pentru introducerea si editarea datelor
de baza ale aplicatiei, parametrii scenariilor. Este bine ca sa definim reguli de
validare si formate specifice care sa permita operatorului introducerea corecta a
datelor.

e Tn zona calculelor vom pune formulele pe care va trebui s le protejam la stergeri
accidentale. Stabilim daca referintele din formule sunt absolute sau relative. Este
mai comod pentru proiectant si pentru claritatea expresiilor daca vom da nume
zonelor referite absolut.

e In zona datelor de iesire vor fi rezultatele prelucrarilor sub forma unor tabele de
raportare, tabele pivot, situatii centralizate sau/si grafice.

Uneori este util sa proiectam un registru sablon salvat ca template. Un registru sablon,
n care zonele de date au valoare zero, este Tncarcat de utilizator, apoi sunt completate
zonele de intrare cu datele utilizatorului si registrul se salveaza pe disc cu alt nume.
Registrul sablon raméane in Template neschimbat.

Etapa 4. Construirea si testarea

Etapa de construire se poate uni cu etapa de proiectare pentru lucrdrile de mai mica
amploare, mai ales prin folosirea unui mediu vizual de dezvoltare. Raméane Tnsa necesara
testarea produsului cu date fictive Tn vederea depistarii si corectarii erorilor. Primul pas
este scrierea pe hartie. Pentru o multitudine de valori posibile — tipice si extreme — pentru
datele de intrare si se urmaresc rezultatele obtinute manual si pe foaia de calcul.
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Uneori foaia de calcul nu functioneaza corect din cauza lipsei de intelegeri a problemei
puse initial. Beneficiarul aplicatiei asteapta altceva. In acest caz va trebui sa se faca din
nou analiza problemei si sa se discute cu cei implicati in lamurirea ei.

Se va verifica daca formulele functioneaza corect pentru toate combinatiile datelor de
intrare.

Se verifica apoi modul cum se prezinta iesirile, sub ce forma sunt, daca sunt acceptate
de beneficiar, daca sunt usor intelese, daca sunt vizibile, etc. Tn situatia Tn care raspunsul
la aceste verificari o impune se va reveni asupra proiectarii registrului de calcul.

O alta sursa de erori este legata de introducerea datelor. Sunt anumite date obligatorii
de completat de catre operator, date care intervin in formule. Se va verifica validarea
fiecarei date, mesajele catre operator, protectiile puse.

Etapa 5. Implementarea

De obicei produsul program vine sa Tnlocuiasca o procedura manuala sau fnvechita.
Se renunta la vechiul sistem de prelucrare si sunt puse in practica procedurile de culegere,
transmitere si prelucrare a datelor specifice aplicatiei informatice. Este etapa cea mai
»riscanta® pentru proiectanti, pentru ca de succesul sau insuccesul demersului poate
depinde soarta intregului proiect. O aplicatie informatica nu este statica; ea trebuie sa fie
permanent adaptata la cerintele noi care apar. Cerintele de modificare pot fi de mica
amploare si se vor realiza din ,,mers” fara sa fie afectate structurile de baza ale bazei de
date sau prelucrarilor, caz in care are loc activitatea de intretinere a aplicatiei. Daca insa
sunt schimbari majore Tn activitatea modelata de produsul soft, atunci este necesara o re-

analizare si reproiectare software.

Etapa 6. Documentarea

Daca proiectantul ar fi si singurul utilizator al registrului, probabil ar fi suficiente
etichetele si cateva instructiuni pentru ca aplicatia sa fie clara. Dar produsul informatic
poate si trebuie sa fie folosit de un numar mare de utilizatori, unii chiar nefamiliarizati cu
Excel pe o perioada mare de timp. Unii utilizatori cunosc mediul Windows, lucreaza cu
Excel, altii nu. Fiecare utilizator, fie ca introduce datele, fie ca citeste rezultatele, trebuie
sa primeasca instructiunile pentru activitatea la care este autorizat sa raspunda. De
asemenea, dupa un timp aplicatia va trebui sa fie revizuitd. Cel ce va avea aceasta
sarcina trebuie sa Tnteleaga ce s-a facut, ce formule s-au folosit, unde sunt limitele si
restrictiile aplicatiei, pentru a corecta acolo unde este necesar.

Ce tipuri de documentatie exista?

e documentatia de prezentare a aplicatiei — care contine informatii generale de natura
tehnica si economica asupra produsului program in intregul sau; este destinata poten-
tialilor utilizatori; are un pronuntat caracter comercial; insista asupra posibilitatilor oferite
de produsul program, eventualele performante care sa permita alegerea produsului din
mai multe programe existente pe piata pentru rezolvarea aceleiasi probleme.

e documentatia de utilizare — care contine informatii privind utilizarea curenta a
produsului program, descrieri complete pentru un incepator ale tuturor actiunilor pe
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care va trebui sa le execute. Se vor scrie separat instructiunile pentru operatori la
introducere date si pentru beneficiarii care consulta datele prelucrate.

e documentatia destinata proiectantilor implicati in intretinerea si dezvoltarea
produsului —va contine descrieri complete ale foilor de calcul cu formule, cu rapoarte,
descrieri ale zonelor protejate, eventual parolele de acces.

Documentatia asigura:

e certitudinea ca operatiile indicate se vor realiza si, ulterior, se vor executa asa cum
trebuie;

e excluderea anumitor presupuneri sau ipoteze in afara celor descrise;
e clarificarea elementelor si notiunilor care apar;

e aplicarea anumitor structuri si proceduri tip in abordarea si rezolvarea unui numar
mare de probleme;

e utilizarea rationala si eficientd a tehnicii de calcul.

Specificatiile sunt — pe plan mondial — din ce Tn ce mai apropiate de o forma standard.

Activitatea de documentare este destul de laborioasa si este necesar sa o privim ca
parte importanta a efortului de realizare a unui produs informatic alaturi de analiza,
proiectare si implementare.

Studiu de caz — SC APEMIN SA

Societatea Comercialda Apemin SA este distribuitor unic de ape minerale pentru Moldova.
Ea se aprovizioneaza cu sticle de apa mineralda de la diferiti producatori si distribuie
marfa catre clientii sdi. Forma de ambalare este sticla de diferite capacitati. Preful este
n lei. O sticla de Borsec de 1L poate costa 5000 lei, 7000 lei sau chiar 10000 lei.

Managerul doreste sa cunoasca in fiecare moment:
d. numarul total de sticle intrate Tn depozit si iesite (la momentul curent);
a. intrarile si iesirile cantitativ Tn fiecare luna si pentru fiecare produs;
b. total intrari/iesiri pe produs de la Tnceputul anului si pana in luna curentg;
c. stocul curent pentru fiecare produs Tn parte, cantitativ si valoric.

Analiza problemei

Pentru ca sunt mai multe sortimente de produse este comod sa tinem separat evidenta
stocurilor, a intrarilor si a iesirilor.

Automat la o cantitate intratd/sau iesita va trebui actualizat stocul stiind ca stoc_curent
=stoc_initial+intrari-iesiri.

Unitatea de masura este diferitd. Se considera ca Borsec de 1L este alt produs decat
Borsec de 2.5L.
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Preturile nu sunt aceleasi pentru toatd perioada. Se considera ca Borsec 1L la 2000
lei este alt produs decat Borsec 1L la 1200 lei. Daca se schimba pretul, atunci se adauga
0 noua linie — se considera ca este alt produs.

Evidenta activitatii din fiecare an se {ine intr-un registru separat, care are aceleasi foi:
intrari, iesiri, stocuri. Numele acestui registru va avea ca sufix ultimele cifre ale anului.
De exemplu, ape_min_04.xls, ape_min_05.xls etc.

La Tnceputul activitatii se vor introduce stocurile initiale.

Proiectarea foilor de calcul

Foile de calcul pentru intrari si iesiri au acelasi continut, si anume informatiile despre
produs (codul, denumirea etc.) si cantitatile intrate/iesite din fiecare produs pe luna.
Automat se vor calcula totalurile.

Totalul a fost pus pe linia superioara.

E | ¢

2 | intraduceti u:antitatiNesitefcnnsumate de ape minerale
3 |cod denurnire ur pret total Sant total val ian feh rar
EX total L 9.0.9.9.6.4 XHHAX 97 XXXXX 34 63
5 | 1 barsec 45 1000 a0 30000 20
B | 2 biborteni 1 2000 22 44000 12 10
7| 3 izvarul alb 25 2200 30 GE0O00 10 20
8 | 4 paoiana negr 5 5000 3 15000 1 2

8l 4 stana de vale 1 1450 12 17400 1 11

Tn imagine sunt selectate zonele de date si anume:

Ce se introduce? Domeniu de celule
Denumire produs B5:B100
U.M. C5:C100
Pret D5:D100

Atentie! Aceste date trebuie introduse odata in toate foile. Deci inainte de a le intro-
duce grupati foile. Celulele neselectate contin formule. Cu xxxxx am indicat o celula
nefolosita.

Ce se calculeaza? Formule

a. Numarul curent AUTOFILL

b. Linia de total care este o suma a E4=sum(E5:E100); copiem pe linia 4, cu exceptia
valorilor pe coloane: celulei F4

c. Totalul cantitatilor intrate/iesite E5=sum(G5:05); copiem pe coloana E

pentru fiecare produs

d. Total valoric pe produs F5=E5*D5; copiem pe coloana F
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Foaia de calcul Stocuri

A DENERERECHEN © BEEE 6 | 4 [ 1 R K
1 tva 2%
2 produse cantitati valori

| stoc stoc- total- total-  |[valoare valoare
3 |cod denumire um |pret  [curent initial intrari__|iesiri stoc valoare-tva [finala
4 total XXHXXKXY 1928 1900 80 52 6759300 1487046 8246346
5 1|borsec 1.5/ 1000 89100 19 30 89000 19580 108580
B 2|biborteni 1| 2000 1688 200 10 22 376000 82720 458720
7 3izvorul alb 25 434 400 34 0 954800 210056 1164856
8 4|poiana negri 5| 5000 1007 1000 7 0 A035000 1107700 6142700
9 Slstana devale] 1| 1450 210 200 10 0 304500 66990 371490

Ce se introduce? Domeniu de celule

TVA J1

Stocul initial F5:F100

Zonele selectate sunt folosite pentru introduceri de date de catre operatori: informatiile
despre produse (trebuie introduse simultan n cele 3 foi), cota TVAsi stocul initial.

Ce se calculeaza? Formule

a. Linia de total care este o suma a valorilor | E4=sum(E5:E100); copiem pe linia 4
pe coloane:

b. Pentru fiecare produs totalul intrarilor G5=intrarilE5; copiem pe coloana G
este preluat din foaia de calcul intrari

c. pentru fiecare produs, total iesiri este H5=iesiri!E5; copiem pe coloana H
preluat din foaia de calcul iesiri

d. pentru fiecare produs Stocul E5=F5+G5-H5; copiem pe coloana E
curent=stoc-initial+total intrari-total iesiri

f. Valoare stoc=stoc-curent*pretul 15=E5*D5; copiem pe coloana |

g. valoare TVA=valoare stoc*TVA J5=I5*TVA; copiem pe coloana J

h. valoare finald=valoare stoc+valoare TVA | K5= |5+J5; copiem pe coloana K

Testarea

Pentru a testa functionarea vom deschide toate foile de calcul in ferestre diferite si
vom introduce valori oarecare. Urmariti planul de testare Tn tabelul urmator.
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Actiune

Ce efect are?

1. Ne pozitionam in foaia intrari si grupam
celelalte foi; introducem un prim produs
Borsec de 1.5 la pretul 1000 lei/sticla si
Biborteni de 1L la 2000 lei/sticla

Informatiile apar Tn toate cele 3 foi in exact
aceleasi celule

2. Inregistrdm sosirea a 12 sticle in
ianuarie si 7 in martie

E5=E4=19; F5=9000 in intrari

G5=G4=E5=E4=19; 14=15=19000;
J4=J5=4180; K4=K5=23180 in stocuri

3. Modificam TVA la 10%

Se modifica coloana J4=J5=1900 si
K4=K5=20900

4. Se scot 19 sticle de Borsec

E5=E4=19; F5=19000 in iesiri
H5=H4=19; restul zero Tn stocuri

5. Punem pentru Borsec stocul initial 100

Se madifica in stocuri: E5=E4=100

14=15=100000; J4=J5=10000;
K4=K5=110000

6. Completam cu intrari in diferite luni
pentru Borsec.

Observam sumele pe linia 5 daca sunt
corecte in foaia intrari si totalul comunicat n
stocuri.

7. Completam cu iesiri in diferite luni pentru
Borsec.

Observam sa fie actualizat totalul pe linia
produsului si corespondentul din stocuri.

8. Punem date pentru al doilea produs.

Cum se modifica sumele pe coloane.

Ultima actiune

Aplicam protectie prin parola la foile de calcul pentru a evita modificarea formulelor
din foile de calcul

Actiunea va fi realizata la nivelul fiecarei foi.

Pasul 1. Selectdm zonele de date si prin Format->Cells=>Protection anulam comutatorul
Locked.

Pasul 2. Selectam zonele de formule si prin aceeasi manevra activam comutatorul
Locked.

Pasul 3. Tools—>Protection>Protect Sheet.

Punem protectie la registru pentru a nu putea adauga/sterge foi prin Tools—>Protection
—>Protect Workbook.

Studiu de caz: Maxi-taxi

O firma de taxi are mai multe masini pe care le trimite in teritoriu. Fiecare sofer are
obligatia de a Tnregistra kilometrajul masinii la plecarea in cursa si la intoarcere in fiecare
zi. Conducerea doreste o situatie a kilometrilor parcursi de o masina si valoarea incasarilor
n fiecare zi. Seful mai doreste ceva: sa afle daca masina are si un consum neinregistrat!
Diferentele nejustificate apar daca kilometrajul masinii la sosirea din cursa intr-o zi nu
coincide cu cel existent la plecarea Tn cursa a doua zi.
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Se cere:

a. Realizati o foaie de calcul pentru rezolvarea problemei pentru o luna si o masina,
presupunand ca tariful practicat pentru un kilometru este fixat la inceputul lunii. Numele
lunii va fi afisat pe prima linie, iar ziua va fi pe prima coloana. Se va calcula automat
suma corespunzatoare curselor si cea nejustificata.

b. Se doreste calcularea la finalul lunii a sumei achitate ca salariu soferului, stiind ca
din total Tncasari firma Tsi ia un comision de minim 30%. Apoi se scad cheltuielile de
benzina. Alte cheltuieli legate de Tntretinerea masinii sunt suportate de firma si nu intra in
acest calcul. Se suporta din salariu eventualele penalizari si amenzi de circulatie. Daca
sunt kilometri nejustificati si seful constata ca soferul este vinovat, atunci i se va scadea
din salariu si va mai primi o penalizare suplimentara de 10% din valoarea prejudiciului.
Realizati noua varianta de foaie de calcul.

¢. Cum ar putea seful sa vada daca soferul este corect? Mai ales ca acesta are obligatia
ca la sfarsitul fiecdrei zile sa depuna si banii incasati din curse. Faceti corecturile necesare
si marcati situatiile exceptie astfel: cu rosu diferenta strict pozitiva, cu verde diferenta
negativa si nimic pentru zero Nu trebuie sa fie alterate celelalte calcule!

d. S-a constat ca tariful zilnic nu mai este constant pe luna. Conducerea hotaraste ca
diferentele de kilometraj sa fie evaluate la pretul maxim din luna respectiva. Ce trebuie
modificat Tn foaia de calcul?

e. Foaia de calcul va trebui utilizata de doua categorii de persoane: pe de o parte
personalul firmei, care trebuie sa introduca datele curente: kilometrajul, tariful, suma de
lei depusa in fiecare zi, iar pe de alta parte conducerea, pentru a afla informatiile dorite.

Realizati accesul limitat numai la domeniul de date pentru personal printr-un buton pe
bara de butoane cu textul ,,utilizatori”.

Realizati alt buton care, folosit de conducere, va permite afisarea si editarea intregii
foi de calcul.

Analiza problemei

Pct. a)
i R Zona din foaia
Ce va introduce operatorul? Cand?
de calcul
Taxa /km La Tnceputul lunii D1
Ziua, indexul la plecare si la sosire La fiecare cursa A4:C34
Ce se va calcula?
Nr. km parcursi ca diferenta intre index sosire | La fiecare cursa D4:D34

siindex plecare

Valoarea corespunzatoare drumului ca nr. km | La fiecare cursa-efectuata | F4:F34
parcursi inmultita cu pretul pe km

Numarul de km nejustificati este calculat ca La fiecare cursa-cu E5:E34
diferenta intre indexul masinii la sosirea din incepere din a doua zi.
cursa intr-o zi si indexul Tnregistrat ca fiind de
plecare in cursa a doua zi.

Total km parcursi La orice adaugare de date | D36
Valoarea corespunzatoare km parcursi La orice adaugare de date | F37
Total km nejustificati E39
Valoarea nejustificata E40
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Proiectarea foii de calcul

Formulele sunt afisate in imaginea urmatoare. Observati faptul ca pentru diferente de
kilometraj a trebuit folosita o expresie cu functia ISBLANK, pentru a le calcula numai
daca Tn ziua curentd masina a plecat Tn cursa. Folosim bara Horizontal Split pentru a
vedea Tn aceeasi fereastra toate datele!

Al B | ¢ | D | E I F
Lk luna iulie lei’lkm 1000
2
| 3 |ziua km-plecare km-sosire km-parcursi diferente valoare
14 1 100 120 =C4-B4 =D4%lei_km
5|2 120 130 =C5-B5 =IF(ISBLANK(B5),0;B5-C4)  =D5%lei_km
|6 [3 145 160 =C6-B6 =|F (ISBLANK(B6);0,B6-C5)  =DB6"lei_km
133 |30 =C33-B33  =IF(ISBLANK(B33),0,B33-C32 =D33"lei_km
134 |31 =C34-B34  =IF(ISBLANK(B34),0,B34-C33 =D34"lei_km
35
136 | total km parcursi  =SUM(D4:D1
|37 | valoarea obtinuta =SUM(F4:F18)
36
139 kilometri nejustificati =SUM(E4:E18)
140 | valoare nejustificata =E39*lei_km

Vom da nume domeniilor si celulelor pentru usurinta scrierii si intelegerii formulelor.
Astfel domeniul D4:D34 se va numi km_parcursi; domeniul E5:E34 se va numi diferente;
domeniul F4:F34 se va numi Valoare_zi etc.

Pct. h)

Adaugam n zona de date celule pentru comisionul firmei, pretul benzinei, penalizarile
si amenzile luate de sofer, precum si valoarea deciziei sefului pentru cazul n care apar
acele diferente nejustificate. Folosim din nou functia ISBLANK pentru a lua in considerare
sau nu celula val-nejustificata.

Tn imagine observati numele celulelor folosite si formulele necesare rezolvérii.

total km  =SUM(km_parcwisi) comision-firma 0.3
valoare =SUM(valoare_zi) pret-benzina 500

km_nejustific  =SUM(diferente) penalizari 20000

val_ nejustific =km_nejustifc’lei_km amenzi 40000
decizie DA
profit firma =valoare*comision_firma

cost_benzina =pret_benzina'total_km
pen_km_nejus
tific =IF{(AND(NOT{ ISBLANK(val_nejustific)):decizie="da"):val_nejustific*110%:0)

salar =valoare-profit_firma-cost_benzina-penalizari-amenzi-pen_km_nejustific
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Pct. c)

Adaugam coloana suma depusa de sofer in zona
de date. O numim lei_depusi pentru a ne putea
referi la ea. Atentie! De fapt, ddm nume domeniului
de date de la prima zi la cea de-a 31-a zi a lunii.
Calculam intr-o noud coloana (numita dif_valoare)
diferenta dintre aceasta suma si valoarea_zi. 25000
Folosim formatarea conditionata pe coloana

45000
10000

lei-depusi  valoare  dif_valoare

20000 25000

10000

30000 -30000

20000 5000
320000/ -320000

dif_valoare. Atentie! Pentru ascunderea valorii zero
vom folosi culoarea White.

Pct. d)
Adaugam o coloana tarif-pe-km Tn zona de date. Modificam

formula Tn coloana

valoare_zi=tarif-pe-km*km_ parcursi. Copiem formula pentru cele 31 de zile. Modificam
celula D1 care are numele lei-km = max(tarif) ce intervine Tn calculul valorii pentru

diferente de kilometraj. Celelalte formule raman aceleasi.

cai) D | E | F | 6 | H
lei’km 200
km-sosire lei-depusi km-parcursi  diferente valoare
120 45000 26 2000
130 100 10 0 2000
160 12000 200 20 10 4000

Pentru a vedea legaturile dintre formule (dependentele) ne pozitionam pe celula sursa

(ex. E4) si activam Tools->Formula Auditing->Trace Dependents.

Formula Auditing » || Trace Precedents

Tools on the Web... E Trace Dependents

Pct. e)

Protectia foii de calcul se va face prin ascunderea liniilor si coloanelor cu formule si
interzicerea acesului la ele atunci cand utilizatorul este un operator oarecare.

Operatorului i se permite doar completarea unui domeniu fixat, ca in imaginea

urmatoare.

Daca utilizatorul face parte din conducere, atunci vom anula protectia si vom reafisa

celulele calculate.

Pentru usurinta operarii, mai ales ca sunt manevre repeta-

. \ ) . aou sef
bile, vom realiza doua macro-instructiuni si le vom plasa pe

| utilizatori

bara de butoane cu un text semnificativ.
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200

| 3 |ziua km-plecar km-sosire lei-depusi tarif_km |

Cum facem?
Pasul 1. Proiectam macroinstructiunea mac_utiliz pentru utilizatori obisnuiti:
1.a Deschidem editorul de macroinstructiuni prin Tools->Macros->New Record
Macro, atribuim un nume si incepem inregistrarea manevrelor urmatoare: ne

pozitionam pe coloanele E:J, le selectam sl le ascundem prin
Format->Column->Hide;

1.b ne pozitionam pe liniile 35 pana la 50, le selectam si le ascundem prin
Format->Row->Hide.

1.c. Selectam tot domeniul B4:G34 si formatam asfel incat sa permitem intro-
ducerea/editarea valorilor Tn cazul protejarii foii. Vom dezactiva caseta de
validare Locked din Fermat Cells->Protection.

1.d. Vom proteja foaia fara sa punem parola deschizand pagina Tools->Protection
->Protect Sheet si executdam clic pe OK.

1.e. Oprim inregistrarea.

1.f. Asociem macro-ul (cu numele mac_utiliz) butonului depus pe bara cu
instrumente (toolbar).

Pasul 2. Proiectam macro-instructiunea pentru sef. De asta datd manevrele vor fi anularea
protectiei, apoi de afisare a coloanelor si liniilor ascunse.

Asociem macro-ul butonului pe toolbar.
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Sarcini de laborator

Realizati un proiect informatic cu baze de date in Excel util Tntr-un domeniu de activitate
ales de voi (turism, invatamant, productie, asistenta sociala, gestiune societati comerciale,
sanatate, transporturi, sport etc).

Cerinte

1. Proiectul va contine (cel putin) 3 fisiere: registru de calcul (Excel)/baza de date
(Access), documentatie (Word) si prezentare (Powerpoint).

La nivelul clasei se vor realiza proiecte pentru ,,probleme” din domenii diferite.

3. Fiind un proiect didactic evaluarea va urmari modul in care s-au insusit tehnicile
de analiza a unei probleme, de proiectare si de lucru efectiv cu bazele de date in
Excel, de elaborare a documentatiei unei lucrari informatice in Word si de
prezentare in PowerPoint.

Notarea se va face pe lucrare. Va sugeram urmatoarele criterii, fiecare notat de la 1 la
10 pct.

1. Fixarea corecta a datelor de intrare, alegerea sau folosirea unor coduri pentru
usurinta prelucrarilor, validari complexe.

2. Imaginarea unor utilizatori diferiti la aplicatia voastra, fiecare cu anumite drepturi
de acces; rezolvarea problemei protectiei datelor.

3. Imaginarea unor moduri variate de prezentare a informatiilor calculate din baza
de date — grafice, tabele pivot, situatii centralizatoare.

4. Folosirea unor functii logice, statistice, financiare, a operatiilor de sortare si
filtrare, folosirea operatiei de cautare.

5. Analiza datelor si estimarea tendintelor de evolutie a unui fenomen, construirea
unor scenarii.

Legarea aplicatiei Word cu Excel in vederea corespondentelor automate.

Crearea unei interfete prietenoase pentru aplicatie, folosirea macro-instructiunilor
(sau a programarii in Visual Basic) pentru automatizarea prelucrarilor.

8. Structurarea informatiei pentru documentatiile proiectului avand in vedere
utilizatori diferiti: fie clienti — (prezentare Powerpoint) fie informaticieni pentru
dezvoltarea aplicatiei (document Word).

9. Imaginarea unor variante de rezolvare diferite — aceeasi problema in Excel si
Access sau doua variante in Excel; imaginarea unor situatii de dezvoltare a
aplicatiei Tn viitor.

10. Prezentarea proiectului — modul de colaborare a echipei.
Fiecare echipa va fi formata din minim 5 persoane cu urmatoarele roluri: analist,

proiectant, tester, documentarist, sef de proiect. Fiecare echipa va cerceta in comun
domeniul propus, isi va defini clar ,,problema” pe care trebuie sa o rezolve, va fixa restrictiile
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si limitele proiectului. Nu toate activitatile domeniului de interes pot fi modelate in cadrul
acestui proiect didactic.

Echipa va alege o sigla pentru proiect, un motto, o anumita imagine care sa
individualizeze proiectul si echipa.

Fiecare echipa Tsi va repartiza rolurile pe membri. De exemplu:

a. Analistul —va realiza analiza problema fixandu-se asupra utilizatorilor potentiali,
intrarilor, iesirilor, codificarilor existente si/sau imaginate, validarile impuse

b. Proiectantul — va proiecta si realiza registrul de calcul separand in foi distincte
baza de date, informatiile prelucrate, panoul de bord al aplicatiei.

c. Testerul — va testa functionarea registrului simuland toate situatiile de intrare
posibile

d. Documentaristul — va scrie documentatia de utilizare a aplicatiei (in Word) si
cea destinata intrelinerii si dezvoltarii produsului

e. Seful de proiect — va ,lega” si superviza toate aceste activitatati; va scrie
documentatia de prezentare (in Powerpoint).

Fiecare echipa va stabili un plan a indeplinirii sarcinilor astfel Tncat sa se poata fizic
realiza proiectul si sa fie prezentat colegilor la termenul impus.

Atentie!
Nu uitati criteriile de evaluare. Imaginati situatii sau informatii cerute in ,,problema”
formulata de voi pentru a fi punctati la toate cerintele.

Sugestii de teme pentru proiecte

1. Teste-grila

Realizati un registru de calcul pentru compunerea testelor si examinarea elevilor pe
baza de teste. Profesorul va introduce fiecare intrebare cu variantele sale de raspuns,
raspunsul corect si punctajul.

Elevul va vedea doar intrebarile si va raspunde Tn coloana rezervata lui. Nu va putea
vedea nici punctajul total, nici raspunsurile corecte.

Evaluarea se va face automat la cererea profesorului, cand vor fi afisate — pe ecran
sau/si laimprimanta — intrebarile, raspunsurile corecte, rdaspunsurile elevului cu mesajul
“corect” sau “incorect”, punctajul oficial al raspunsului si punctajul obtinut de elev.
Foaia va calcula punctajul total al testului si cel obtinut de elev.

Este recomandat sa lucrati cu macro-uri care sa va permita:

1. Introducerea de catre profesor a unui nou test (se va face un macro care sa insereze
o noua foaie de calcul cu aceeasi structura ca a celei initiale, cu toate formulele, dar fara
datele de intrare!).

2. Afisarea tuturor coloanelor pentru profesor.
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3. Ascunderea coloanelor cu raspunsul corect si /sau a punctajului la fiecare intrebare
pentru elev (puneti protectie la foaia de calcul atunci cand este disponibila elevului).

4. Stergerea raspunsurilor unui elev.

2. Cheltuieli de intretinere

Pentru evidenta cheltuielilor de intretinere la o asociatie de locatari se folosesc doua
evidente de baza: una cu datele generale ale fiecarui apartament (suprafatd, numar de
locuitori, numar de ochiuri gaz metan etc.), alta cu facturile lunare (total cheltuieli pe
asociatie legate de apa rece, canalizare, caldura, Tntretinere comuna).

Se cunoaste ca sumele totale pentru gaz metan se vor imparti pe fiecare apartament n
functie de numarul de ochiuri-gaz, cele legate de apa rece in functie de numarul de
persoane, iar cele de incalzire in functie de suprafata. Pe baza lor se afiseaza si se retine
intr-un istoric suma datorata de fiecare apartament in fiecare luna. La achitarea sumelor
datorate pentru intretinere se elibereaza o chitanta si se inregistreaza achitarea.

Afisati sumele pentru luna curenta si datoriile pe fiecare scara, separat ordonate dupa
numarul apartamentului.

Trimiteti somatii de plata proprietarilor restantieri.
3. Policlinica

O policlinica are mai multe cabinete particulare de diferite specializari, fiecare cabi-
net fiind al unui singur medic.

Fiecare cabinet practica tarife diferite pentru consultatiile sale si plateste, in afara
cheltuielilor interne legate de aparatura, materiale etc.) cota parte din cheltuielile comune
legate de apa, caldura, lumind, curatenie, paza.

Fiecare cabinet trebuie sa-si afiseze programul, sa-si planifice consultatiile, sa
inregistreze costurile si incasarile. Odata cu prezentarea pentru prima data a bolnavului
la cabinet sunt trecute datele sale generale. Pentru fiecare consultatie in parte sunt detaliate
simptomele, diagnosticul, tratamentul indicat si valoarea consultatiei.

Policlinica are si un triaj, care face legatura cabinetelor cu exteriorul. Pe de o parte, la
triaj trebuie sa vina informatii de la cabinete, informatii care, prelucrate, vor putea constitui
baza informatiilor catre exteriorul firmei.

Astfel, de obicei managerul general, interesat de bunul mers al afacerii sale, doreste
sa afle totalul veniturilor obtinute de fiecare cabinet pentru a putea calcula cat i se cuvine
firmei (s-a hotarat ca fiecare cabinet sa nu plateasca o taxa fixa, ci un procent din veniturile
obtinute, conform unei grile elaborate de comitetul director).

4. Salarii

Pentru o norma intreaga lunara un profesor primeste un salariu de baza fix de X lei.
Norma este 72 ore/luna daca profesorul are sub 25 ani vechime si de 64 ore/luna altfel.
Orele suplimentare se platesc cu 75% din salariul de baza /norma. Daca un profesor nu
are norma intreaga, atunci el este retribuit ca si pentru orele suplimentare cu 75% din
salarul de baza /norma*numarul sau de ore. La salariu se poate adauga un spor de 20%
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daca are salariu de merit sau de 30% daca are gradatie de merit.

Sporul de vechime se calculeaza astfel: Sub 5 ani — nimic, intre 6 -15 ani se acorda
5% din salariul de baza; intre 16-25 ani se acorda 10% iar peste 26 ani 15%. Impozitarea
se face Tn functie de totalul salariu + sporuri astfel:

Sub 5 milioane — zero lei; Tntre 6-9 milioane -5%; Tntre 10-15 milioane cu 12% iar
peste 16 milioane cu 20%

Salariile dintr-un an se retin intr-un registru pe céate o foaie in fiecare luna, iar la
sfarsitul anului se face un centralizator cu sumele totale primite ca salarii in fiecare luna
de fiecare persoana. De asemenea, se calculeaza sumele totale/lunare si anuale pentru
sporuri si impozite.

Pe o foaie speciala se doreste un grafic al variatiei salariului total pe luni.

5. Hotel de 5 stele

Un hotel Tsi stabileste preful pe o noapte pentru fiecare camera in functie de pozitia
acesteia si confort. Astfel:

a. fiecare pat costa 200 lei; b. camerele cu vedere la mare au in plus cate 2000 lei
indiferent cate paturi au. Cele cu vedere la piscina cate 1500 lei, iar celelalte cate 800
lei. c. pentru televizor se plateste o taxa de 500 lei, iar pentru telefon o taxa de 100 lei.
d. camerele aflate la parter sau la ultimul etaj beneficiaza de o reducere de 200 lei, e.
camerele tip apartament au un supliment la pret de 3000 lei.

Aflati: Cat costa fiecare camera. Cat va castiga in sezon hotelul daca ar fi ocupat
complet? Afisati cu rosu camerele tip apartament, cu galben cele mai scumpe si cu verde
camerele cele mai ieftine.

Proiectati un registru care sa aiba pe prima foaie date despre hotel si pe a doua foaie
date despre camere.

A treia foaie poate fi un centralizator cu numarul de camere si numarul total de paturi,
pretul mediu pe fiecare camera cu 2/3/4 paturi.

Foaia a patra va afisa ordonat dupa preturi, la acelasi pret dupa pozitie, la aceeasi
pozitie dupa numarul de paturi.

6. Campionat de fothal

Creati 0 baza de date necesara activitatilor de informare dintr-un campionat de fotbal.
Veti retine informatii despre echipe si fotbalisti, despre meciuri si stadioane.

Odata cu planificarea meciurilor, trimiteti pentru fiecare stadion cate o scrisoare de
forma urmatoare, realizatd in Word!

Proiectati raportul final al campionatului.

Pentru fiecare echipa se vor afisa meciurile jucate si scorul: la finalul raportului se va
scrie totalul golurilor Tnscrise/primite de echipa respectiva, precum si punctajul.

LEcTIA 14 © DEZVOLTAREA PROIECTELOR CU BAZE DE DATE EXCEL




FEDERATIA ROMANA DE FOTBAL AMATOR
Catre administratia stadionului................
Avem deosebita placere sa va anuntam planificarea meciului

intre ..oococooeiieis ] I ladata ............ pe stadionul dumneavoastra.
Rugam asigurati buna desfasurare, eventual sponsorizare!
F= V4 O ora.......... Semnatura,

Afisati un raport cronologic cu situatia meciurilor pe stadioane. Pentru fiecare stadion
va fi afisat punctajul maxim obtinut
de o echipa care a jucat Tn deplasare,
respectiv acasa. La sfarsitul raportului
se vor calcula numarul total de
meciuri jucate, numarul total de
goluri.

CAMPIONATUL NATIONAL DE FOTBAL
Situatie Finala
Echipa............... pag. x
data loc adversar scor

Desenati grafice al campionatului

evidentiind: variatia numarului de

goluri primite si

| | marcate pe echipe;

ponderea in totalul

golurilor primite de o

echipa a golurilor

primite Tn deplasare

fata de cele primite
acasa.

Lista meciurilor pe stadioane

data | echipa1 echipa2 scor

er——
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Rezolvari

Recapitulare, problema 38

Pentru aflarea termenului 50 din sirul
Fibbonacci vom scrie formulele ca in imagine
si vom copia pana la numarul de termeni dorit.

Recapitulare, problema 39

e =CBinr_pers_reteta™nr_musafiri

1 -

2 | nrpers care vin la masa o

3 |nr pers din reteta 47 Trr_pers_reteta |

4

5 nr_et produs  cant urmn de cumparat Celulele vor primi nume prin
?J ; sunca ‘z‘gg g |:L1ggg.| Insert>Name-> Define sau

ceapa q . N .
5 2 cartof 00 750 direct in zona.de afisare a
9 4 rosii 500 g 1250 adresei celulei.

Recapitulare, problema 40

Am numit celula C10 total_curent pentru a ma referi ca zona de adresa absoluta in
formule si am folosit formatarea conditionata pentru diferenta, scriind cu rosu acolo unde
valoarea celulei este negativa.

cantitativa |care este % |vanzarilor
fata de vanzarilor curente pe
luna luna curente fata  |regiuni fata
3 regiune |precedenta [luna curentiqtrecuta de precedentalde total
4 moldova 10 5 -5 50.00% 1.37%
5 muntenia 100 20 -8 20.00% 5.48%
B oltenia 40 120 80 300.00% 32.88%
7 maramure 100 120 20 120.00% 32.88%
8 bucovina 200 100 -100 50.00% 27.40%
9
10 [total 450 365 B85 81.11% 100.00%
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A B C D E F
1
2
diferenta care este % vanzarilor

luna cantitativa fata |care este % vanzarilor curente pe regiuni fata
3 regiune precedenta  [luna curenta |de luna trecuta |curente fata de precedenta |de total
4 moldova 10 [5 =C4-B4 =C4/B4 =Cafotal_curent
5 muntenia 100 20 =C5-B5 =C5/B5 =Chitotal_curent
6  oltenia 40 120 =CE6-B6 =C6/B6 =CBitotal_curent
7 |maramures 100 120 =C7-B7 =C7/87 =C7/total_curent
8 bucovina 200 100 =C8-B8 =C8/B8 =C8/otal_curent
9
10 total =SUM(B3:B8) |=SUM(C3:C8) |~C10-B10 =C10/B10 =C10/total curent
1

Recapitulare, problema 41

Atribuim celulei A1 un nume (Rata_schimb) prin Insert>Name->Define. Selectam
domeniul B4:B9 si-I denumim Sal_1.

Formulele vor fi

Bll=sum(sal_1); B12=max(sal_1); B13=min(sal_1)

T
A IR C | D | E
1
| 2 |salarii medii pe domenii de activitate
3
4 fimatamant ™~ 5000}
|5 |cercetare )} 5500, VERAGE
] ]
|6 _jarmata : ?EIDD: bert [54:89 |
| 7 |politie i 5700:
|8 |sanatate E 6000} Number? |
| 9 |justitie v___ 6000y
ﬂ Returns the average (
11 |salarul mediu[(B4:B9) |  arays, o references that
3 [

Recapitulare, problema 42

Am preferat in locul unei formule mai complicate sa lucram termenii conditiei compuse
in coloane separate. Am ales datele de test astfel incat sa putem verifica toate situatiile.
Urmariti cu rosu valorile care dau expresiei valoarea adevarata.

F G H | J K L
condl= cond2= cond3= condd= cond5= cond3 si condl sau cond2
1 ani_lucru>40 varsta>=65 ani_lucru>=30 varsta>=60 cond4 sau cond5 iese_la _pensie
2 |=D2>=40 =E2>=65 =D2>=30 =E2>=60 =AND(H2;12) =0R{F2,G2,J2) =IF(K2;"da"," "
3 =D3>=40 =E3>=65 =D3>=30 =E3>=60 =AND(H3;13) =0R(F3,G3,J3) =IF(K3,"da"," "
4 =D4>=40 =E4>=65 =D4>=30 =E4>=60 =AND(H4;14) =0R(F4,G4,J4) =IF( K4,"da"," "
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Lectia 4, problema 1. Capsuni

A | B
| 20 |lungime coada 100
| 21 |durata servirii in minute 2
| 22 |total_minute =B20"B21
123 |
| 24 | asteptati
| 25 | ore =INT{total_minute/B0)
| 26 | minute =MOD(total_minute;60)

Lectia 4, problema 2. Cheltuieli de stationare

B8 - f =B6*B1+B1/60"D6
_ BRITR B I e =
1 |plata pe ora 6,000 lei
2 introduceti ore si
3 |sosire BA0E [
4 plecare 11:20
L
| 6 ati stationat 5 oresi 10 minute
7
g

aveti de achitat_[31,000 Iei_l

Am introdus textele (plata pe ord, sosire, plecare) pe coloana A.

b. Am formatat celula B1 pentru tipul Currency

c. Am formatat celulele C3 si C4 pentru momentele de timp doar cu ora si minutul

d. Am introdus un comentariu

e. Am calculat numarul de ore de stationare B6=HOUR(C4-C3)

f. Am calculat numarul de minute de stationare D6=MINUTE(C4-C3)

g. Am calculat costul prin inmultirea numarului de ore cu pretul pe ora si am adunat
suma corespunzatoare minutelor de stationare.

B8=B1*B6+ (B1/60)* D6

h. Am formatat celula la tipul Currency

Lectia 4, problema 3. Vacanta

La prima vedere este necesar sa scadem din data curenta data inceperii vacantei. De
exemplu vom scrie =date(2005;06;15)-today()

Dar in fiecare an este vacanta si pentru a nu modifica de fiecare data formula va trebui
sa indicam faptul ca anul vacantei este chiar anul curent. Deci am putea scrie =
date(year(today());06;15)-today()

Dar oare intotdeauna vacanta este n acelasi an cu cel curent?

Deci daca luna curenta este mai mare decat 6 SAU luna curenta este egala cu 6, dar
ziua este mai mare ca 15, atunci vacanta este anul viitor!

Urmariti calculele Tn foaia de calcul.
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Numele exemplu
celulelor formulele
Luna_curenta | =MONTH(TODAYY()) 2
Ziua_curenta =DAY(TODAY()) 24
Anul_curent =YEAR(TODAY()) 2006
Anul_viitor =anul_curent+1 2007
azi =TODAY() 24.02.2006
nr_ curent =DATE(anul_curent;6;15)-azi 111
nr_viitor =DATE(anul_viitor;6;15)-azi 476

=iF (OR(luna_curenta<6; 111

nr-zile AND (luna_curenta=6;ziua_curenta<16));

nr_curent;nr_viitor)

Lectia 4, problema 5. Flori

A D
2 raspuns
3 introduceti numar nou de buchete 6
4 numarul de flori numar de flori 116
5 |culese de fiecare pt. mama 19
6 copil numars pt. doamna 21
7 ana 21 o c
8 maria 25 raspuns
9 emil 23 numar nou de buchete =COUNT(B7:B30)+1
H numar de flori =SUM(B7:B30)
10 IEII_'1LIT - pt. mama =INT(E4/E3)
"; mircea 22 pt. doamna =E5+MOD(E4,E3)
1
1 P———————

Lectia 4, problema 6. Diferenta dintre doua momente de timp

[+ - A 19:20:00
A B c D E
1
B calcule si explicatii
& data ora alaturam data si ora prin ope
4 |sosire 38930 805553 -54+c4
5 plecare 40178 0.53125 =B5+C5
durata se calc. in zile si
B fractiuni pt. timp
7 se asteapta . =D5-D4 zile
g8 nr. Ani =INT(B7/365) rest de zile pt calc nr.luni  =MOD(B7,365)
9 nrluni =INT(ES/30) rest de zile =MOD(ES;30)
10 nr.zile =INT(E9) rest pt. calc. nr.ore, min,sec =MOD(ES;24)
11 nr.ore =HOUR(E10)
12 nr.minute =MINUTE(E10)
13 nr.secunde  =SECOND(E10)
14
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Lectia 4, problema 7. Consultanta
Date de intrare: numarul de ore lucrate pentru fiecare activitate in fiecare zi a unei luni.
Tn foaia de calcul este marcat domeniul de intrare B2:E32.

ziva
2

[
a)

consultati documentare expertize alte_activitati 'Iucrate

nr ore ocupare a o cu acest activitati
zilei activitate nr. Maxim neefectuate
2 0 1 5  40.00%" 2cd e
2 5 5" 17 29.41%" 5cea
3 3 0" 9 3333% Jcde a

Yode

H J
nr max de
ore
lucrate la  activitati

LTS IE

Date de iesire:
a.

numarul total de ore lucrate Tn fiecare zi este calculat ca suma Tn coloana F, astfel
F2=sum(B2:E2)

. procentul de ocupare cu activitatea de consultare a clientilor in fiecare zi raportat la

total ore pe zi este calculat Tn coloana G astfel: G2=B2/F2
Pentru a obtine procentajul formatam coloana la tipul Percentage

. numarul de ore maxim lucrat intr-o zi este calculat in coloana H astfel: H2=max(B2:E2)
. lista activitatilor care au ca numar de ore valoarea maxima in zi s-a afisat in coloana

| folosind functia pentru texte CONCATENATE (textl; text2;text3..) si coduri pentru
activitati (prima literd).
i2=CONCATENATE(iF(B2=H2;"c “;" “);
iF(E2=H2;"a “;" “))

iIF(C2=H2;"d “;” “); IF(D2=H2;"e “;" );

. pentru lista activitatilor neefectuate in fiecare zi — adica cele la care numarul de ore

este zero am folosit coloana J si o formula similara cazului anterior
J2=CONCATENATE(iF(B2=0;"c “;" “);iF(C2=0;"d *;" “);iF(D2=0;"e “;" *);
|F(E2:O,”a u;n u))

Lectia 6, problema 3. Vanzatori citrice
A. Presupunem urmatoarea baza de date. La aceste campuri vom face referire in
explicatiile ce urmeaza.

A |B] ¢ | b | EL F 1 6
1 pers luna loc prod val castig costuri
2 |ionescu ian bacau lamai 200 200 120
3 |vasilescu feb zalau porto 700 700 300

B. Folositi Data—>Validation.

C. Folosim pe rand butonul sort Tn ordinea inversa a campurilor sau ordonam tabelul prin
buton pentru coloana nume-persoana si apoi folosim fereastra Data—> Sort si fixam cheile n
ordinea data.
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D. Ordonam tabelul dupa lund, apoi aplicam Data-> Subtotals. Fixam grupul la nivelul
luna, functia este average iar campul unde se aplica este valoarea vanzarilor (val).

E. Este o situatie de totalizare pe doua niveluri. Mai Tntai obtinem tabelul ordonat dupa
localitati si produse. Apoi aplicam Data-> Subtotals pentru localitati cu functia sum.
Deschidem din nou Data->Subtotals pentru nivelul produs si cu aceeasi functie, dar avem

grija ca comutatorul Replace sa fie inactiv.

F. Folosim Data%EiIter si fixam n ordine [Tz [an ]
pentru coloana produs filtru pe valoarea banane;
pentru coloana localitate filtru pe valoarea iasi, | Sum of val loc  w|
iar pe coloana Luna filtru pe valoarea ianuarie. pers bacau zalau  clyj
Anularea se face tot prin Data>Filter. ionescu 1000
vasilescu 100
G. Este o subtotalizare cu trei niveluri. Atentie | Ma"nescy
la ordonare dupa luna, localitate si produs AL
! ’ Grand Total 1000 100

H. Oferim un exemplu ilustrativ al cerintei.

Desigur vom folosi Pivot table Wizard si vom plasa campul /und la nivelul paginii, persoana

la nivelul liniilor si localitatea la nivelul coloanelor.

|. Folosim doua campuri pentru gruparea
datelor pe linii: localitateasi produsul pe coloane

pers

luna | coLumn

rAaC

loc

vom pune luna iar la nivelul paginii — numele
persoanelor.

DATA

J.

Pasul 1. Vom realiza tabelul pivot cu suma
castigului pe persoane si produse.

Pasul 2. Vom selecta tabelul pivot si vom in-

Insert Calculated Field

troduce campul calculat cost. Mame: |cost
Astfel: din bara cu butoane selectam meniul - :
PivotTable=>Formula>Calculation fields. Intro- |Formula: |= -esturi

ducem numele cost si ca formula valoarea din
campul costuri a tabelei sursa.

Pasul 3. Vom adauga la tabelul pivot campul
cu numele beneficiu calculat ca diferenta intre castiguri si costuri.

K.
Vom pune Data—>Filter=> Autofilter. Pe coloana ian, pe coloana produs alegem portocale
iar pe coloana valoare selectam Custom si punem expresia.

0.
Pasul 1. Vom ordona dupa luni, dar nu alfabetic, ci cronologic. Pentru aceasta folosim
Data=>Sort si, pentru primul criteriu, deschidem prin butonul Option fereastra de dialog Tn
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care alegem din lista First Key lunile anului. Daca
nu sunt definite atunci putem sa definim lista prin
Tools>0ptions>Custom List si pe urma folosim lista
pentru a indica ordinea de sortare.

Pasul 2. Folosim Data->Subtotals.

Pasul 3. Tn tabelul centralizator rezultat vom
ascunde detaliile.

Pasul 3. Formatam tabelul: ascundem coloanele in plus (produs, persoana etc); inseram
linii pentru titlu; folosim alta dimensiune, stil etc.

M.

Pasul 1. Afisam detaliile si Tnainte de totalul pentru luna ianuarie inseram o noua linie
cu valoarea vanzarii de 200. Observam recalcularea sumei.

Pasul 2. Este necesara sortarea descrescatoare dupa valoare. De aceea vom ascunde
detaliile, si 7n tabelul centralizat, vom efectua sortarea dupa coloana valoare.

Lectia 10, problema 1. Clubul Dinamo

Problema se refera la meciuri si clasamente, dar si la stadioane, locuri, preturi. Primul
lucru pe care 1l facem cand analizam o problema este sd vedem ce evenimente se pot
petrece si care sunt actiunile asupra datelor.

1. Planificarea meciurilor pe care le va sustine echipa Dinamo se face din timp, in
colaborare cu adversarii, si se fixeaza momentele si locurile de desfasurare a fiecarui meci.
Acum se inregistreaza numele echipei adverse, stadionul, data, ora.

2. Modificarea datelor legate de meciurile planificate se poate face oricand, dar pana la
desfasurarea meciului.

3. Desfasurarea unui meci al echipei Dinamo va determina Tnregistrarea numarului de
goluri primite si marcate de echipa cu care a jucat Dinamo. De asemenea, se poate Tnregistra
numarul de bilete vandute si suma de bani Tncasatd de echipa pentru acest meci.

4. Modificarea datelor legate de meciul desfasurat deja nu va fi permisa! (deci va fi un
moment cand hotaram blocarea accesului Tn vederea corectarii acestor date).

4. La inceperea evidentei sau atunci cand se planifica un meci pe un stadion nou se va
Tnregistra numarul de locuri ale acestuia si poate pretul mediu practicat.

5. Solicitarea informatiilor de catre patronul echipei se poate face oricand, deci datele
de iesire trebuie sa reflecte Tn orice moment situatia dorita.

6. Accesul oricarei alte persoane va fi numai pentru vizualizarea datelor legate de meciurile
jucate si cele planificate! Vom ascunde de ochi indiscreti datele legate de castiguri!

Cine are acces la date?

1. Operatorul. El va introduce si va avea grija sa actualizeze datele legate de planificarea
si desfasurarea meciurilor. Nu va putea modifica scorurile unui meci sau numarul de bilete
vandute la meciul desfasurat deja. Nu va “vedea” situatiile cerute de sef.
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2. Patronul echipei Dinamo. El va putea “vedea” toate datele Tn orice moment. Poate sa
acorde acces operatorului la modificarea datelor legate de numarul de locuri pe stadioane,
prefurile practicate etc.

Date de intrare:

numele echipei adverse (tip text), stadionul (de tip Text), data (tipul Date), ora (tipul
Time), numarul total de locuri pentru stadion (de tip Number), numarul de bilete vandute (de
tip Number), numarul de goluri marcate si numarul de goluri primite (de tip Number), suma
de bani primita pentru meci (de tip Currency)

Date de iesire

Total numar de goluri primite si marcate de Dinamo, total numar de goluri marcate si
primite de fiecare echipa, numarul de bilete vandute raportat la numarul de locuri al fiecarui
stadion, castigul total la meciurile jucate, castigul estimat pentru meciurile viitoare.

Lectia 12, problema 1. Ordonare valori

Analiza problemei. Presupunem ca valorile sunt mici (intre 1 si 10). Cele 3 valori vor fi
comparate intre ele si in functie de rezultat, se va afisa o expresie cu denumirile variabilelor
si alaturi valorile n ordine.

Ce ne asteptam sa obtinem? Unul din sirurile x,y,z sau x,z,y sau y,x,z etc. in functie de
relatiile dintre variabile.

Proiectarea foii de calcul

Tn B2, B3, B4 vom introduce valorile iar in D7 vom afisa rezultatul ordonarii.

Am introdus valorile si am numit celulele x, vy, z.

Pentru ca sunt multe comparatii, formula finala va fi destul de stufoasa, asa ca am
preferat sa efectuam unele calcule partiale. Astfel:

| Al B | C | D |
5 operatia de ordonare- apasa F9
B lx= 7 ordinea este
7 _|y= 5 yxz=5,77,
8 |z= 7
ralil

Pasul 1. Am transformat n sir fiecare numar folosind functia Text. Sablonul inhiba zerourile
nesemnificative din numar. La fiecare am concatenat caracterul virgula ca separator.
Am obtinut astfel A11, A12, A13.

Pasul 2. Am dat nume acestor celule Al1=text_x; Al2=text_y; Al3=text_z

Pasul 3. Am scris expresiile necesare fiecarui sir unite prin functia AND si pe linia
urmatoare am trecut valoarea rezultat.

Ex. Pentru o situatie de felul ,,daca x<=y si Y<=z atunci va rezulta sirul x, y, z” am folosit
celulele Al4 si Alb.
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A
=TEXT(x;"##0"&" ")
=TEXT(y,"##0"8" , ")
=TEXT(z;"#40"&" , ")
=AND(x<=y,y<=2)
="y y,z=" &text_x&text_y&text z
=AND(x<=z;z<=Yy)
="x,z,y "&text_x&text_z&text_y
=AND(z<=x;x<=y)
="z %,y ="&text_z&text_x&text_y
=AND(y<=x;x<=2)

_2_1__]="y,x.z ="&text_y&text_x&text_z
22 |=AND(y<=z,2<=x)
123 |="y,z x= "&text_y&text_z&text_x
24 |=AND(z<=y,y<=x)
125 |="z,y x= "&text_z&text_y&text_x

Am folosit concatenarea mesajului cu valorile text rezultate prin conversie.

Pasul 3. Am scris formula finald Tn celula D7.

=|F(A14: A15:IF(A16: A17:IF(A18: A19:IF(A20: A21: IF(A22: A23: A25)))))

Testarea foii de calcul. Pentru usurinta testarii am preferat generarea aleatoare a valorilor
pentru x,y, z. Am folosit functia rand() si pentru a ma incadra in intervalul 1-10 am folosit
formula int(rand()*9)+1.

De asemenea este util sa controlam functionarea formulei deci am folosit o facilitate a
programului Excel care permite calcularea manualad a formulelor din foaia de calcul. La
fiecare apasare a tastei F9 se genereaza un set de valori si se poate observa corectitudinea
formulei. Acest mod de lucru se poate fixa folosind Tools—>Options—=>Calculation=>Manual.

X - A =
A | B
5
6|~ [ENTRANDpGH View  Calulation | Edt | General | 1
|7 |y=  =INT(RAND()*9)+1 Calculation
8 lz=  =INT(RAND('9)+1 (" éutomatic @ Hanual]

Observatie. Nu uitam ca afisarea formulelor/valorilor se face prin <ctrl>+<apostrof>

Tn final, am realizat formatarea foii: am ascuns liniile de calcule de la 11-25 si am pus
titlu si mesaje!; am scos expresia de generare pentru celulele x, y, z pentru a permite
utilizatorilor introducerea valorilor reale!

Am refacut modul de calcul automat pentru foaia de calcul prin Tools=>Options
—>Calculation.
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